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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to HP Business Process Testing. Business Process Testing with 
HP Application Lifecycle Management (ALM) enables non-technical subject 
matter experts to build and work with business components in a script-free 
environment and to create application-quality business process tests. 

This chapter includes:

➤ How This Guide is Organized on page 10

➤ Documentation Library Guides on page 13

➤ Additional Online Resources on page 16
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How This Guide is Organized

The HP Business Process Testing User Guide describes how to use Business 
Process Testing to create business process tests. It provides step-by-step 
instructions to help you create and debug business components, create 
flows, build and run business process tests, and report defects detected 
during the testing process.

This guide contains the following chapters:

Chapter 1 Introducing Business Process Testing

Provides an introduction to the Business Process Testing model and its 
integration with HP QuickTest Professional and other testing tools.

Chapter 2 Getting Started with Business Components

Provides an overview of the Business Components module in ALM, and 
describes the component tree view. The chapter also describes the key 
elements in the module interface, including the various formats of the tabs 
when working with manual components, keyword view components, and 
scripted components.

Chapter 3 Working with Business Components

Describes how to create, define, and modify the business components that 
are incorporated into business process tests and flows. The chapter also 
describes how to request new components, enter manual steps in a 
requested component, and generate reports, graphs, and other project 
documents that include component information.

Chapter 4 Designing Manual Component Steps

Describes how to create business component content in the form of manual 
steps and expected results, and how to create and insert parameters into the 
steps directly from the Component Steps tab.
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Chapter 5 Working with Automated Component Steps

Describes how to work with automated component steps, how to convert 
manual components to keyword-driven components, and how to add or 
modify component content in the form of keyword-driven steps, 
operations, parameters, and comments. The chapter also describes viewing 
scripted components that are created in QuickTest Professional and other 
testing tools.

Chapter 6 Getting Started with Business Process Tests

Provides an overview of the Test Plan module in ALM and describes the 
unique elements in the module interface when a business process test or 
flow is selected. 

Chapter 7 Managing Business Process Tests

Describes how to create and manage business process tests and flows in the 
Test Plan module of ALM.

Chapter 8 Working with Flows

Describes how to create and develop flows, and how to use flows to build 
business process tests.

Chapter 9 Working with Parameters

Describes how to expand the flexibility and reusability of business 
components, flows, and business process tests by replacing fixed values with 
parameters.

Chapter 10 Linking Parameters

Describes how to expand the scope of business process tests and flows by 
passing the values of output component parameters to input component 
parameters of subsequent business components in a flow or test.

Chapter 11 Working with Iterations

Describes how configure a component or flow to run a specified number of 
iterations during a single run, using different values for the component’s or 
flow’s parameters.
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Chapter 12 Working with Test Configurations

Describes how to expand the flexibility and reusability of business 
components, flows, and business process tests by creating test 
configurations that represent different use-case scenarios, and having each 
configuration access different data.

Chapter 13 Defining Run Conditions

Describes how to add run conditions to your flows, enabling you to run 
business components selectively, depending on parameter values of 
previous components in a flow.

Chapter 14 Running Business Process Tests and Flows

Describes how to run and debug business components in manual and 
automated business process tests and in flows, and how to view the results.

Appendix A Business Process Testing Keyboard Shortcuts

Provides a list of keyboard shortcuts for the Business Component module, 
the Test Plan module (for business process tests and flows) and the Manual 
Runner (for business process tests and flow). 

Appendix B Business Process Testing Glossary

Glossary of Business Process Testing terms.

Documentation Library

The Documentation Library is an online help system that describes how to 
use ALM. You can access the Documentation Library in the following ways:

➤ Click Documentation Library in the ALM Help menu to open the 
Documentation Library home page. The home page provides quick links 
to the main help topics.

➤ Click Help on this page in the ALM Help menu to open the 
Documentation Library to the topic that describes the current page.



Welcome to This Guide

13

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Application Lifecycle Management Guides

Reference Description

Using this 
Documentation 
Library 

Explains how to use the Documentation Library and how 
it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. 

To access, select Help > What's New.

Product Feature 
Movies

Short movies that demonstrate the main product 
features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application life cycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application life cycle management process.

http://www.adobe.com
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ALM Performance Center Guides

HP ALM Installation 
Guide

Describes the installation and configuration processes for 
setting up ALM Platform.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to use Lab 
Management for overall lab resource management, lab 
settings management, and system configuration.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance 
of applications under test.

Guide Description
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ALM Best Practices

ALM API References

Guide Description

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

Guide Description

HP ALM Project 
Database Reference

Provides a complete online reference for the project 
database tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides a complete online reference for the ALM COM-
based API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides a complete online reference for the Site 
Administration COM-based API. You can use the Site 
Administration API to enable your application to 
organize, manage, and maintain ALM users, projects, 
domains, connections, and site configuration 
parameters.

HP ALM REST API 
Reference

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM Custom Test 
Type Guide

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM 
environment.
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Introducing Business Process Testing

HP Business Process Testing enables subject matter experts to create business 
process tests using reusable business components and flows.

This chapter introduces Business Process Testing and HP Application 
Lifecycle Management application (ALM), and describes workflows for 
working with Business Process Testing.

Note: For information on configuring user permissions, see the 
HP Application Lifecycle Management Administrator Guide.

This chapter includes:

➤ About Business Process Testing on page 18

➤ Identifying Roles on page 20

➤ A Top-Down Methodology on page 23

➤ Automating Business Process Testing Components on page 34

➤ Setting Up Business Process Testing on page 41
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About Business Process Testing

Many applications are mission critical for modern corporations. Effective 
functional testing is essential to assess the quality of your applications and 
ensure that they are stable and free from damaging and costly defects.

Business Process Testing enables subject matter experts to:

➤ Design quality assurance tests for an application early in the development 
cycle and in a script-free environment.

➤ Design quality assurance tests at various levels without any scripting 
knowledge from the design of a high-level test structure down to the 
design of actual steps.

Business Process Testing uses a new methodology for testing, and in 
conjunction with testing tools such as HP QuickTest Professional, provides 
numerous benefits in an improved automated testing environment.

ALM Editions: Business Process Testing is not available with 
Performance Center Edition. For more information, see the HP Application 
Lifecycle Management User Guide.

This section includes the following topic(s):

➤ "Benefits of Business Process Testing" on page 18

Benefits of Business Process Testing
Business Process Testing and its integration with various testing tools 
provide numerous benefits in efficiency and cost reduction, including the 
following:

➤ Business process tests can be created in a script-free environment by 
subject matter experts who best understand the business processes that 
need to be tested, without the need for a programming background.

➤ Business Process Testing enables structured testing of an application by 
combining test automation and automatically generated, 
easy-to-understand, plain-language test documentation. 

➤ When creating manual tests, Business Process Testing dramatically 
reduces the need for repeating steps and facilitates text reusability.
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➤ Business Process Testing supports a keyword-driven approach for 
constructing automated scripts.

➤ Business Process Testing is not dependent on the completion of detailed 
testing scripts. After designing the test and establishing automation 
guidelines, applications can be tested manually before automated tests are 
ready by non-technical users. Business process tests can therefore be 
created and implemented more quickly than other automated tests, 
enabling potential performance issues to be detected earlier in the 
development process, and before downtime can occur.

➤ Usage of automation assets (created by the automation engineer) in the 
design or implementation of test steps does not require coding skills.

➤ Business process test creation is further accelerated by the ability to use 
modular, reusable flows and business component units in multiple tests.

➤ Version control enables you to keep track of changes made to entities in 
your project, including business process tests, flows, and components.

➤ Ongoing test maintenance time and costs are reduced, while increasing 
staff efficiency.

➤ Quality assurance experts can take advantage of the sophisticated 
automated testing capabilities in QuickTest Professional and other testing 
tools to prepare object hierarchies and application-specific functions that 
can be packaged as building blocks for use in business process tests by 
subject matter experts. Subject matter experts can work efficiently with 
quality assurance experts to test the functionality of applications. 

➤ Documents containing information about the tests, flows, and 
components in a project can be easily generated.
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Identifying Roles

The Business Process Testing model is role-based, allowing non-technical 
subject matter experts to work on tests with automation engineers, both 
together and in parallel. Two basic user roles are identified in the Business 
Process Testing model and are referred to in this guide:

➤ Subject Matter Expert

➤ Automation Engineer

Note: The automation engineer is only needed if the Business Process 
Testing framework will include automated tests.

These two main roles are the key players designing and implementing 
business process test. In addition to these two main roles, QA testers use and 
run the business process tests and ALM administrators set up and configure 
Business Process Testing. 

Roles are flexible, depending on the abilities and time resources of the 
personnel using Business Process Testing. There are no product-specific rules 
or limitations controlling which roles must be defined in a particular 
organization, or which types of users can perform which Business Process 
Testing tasks (provided that the users have the correct permissions). For 
example, in some organizations, the tasks of the subject matter expert may 
be performed by multiple personnel.

Note: To control access to various modules and tasks, ALM enables you to 
configure access permissions for users. For more information, see the 
HP Application Lifecycle Management Administrator Guide.
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Subject Matter Expert
The subject matter expert has specific knowledge of the application logic, a 
high-level understanding of the entire system, and a detailed understanding 
of the individual elements and tasks that are fundamental to the application 
being tested. This enables the subject matter expert to:

➤ Determine the operating scenarios or business processes that must be 
tested.

For example, the subject matter expert has the knowledge necessary to 
design the business process at a high-level by creating a business process 
test and requesting components for the test.

➤ Identify the key business activities that are common to multiple business 
processes.

For example, most applications require users to log in before they can 
access any of the application functionality. The subject matter expert 
could create one business component that represents this login 
procedure. This component procedure can be used in many business 
process tests or flows, resulting in easier and more cost-efficient 
maintenance, updating, and test management.

➤ Participate in other aspects of the creation of business process testing, 
depending on his/her availability and set of skills. These include:

➤ Creating business components, and manual steps for each business 
component.

➤ Defining steps as keyword-driven components and implementing the 
steps as automated steps, in conjunction with the automation 
engineer.

➤ Creating a business process test from existing components and 
defining data for test iterations.

➤ Creating flows for the business process test. 

➤ Configuring parameter values for test configurations, components, 
and flows. 
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➤ Executing the tests to verify that test was designed appropriately and 
ran as expected.

➤ Reviewing test results to verify that the results are as expected. 

➤ Maintaining test steps for each of the business components. 

Automation Engineer
The automation engineer is an expert in QuickTest Professional (or another 
testing tool) automated testing.

The automation engineer prepares the resources and automated functions 
required for testing the features associated with each specific component. 
For example: 

➤ The automation engineer can create and maintain application areas both 
within ALM and other testing tools. 

➤ The automation engineer can create function libraries with general scripts 
which are encapsulated into general operation keywords.

➤ The automation engineer can populate the shared object repository with 
objects that represent the different objects in the application being tested. 
The automation engineer can rename the object repository, create more 
appropriate keywords, and filter out objects which are not relevant. The 
subject matter expert can use these objects to create steps in keyword-
driven business components.

Depending on your company’s organization and resources, automation 
engineers may also be responsible for some of the tasks listed above for the 
subject matter expert.

Automation engineers can also create, debug, and modify business 
components in QuickTest Professional (or the relevant testing tool) if 
required. For more information, see the HP QuickTest Professional for Business 
Process Testing User Guide.
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A Top-Down Methodology

Business Process Testing is flexible and does not enforce any one particular 
model for incorporating business processes into your testing environment. 
The actual workflow in an organization may differ for different projects, or 
at different stages of the application development life cycle. 

A methodology of defining low-level components first and then designing 
business process tests based on the defined components is a legitimate 
methodology that may meet your needs. This section, however, presents a 
top-down methodology as a preferred alternative from the perspective of the 
subject matter expert with a high-level understanding of the entire system.

The top-down methodology presented here for working with Business 
Process Testing is based on:

➤ The high-level design and creation of a structure for business process 
tests.

➤ The mid-level design, including the:

➤ Creation of flows (sets of business components in a logical order that 
can be executed).

➤ Creation of business components (reusable units that perform specific 
tasks in a business process).

➤ Specifying criteria for more granular test coverage (requirements) as 
necessary. 

➤ Specifying different test configurations for testing different use-cases 
and for more “true-to-life” test coverage (requirements).

➤ The low-level implementation of business component content by 
creating component steps, setting up iterations (for business process tests, 
flows, and components), parameterizing, and when necessary, 
automating.

➤ The execution of the business process tests and flows.
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The top-down methodology therefore advocates the creation of business 
process testing entities according to the following hierarchy:

➤ Business process tests, which contain flows and/or business components. 

➤ Flows, which contain business components. 

➤ Business components (manual or automatic), which contain steps.

Business process tests, business components, and flows are created using 
ALM’s Business Components module and Test Plan module.

Note: The Business Components module is available only if your ALM 
license includes Business Process Testing. For more information, see 
"Licensing" on page 41.

The Business Process Testing model is described in the following sections:

➤ Designing the High-level Structure

➤ Designing the Mid-level Structure

➤ Adding Content to the Tests and Flows

➤ Running Business Process Tests and Viewing Results

Designing the High-level Structure
Business Process Testing provides an intuitive interface that enables subject 
matter experts to create and implement an effective Business Process Testing 
structure, without using complex scripting or programming procedures.

The high-level component of a Business Process Testing structure is the 
business process test.

Designing the high-level structure is described in the following sections:

➤ Designing with Automation in Mind

➤ Creating Business Process Tests
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Designing with Automation in Mind

Consider if the business process test might one day be automated. Reuse is a 
key factor when automating tests. Consider the following:

➤ Modularity and reusability facilitate automation. Design your tests to use 
smaller, reusable components that automated tests can call multiple 
times. 

➤ Reusability and test maintenance. With reusable components, tests are 
easier to maintain. 

➤ Automation engineers can use the design as a structure for creating 
methods that facilitate automation, instead of for creating scripted 
components. 

This part of the design phase is often done by both the subject matter expert 
and the automation engineer together.

After designing the test with automation in mind, you can use the Convert 
to Component feature to create components from a test systematically and 
effectively. For task details, see "Converting Manual Tests to Components" 
on page 235.

Creating Business Process Tests

The Test Plan module enables subject matter experts to build and configure 
business process tests (and flows) that represent the main tasks of a business 
process.

A business process test is a scenario comprising a sequence of business 
components or flows, designed to test a specific business process of an 
application. For details about business process tests, see Chapter 6, "Getting 
Started with Business Process Tests."
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Note: Flows are sets of business components that are executable. As such, 
they are available from the Test Plan module, which allows them to share 
the same functionality as business process tests (iterations, parameter, 
coverage, and results). However, when designing flows, we recommend that 
you consider them “compound components” and plan their design when 
"Designing the Mid-level Structure."

So as not to interfere with the high-level design process at this point, 
business components for each test can be created in the Business 
Components module, and flows for each test can be created in the Test Plan 
module, later.

Tip: As the subject matter expert creates the test or flow, he/she can request 
the creation of new business components. The component request can be 
very detailed (with a name, a description, a status, and implementation 
requirements), or a basic shell of the component (for example, specifying 
only a name). These component requests enable subject matter experts to 
build business process tests even before the application is ready for testing 
and make sure no duplicate business components are created. 

After a business process test is complete, you can work with it in the 
Requirements, Test Lab, Analysis, and Defects modules, just as for any other 
test type.

You can use run conditions to enable components to run selectively, based 
on earlier stages within the test or flow. This enhances the overall flexibility 
of a test or flow. For more information, see Chapter 13, "Defining Run 
Conditions."

This part of the design phase is typically performed by the subject matter 
expert.
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Designing the Mid-level Structure
The design of flows and components, and how they are parameterized, is 
often the next step in creating the structure of a business process test.

Designing the mid-level structure is described in the following sections:

➤ Creating Flows

➤ Creating Business Components

➤ Linking to Other ALM Entities

➤ Adding Components to Business Process Tests and Flows

Creating Flows

The Test Plan module enables subject matter experts to build and configure 
flows that represent logical sets of business components that can be 
executed as a unit (“compound components”).

A flow is a type of test comprising a collection of business components in a 
fixed sequence that performs a specific task. You can use a flow in multiple 
business process tests. When you modify a flow or any of its components, all 
business process tests containing that flow reflect that modification. For 
details about flows, see Chapter 8, "Working with Flows."

This part of the design phase is typically performed by the subject matter 
expert.

Creating Business Components

A business component is a reusable unit that performs a specific task in a 
business process and describes the condition or state of the application 
before and after those tasks. The subject matter expert defines the individual 
steps for each business component comprising the business process in the 
form of manual, or non-automated, steps. 

You can use a component in multiple business process tests and flows. 
When you modify a component or its steps, all business process tests or 
flows containing that component reflect that modification.
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The Business Components module enables you to create and manage 
reusable business components that perform specific tasks in a business 
process. The Dependencies tab of the module lists all entities that are 
dependant on each business component, which indicates the need for the 
component. 

This part of the design phase is typically performed by the subject matter 
expert, but may also be done in conjunction with the automation engineer, 
depending on available resources and skills.

Linking to Other ALM Entities

You can link business process tests and flows with other ALM entities, such 
as requirements and defects. This facilitates the integration of business 
process testing into ALM, providing comprehensive tracking and reporting 
of business process testing. 

This phase is typically performed by the subject matter expert.

Adding Components to Business Process Tests and Flows

To complete the framework, add business components to the relevant 
business process tests and flows in the Test Plan module by dragging 
business components from the component tree and dropping them into the 
test or flow. For more information, see Chapter 8, "Working with Flows" and 
Chapter 7, "Managing Business Process Tests." 

This phase is typically performed by the subject matter expert.

Adding Content to the Tests and Flows
After the general framework for the business process test is designed, the 
low-level details are implemented. These details form the content of the 
tests and flows.

Adding the content is described in the following sections:

➤ Adding Component Steps

➤ Parameterizing and Creating Iterations

➤ Grouping Components

➤ Automating Components
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Adding Component Steps

Business components are themselves comprised of several application steps. 
In a Web application, for example, a login component’s first step could be to 
open the application. Its second step could be to enter a user name. Its third 
step could be to enter a password, and its last step could be to click the 
Submit button on the Web page. The component could also be enhanced 
with other logic to test important details of the login task.

➤ If designing a manual test (or, before automated testing resources are 
available for an automated test), you can add manual steps in the 
Component Steps tab of each component and you can run these steps 
using the Manual Runner. For information, see Chapter 4, "Designing 
Manual Component Steps."

➤ If designing an automated test, after automated testing resources are 
ready, you can convert components to automated components and begin 
implementing the automated steps for each component by assigning 
keywords to each step. For information, see Chapter 5, "Working with 
Automated Component Steps."

This part of the design phase can be performed by the subject matter expert, 
the automation engineer, or both together.

Parameterizing and Creating Iterations

ALM enables you to expand the scope of business components (both 
manual and automated), flows, and business process tests by replacing fixed 
values with input and output parameters. Parameterization enables you to 
iterate specific components in a business process test, specific components 
in a flow, configurations, or entire business process tests, thereby creating 
data-driven tests. This process greatly increases the power and flexibility of 
your component, flow, or test. For information on component and flow 
parameterization, see Chapter 9, "Working with Parameters." 

Parameterizing and creating parameters can be performed by the subject 
matter expert or the automation engineer, depending on available skills and 
resources. 

For an example of component parameterization, see the Parameterization 
Example, below.
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Parameterization Example

If you want to create a business process test that tests the business process of 
booking a flight from an online reservation application, you might structure 
it from business components that: Log in to the application, select an 
itinerary, enter credit card details, enter shipping details, and log out.

If you were planning such a test without Business Process Testing, you might 
use the following diagram as part of your master test plan document:
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Using Business Process Testing, you could directly create a business process 
test containing business components, as shown below:

The steps in each of these business components can be set up to receive 
specific elements of data from the test that runs them (for example, the 
login name and password, the number of passengers, and credit card 
details). Each of these elements of data, which have different values each 
time the business component is run, can be parameterized. Each business 
component run is called an iteration.

Using iterations and parameterization, the same business process test can be 
used to answer many testing needs, for example:

➤ Testing the flight booking process for users with different login 
permissions, such as new users, VIP customers, and so on.

➤ Testing the flight booking process for one itinerary, or for several 
itineraries.

➤ Testing the flight booking process for one passenger, or for several 
passengers.
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Additionally, due to the modular structure of these business components 
and the ability to control components with external data, you can use the 
same components in other business process tests and flows. 

The login and logout components could be used in most other tests or flows 
on the same application. For example, you might be able to use the 
component for entering shipping details in other business process tests that 
check the business process of ordering online merchandise from the 
application, or in a test for subscribing to a frequent flyer program.

Grouping Components

In certain business process tests or flows, you may want perform several 
business components together as a group, perhaps as iterations. This form of 
parameterization and iteration is done within a test or a flow, and not on an 
entire test or flow as a whole. For task details, see "Grouping Components 
and Flows" on page 222.

This part of the design phase is generally performed by the subject matter 
expert.

Automating Components

If desired, test steps can be automated (this is decided during "Designing 
with Automation in Mind" on page 25). For details, see Chapter 5, "Working 
with Automated Component Steps." Automating test steps within ALM is 
typically done by the subject matter expert in conjunction with the 
automation engineer.

Automating component steps involves the creation of application areas, 
which provide access to the settings and resources required to create the 
content of keyword-driven business components for a particular application 
or part of an application.

You can create basic application areas based on a default template in the 
ALM Test Resources module. The default application area template is stored 
in the System Application Areas subfolder and cannot be moved or 
modified. For details, see the HP Application Lifecycle Management User Guide. 
Use QuickTest to edit and enhance application areas created in ALM.
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Automation engineers can create comprehensive application areas in 
QuickTest. For details, see "Automating Business Process Testing 
Components" on page 34. 

Running Business Process Tests and Viewing Results
When manual tests are ready (or, before automated parts of the test are 
ready), you can perform a manual run of the business process test or flow.

If automating the business components, you can check for problems arising 
from the combination and order of components in a business process test or 
flow by running the test in Debug mode from the Test Plan module. 
QuickTest Professional (and other testing tools) automated components can 
be used in the same business process test. The appropriate application is 
launched to run the components.

You can also check for syntax or logic errors in specific business components 
by running them individually in QuickTest Professional or another testing 
tool.

Then, when you are ready to run a complete business process test or flow, or 
to run it as part of a larger test set, you run it from the Test Lab module.

From the Test Lab module, you can view the results of the test run. These 
results include the steps in each business component, the actual value of 
each component parameter, and the results of individual steps.

For details, see Chapter 13, "Defining Run Conditions" and Chapter 14, 
"Running Business Process Tests and Flows."
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Automating Business Process Testing Components

Business process tests and flows are composed of business components. The 
information in the component’s outer layer or shell, for example, the 
component’s description, status, and implementation requirements, 
together with the steps that make up the component, are defined by the 
subject matter expert in ALM.

This section describes the following topics: 

➤ "Keyword-driven Automation and Integration with 
QuickTest Professional" on page 34

➤ "Scripted Automation and Integration with Testing Tools" on page 40

Keyword-driven Automation and Integration with 
QuickTest Professional
When QuickTest Professional is connected to an ALM project with Business 
Process Testing, the automation engineer can define objects in the object 
repository and save them in ALM. The objects are then available for 
insertion into component steps by the subject matter expert in ALM. In 
addition, all business component information is visible in 
QuickTest Professional.

Integration between ALM and QuickTest Professional enables the subject 
matter expert to implement the testing steps for the business components in 
a keyword view, and also enables the automation engineer to effectively 
maintain the set of objects in the object repository and the operations in the 
function libraries.

QuickTest Professional offers two types of automated components; keyword-
driven components and scripted components. The automated steps of 
keyword-driven components can be created and edited in ALM. Scripted 
component steps can be created and maintained only in 
QuickTest Professional or another testing tool by the automation engineer.

Each testing step is made up of an item (an object in the application or an 
operation), and an operation. The available items and operations are 
defined by the automation engineer. 
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The automation engineer compiles an object repository containing objects 
that represent all the objects in the application or application segment that 
you need to test.

For example, the objects in a login window may be captured in the object 
repository in QuickTest Professional as follows:

The automation engineer encapsulates all the activities and steps that 
require programming into a set of function libraries. These function libraries 
define the operations (or keywords) that your test needs to perform. With 
keyword-driven components, you can use these operations to create the 
component steps in the Business Components module in ALM.

The object repository location and associated function libraries for each part 
of the application being tested are specified in an application area. The 
application area provides all of the settings and resources required to create 
the content of its associated keyword-driven business components. These 
include representations of the objects from your application (contained in 
the shared object repository) and user-defined operations (contained in 
function libraries).
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Note: You can create basic application areas based on a default template in 
the ALM Test Resources module. (For details, see the HP Application Lifecycle 
Management User Guide.) However, most application area functionality is 
provided by the subject matter expert in QuickTest.

All application area settings are automatically inherited by the business 
components that are based on that application area. Each application area is 
intended for use with a different part of the application being tested. Each 
business component is associated with a specific application area. 
Application areas include the resources and settings described in Business 
Component Resources and Settings, below.

For more information, see:

➤ Business Component Resources and Settings

➤ Business Process Testing Workflow Using QuickTest Professional

Business Component Resources and Settings

Using QuickTest Professional, the automation engineer defines an 
important set of resources and settings that comprise the application area or 
otherwise affect the business component. These include:

➤ "Object Repositories" on page 37

➤ "Function Libraries" on page 37

➤ "Associated Add-ins" on page 37

➤ "Applications List" on page 38

➤ "Recovery Scenarios" on page 38

The resources and settings supplied by the application area apply to all 
components that are associated with it. You can create multiple application 
areas for different purposes. Each QuickTest Professional business 
component must be associated with an application area. You cannot delete 
an application area that is associated with a business component.
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This section contains only a brief description of these resources and settings. 
For more information on QuickTest Professional resources and settings and 
the application area, see the HP QuickTest Professional for Business Process 
Testing User Guide.

Object Repositories

The object repository stores all the information about the test objects that 
are used in each business component. After you associate a shared object 
repository with an application area, it can be accessed by any component 
that is associated with that application area.

By using the same shared object repository file for multiple components, the 
same objects can be used in multiple components, flows, and business 
process tests in ALM, and object changes in the application can be updated 
in one central location.

Function Libraries

Function libraries contain VBScript functions, subroutines, and so on, that 
can be used as operations in a business component.

Associated Add-ins

The specified set of QuickTest Professional Add-ins that is associated with 
the business component determines the types of objects that 
QuickTest Professional recognizes and that can be tested using that business 
component. Each add-in is associated with a development environment. For 
example, QuickTest Professional includes built-in add-ins for testing in Web, 
ActiveX, and Visual Basic environments. Additional QuickTest Professional 
Add-ins are available for testing environments such as SAP Solutions, Java, 
Oracle, Siebel, terminal emulators, and more.

When you convert manual components to automated components, the 
add-ins associated with the first keyword-driven or scripted component in a 
business process test (inherited from the application area used by the 
component) are automatically loaded in QuickTest Professional when ALM 
runs the test. Add-ins associated with other components in the business 
process test are not loaded.
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Note: ALM assumes that the add-ins associated with the first component in 
a business process test are required for all the components in the same test. 
Therefore, it is important to make sure that all required 
QuickTest Professional Add-ins are associated with the first business 
component in the test. If they are not, you should ask the automation 
engineer to add them to the application area used by the first component in 
the test. Then update your copy of the application area. For more 
information on updating the application area, see "Working with 
Application Areas" on page 136.

Applications List

QuickTest Professional runs components only on the set of Windows-based 
applications that are specified for the component. It can also run on 
applications in any other environment for which the appropriate 
QuickTest Professional Add-in is loaded.

Recovery Scenarios

Recovery scenarios are activated during the running of a business 
component if an unexpected event occurs, such as an application crash, and 
the run is suspended. Recovery scenarios define the operations necessary to 
recover from the event and continue the run.
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Business Process Testing Workflow Using 
QuickTest Professional

The following is an example of a common Business Process Testing 
workflow using QuickTest Professional. The actual workflow in an 
organization may differ for different projects, or at different stages of the 
product development life cycle.
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Scripted Automation and Integration with Testing Tools
Keyword-driven business components and scripted components are both 
part of Business Process Testing. Both types of components are 
maintainable, reusable modules that perform a specific task when testing 
your application. 

Scripted component steps can contain programming logic and can be edited 
only in the applications in which they were created, such as 
QuickTest Professional or Service Test. They cannot be modified by the 
subject matter expert in ALM, but you can include these scripted 
components in any business process tests.

In the Automation sub-tab, you can launch the component in the testing 
tool in which it was automated.

You create scripted components in QuickTest Professional and Service Test:

➤ For more information on creating and editing scripted components in 
QuickTest Professional, see the HP QuickTest Professional for Business 
Process Testing User Guide. 

➤ For more information on creating and editing scripted components in 
Service Test, see the HP Service Test User Guide and HP Software Self-solve 
knowledge base article KM1016396 
(http://h20230.www2.hp.com/selfsolve/document/KM1016396).

Note: Most of the information, examples, and images in this guide focus 
specifically on working with keyword-driven business components. 
However, much of the information also applies to scripted components.

http://h20230.www2.hp.com/selfsolve/document/KM1016396
http://h20230.www2.hp.com/selfsolve/document/KM1016396
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Setting Up Business Process Testing

This section describes the licensing and prerequisites for Business Process 
Testing in HP Application Lifecycle Management (ALM).

This section includes:

➤ "Licensing" on page 41

➤ "Prerequisites" on page 42

➤ "Accessing Business Process Testing" on page 42

Licensing
A license for Business Process Testing enables you to access the Business 
Components module and provides the ability to edit business process tests 
and flows in the Test Plan module. 

ALM Editions: Business Process Testing is not available for the 
Performance Center Edition.

Each user with the proper permissions who logs into an ALM Platform 
server with a Business Process Testing license uses up both a Business Process 
Testing license and an ALM license. 

Note: You can run test sets containing business process tests in the Test Lab 
module and you can also edit automated components in 
QuickTest Professional, even if no Business Process Testing license is 
available in ALM.

For more information on licensing, see the HP Application Lifecycle 
Management Administrator Guide.
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Prerequisites
To work with Business Process Testing, make sure the following prerequisites 
are met:

➤ To debug or run automated keyword-driven business components, or 
view test results, make sure that QuickTest Professional version 10.0 or 
later is installed.

➤ To create and/or modify keyword-driven components and their steps, or 
to work with external data tables for test configurations, install the 
QuickTest Professional Add-in for Business Process Testing Add-in on the 
client computer. The QuickTest Professional Add-in for Business Process 
Testing is installed from the HP Application Lifecycle Management Add-
ins page. 

Accessing Business Process Testing
To work with Business Process Testing: In the ALM sidebar, under Testing, 
select Business Components. If Business Components is not displayed in the 
sidebar, one of the following may be the cause:

➤ No Business Process Testing licenses are currently available on the 
ALM Platform server. Contact your ALM Site Administrator or see the 
HP Application Lifecycle Management Administrator Guide.

➤ You belong to a ALM user group that does not have access to the Business 
Components module. Contact your ALM Project Administrator or see the 
HP Application Lifecycle Management Administrator Guide.
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2
Getting Started with Business 
Components

The Business Components module enables you to create and manage 
business components in HP Application Lifecycle Management (ALM). 
These components provide the basis for Business Process Testing.

This chapter introduces the Business Components module. Chapter 3, 
"Working with Business Components," describes how to work with the 
features and other options available in the Business Components module.

Product Feature Movie: To view a movie that demonstrates basic 
information about Business Process Testing, select Help > Product Feature 
Movies in the ALM main window and click HP Business Process Testing for 
Business Analysts.

This chapter includes:

➤ The Business Components Module Window on page 44

➤ Understanding the Manual Steps and Automation Sub-tabs on page 73

➤ The New Component Dialog Box on page 83

➤ The Component Step Details Dialog Box on page 87
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The Business Components Module Window

The Business Components module window is shown below, displaying the 
Details tab for the component selected in the component tree. 

When a business component is selected in the component tree, the Business 
Components module contains the following key elements:

➤ Menu bar. Contains menus with Business Components module 
commands. For more information, see "Components Module Menu and 
Toolbar Commands" on page 48.

➤ Toolbar. Contains buttons for frequently-used commands in the Business 
Components module. These commands enable you to create and delete 
folders and business components, refresh data in the tree, and filter and 
sort the components displayed in the tree. For more information, see 
"Components Module Menu and Toolbar Commands" on page 48.
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Tip: You can navigate the Business Components module, and perform 
many commands, using shortcut keys. For a list of shortcut keys, see 
"Business Component Module Shortcuts" on page 415.

➤ Filter information. Describes the filter currently applied to the 
Component tree. Located directly above the Component tree. 

➤ Component tree. Enables you to construct and organize the hierarchy of 
your business component folders and individual business components. 

For more information on the component tree, see "Component Tree" on 
page 46. 

For information on the special Obsolete and Component Requests 
folders, see "Creating a Component Tree" on page 91.

➤ Business Component Life-cycle and Statuses. Enables you to track 
business components. For details, see "Business Component Life-cycle 
and Statuses" on page 58. 

➤ Business Components Module Tabs

The tabs in the Business Components module enable you to provide a 
complete overview of the component’s content.

➤ Details tab. Enables you to provide or view the general details of the 
business component as well as a summarized description and 
implementation requirements. For general details, see "Understanding 
the Details Tab" on page 62. 

➤ Snapshot tab. Enables you to capture a snapshot image that helps to 
describe the business component from the application and attach it to 
the selected business component. For general details, see 
"Understanding the Snapshot Tab" on page 65. 
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➤ Component Steps tab. Enables you to create or view the manual steps 
of your business component, and to automate it if required. For 
general details, see "Understanding the Component Steps Tab" on 
page 68. For task details on creating manual components, see "About 
Designing Manual Component Steps" on page 121. For task details on 
automating components, see Chapter 5, "Working with Automated 
Component Steps."

➤ Parameters tab. Enables you to define input and output component 
parameters and default parameter values for the business component. 
This allows the component to receive data from an external source and 
to pass data to other components or flows. For general details, see 
"Understanding the Parameters Tab" on page 66. 

➤ Dependencies tab. Displays the dependency relationships between 
components, tests, flows, and resources (including application areas). 
For details, see the HP Application Lifecycle Management User Guide.

➤ History tab. Displays a log of changes made to the component. For 
details, see the HP Application Lifecycle Management User Guide. 

➤ Live Analysis tab. When a folder is selected, this tab is available for 
creating a graphical representation of data related to business 
components.

Component Tree
Business components are displayed graphically in a hierarchical tree. This 
includes components created in:

➤ the Business Components module

➤ automated testing tools such as QuickTest

➤ the Test Plan module as component requests 

You can organize components into folders, and filter and sort the 
components according to your requirements.
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Selecting a folder (other than the Obsolete and Component Requests 
folders) in the Component tree displays Details and Live Analysis tabs that 
enable you to provide a descriptive overview of the folder’s contents and 
create a graphical representation of data related to business components. For 
conceptual information on live analysis, see the HP Application Lifecycle 
Management User Guide.

In a version-controlled project, a component checked out by the current 
user is displayed with an open green lock icon next to the component icon. 
A component checked out by another user is displayed with a red lock icon, 
together with the name of the user. For information on working with 
version control in ALM, see the HP Application Lifecycle Management User 
Guide.

Component Tree Icons

Business components and folders are identified by specific icons in the 
component tree.

➤ Folder. Folders organize business components in the tree into logical 
groups. Selecting a folder in the component tree displays a Description 
area that enables you to enter a textual description of the folder contents. 
A folder can either be collapsed or expanded, as indicated by its icons.

➤ Business Component. Business components are testing units that perform 
specific tasks in a business process. Manual business components are 
indicated by an M symbol on the component icon, for example, . 

For more information on the icons used to represent business component 
statuses, see "Business Component Status Icons" on page 59.
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Components Module Menu and Toolbar Commands
This section describes the commands available in the Business Components 
module. The commands are available from the Components Module Menu 
Bar, the Components Module Toolbar, and the Components Module 
context menu. 

Components Module Menu

The Components Module menu bar contains the following menus:

➤ Components. Contains commands that enable you to create business 
components and folders, go to a specific business component, restore a 
business component, and send e-mail.

➤ Edit. Contains commands that enable you to work with and delete 
business components and folders.

➤ View. Contains commands that enable you to expand and collapse 
folders, and work with filters.

➤ Favorites. Contains commands for listing business components according 
to favorite settings. 

➤ Analysis. The Analysis menu contains commands that enable you to 
generate planning reports and graphs. For more information, see 
"Generating Reports and Graphs" on page 114.

➤ Versions. In a version-controlled project, the Components menu bar also 
displays the Versions menu, which contains commands for checking in 
and checking out components. For information on working with version 
control in ALM, see the HP Application Lifecycle Management User Guide.
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Components Module Commands

Commands are described below in alphabetical order (unlabeled elements 
are shown in angle brackets):

UI Elements (A-Z) Available from Description

<list of recently used 
favorite views>

➤ Favorites 
menu

Displays the four most recently used 
favorite views in the Business 
Components module. 

You can define the number of views 
displayed on the menu by setting 
the FAVORITES_DEPTH parameter in 
the Site Configuration tab in Site 
Administration. For details, see the 
HP Application Lifecycle Management 
Administrator Guide.

Add to Favorites ➤ Favorites 
menu

Opens the Add Favorite dialog box, 
enabling you to add a favorite view 
to your private or the public folder. 
For information on working with 
favorites in ALM, see the 
HP Application Lifecycle Management 
User Guide. 

Change Status ➤ context 
menu

Changes the status of a component 
without switching to the Details tab. 
For information on business 
component statuses, see "Business 
Component Life-cycle and Statuses" 
on page 58.

Check In ➤ Versions 
menu

➤ Toolbar

Opens the Check In dialog box, 
enabling you to check in the 
selected components. For 
information on working with 
version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available from: Version Control-
enabled projects
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Check Out ➤ Versions 
menu

➤ Toolbar

Opens the Check Out dialog box, 
enabling you to check out the 
selected components. For 
information on working with 
version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available from: Version Control-
enabled projects

Clean unused 
components

➤ Components 
menu

➤ context 
menu 

Simultaneously removes all 
components that are not being used 
by any test or flow. 

Available from: Obsolete folder, 
when selected

Collapse ➤ View menu

➤ context 
menu

Collapses all branches in the 
component tree. For information on 
how to expand and collapse folders, 
see "Viewing and Modifying 
Business Components" on page 101.

Component 
Details

➤ context 
menu

➤ Toolbar

Displays the Component Details 
dialog box, enabling you to display 
and modify the details of the 
selected component.

For information on viewing the 
details of business components, see 
"Viewing and Modifying Business 
Components" on page 101.

UI Elements (A-Z) Available from Description
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Copy URL/Paste ➤ Edit menu

➤ context 
menu

Copies a selected component and 
pastes its URL as a link. The 
component itself is not copied. 
Instead, you can paste the address 
into another location, such as an 
email or a document. Clicking the 
link opens ALM and takes you to the 
component. If you are not already 
logged in, ALM first prompts for 
login details. 

Copy/Paste ➤ Edit menu

➤ context 
menu

Copies selected components within 
the same project or across projects. 

For information on how to copy 
folders and business components, 
see "Copying Folders and Business 
Components" on page 102.

Notes:

➤ Defect linkage data for the 
component are not copied.

➤ The root folder cannot be copied 
within the same project.

➤ If you paste a component that has 
the same name as an existing 
component, the suffix _Copy 
followed by a sequential number 
is added automatically to the end 
of the component’s name.

UI Elements (A-Z) Available from Description
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Cut/Paste ➤ Edit menu

➤ context 
menu

Moves selected components or 
folders to a different location in the 
component tree.

The root folder cannot be moved.

For information on how to cut and 
paste folders and business 
components, see "Viewing and 
Modifying Business Components" 
on page 101.

Tip: You can also move a component 
to a new location in the component 
tree by dragging it.

Delete ➤ Edit menu

➤ context 
menu

➤ Toolbar

Removes the selected folders or 
business components from the 
component tree. The contents of a 
removed folder are also removed. 

You cannot delete the root folder.

Any removed component that is 
used by one or more business 
process tests or flows is moved to the 
Obsolete folder in the tree. Unused 
components are permanently 
deleted. For more information on 
working with the Obsolete folder, 
see "Removing Business 
Components" on page 108.

Tip: Business components can be 
easily recovered from the Obsolete 
folder if they were deleted 
accidentally. For more information, 
see "Restoring Obsolete Business 
Components" on page 109.

Version Control: Deleting a business 
component deletes all previous 
versions of the component.

UI Elements (A-Z) Available from Description
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Expand All ➤ View menu

➤ context 
menu

Expands all branches in the 
component tree. For information on 
how to expand and collapse folders, 
see "Viewing and Modifying 
Business Components" on page 101.

Favorite bar ➤ View menu Displays the Favorite bar, enabling 
you to reload a view from a drop-
down list of existing favorite views. 
For details, see the HP Application 
Lifecycle Management User Guide.

Filter bar ➤ View menu Displays the current filter.

Filter/Sort ➤ View menu

➤ Toolbar

Enables you to filter and sort the 
business components in the 
component tree. For user interface 
details, see the HP Application 
Lifecycle Management User Guide. For 
a list of fields available for filtering 
and sorting, see "Understanding the 
Details Tab" on page 62.

Find ➤ Edit menu Searches for a component in the 
Components module. For details, 
see the HP Application Lifecycle 
Management User Guide.

Find Next ➤ Edit menu Searches for the next item that 
meets the previously defined search 
criteria.

UI Elements (A-Z) Available from Description
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Go to Component ➤ Components 
menu

Opens the Go To Component dialog 
box, enabling you to find a specific 
component by the component ID. 
You can open the details dialog box 
for the component or you can go to 
the component’s location in the 
tree. 

Note: You can only go to 
components that are in the current 
filter.

Graphs ➤ Analysis 
menu

Lists the graphs you can generate for 
component data. Select a predefined 
graph, or launch the graph wizard.

For details on the report types, see 
"Predefined Standard Graphs" on 
page 116. 

Live Analysis ➤ Analysis 
menu

Provides a descriptive overview of 
the folder’s contents and creates a 
graphical representation of data 
related to business components. For 
more information on live analysis, 
see the HP Application Lifecycle 
Management User Guide.

Most Recently Used ➤ Analysis 
menu

Displays the most recently viewed 
reports and graphs in the 
Components module. 

New 
Component

➤ Components 
menu

➤ context 
menu

➤ Toolbar

Opens the New Component dialog 
box, enabling you to add a 
component under the selected 
component in the selected 
component’s folder. For more 
details, see "Creating a Component 
Tree" on page 91.

UI Elements (A-Z) Available from Description
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New 
Component 
Folder

➤ Components 
menu

➤ context 
menu

➤ Toolbar

Opens the Create New Component 
Folder dialog box, enabling you to 
add a folder under a selected folder. 
For more details, see "Creating a 
Component Tree" on page 91.

Organize Favorites ➤ Favorites 
menu

Opens the Organize Favorites dialog 
box, enabling you to organize the 
list of favorite views by changing 
properties or deleting views. For 
information on working with 
favorites in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Pending Check In ➤ Versions 
menu

Opens the Pending Check In dialog 
box, enabling you to view a list of all 
entities in the current module that 
you have checked out. For 
information on working with 
version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available from: Version Control-
enabled projects

Private ➤ Favorites 
menu

Lists the favorite views that are 
accessible only to the user who 
created them. For information on 
working with favorites in ALM, see 
the HP Application Lifecycle 
Management User Guide.

Public ➤ Favorites 
menu

Lists the favorite views that are 
accessible to all users. For 
information on working with 
favorites in ALM, see the 
HP Application Lifecycle Management 
User Guide.

UI Elements (A-Z) Available from Description
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Refresh All ➤ View menu

➤ Toolbar

Refreshes the component tree so 
that it displays the most up-to-date 
business components.

Rename ➤ Edit menu

➤ context 
menu

Renames folders and business 
components in the component tree. 
For information on how to rename 
folders and business components, 
see "Viewing and Modifying 
Business Components" on page 101.

You cannot rename the root, 
Obsolete, or Component Requests 
folders.

Syntax exceptions: A component 
name cannot include the following 
characters: \ ^ *

Replace ➤ Edit menu Replaces a field value in the tree. For 
details, see the HP Application 
Lifecycle Management User Guide.

Report Selected ➤ context 
menu

Displays a report of the selected 
components.

Reports ➤ Analysis 
menu

Lists the predefined reports you can 
produce on component data. For 
details on the report types, see 
"Predefined Standard Reports" on 
page 115. 

Restore ➤ Components 
menu

➤ context 
menu

Restores the selected components 
from the Obsolete folder. 

UI Elements (A-Z) Available from Description
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Send by E-mail ➤ Components 
menu

➤ context 
menu

➤ Toolbar

Opens the Send E-mail dialog box, 
enabling you to send component 
email to recipients selected from a 
list or to the author of the 
component. For more information, 
see the HP Application Lifecycle 
Management User Guide.

Text Search ➤ Edit menu

➤ Toolbar

Opens the text search pane in the 
lower part of the Components 
module window, enabling you to 
search for records in predefined 
fields. For more information, see the 
HP Application Lifecycle Management 
User Guide.

Undo Check Out ➤ Versions 
menu

➤ context 
menu

Cancels the check out of selected 
components and discards changes. 

For information on working with 
version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available for: Version-controlled 
projects

Update Selected ➤ Edit menu Opens the Update Selected dialog 
box, enabling you to update a field 
value for multiple selected 
components. For more information, 
see the HP Application Lifecycle 
Management User Guide.

UI Elements (A-Z) Available from Description
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Business Component Life-cycle and Statuses
The color of the business component icons in the component tree and the 
symbols shown in the icons vary according to the status of the component. 
For example, you can use the status to indicate that a business component is 
ready to be run in a business process test or flow, or that it has errors that 
require attention before it can be successfully used in a test or flow. The 
more ready a component is to be included successfully in a business process 
test or flow, the less severe is its status.

The status of a business component affects the status of any business process 
tests or flows of which it is a part. The component with the most severe 
status determines the status of the test or flow. For example, a business 
component with an Error status causes any business process test or flow of 
which it is a part to have an Error status.

Additional statuses can be defined by updating the project list for business 
component statuses. For details, see the HP Application Lifecycle Management 
Administrator Guide.

Versions ➤ context 
menu

Opens a sub-menu with versioning 
options. For information on working 
with version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available for: Version-controlled 
projects

Warn before Check 
Out

➤ Versions 
menu

Instructs ALM to display a 
confirmation message before 
automatically checking out an 
entity. For information on working 
with version control in ALM, see the 
HP Application Lifecycle Management 
User Guide.

Available from: Version-controlled 
projects

UI Elements (A-Z) Available from Description
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Business Component Status Icons

Business component statuses and their corresponding icons are described in 
the following table, listed in order of their level of severity, from the least 
severe status to the most severe status:

Status Icon
Color / 
Symbol

Description

Ready Green 
flag

The business component is fully 
implemented and ready to be run. It answers 
the requirements specified for it and has been 
tested according to the criteria defined for 
your specific system.

Maintenance Grey 
tool

The business component was previously 
implemented and is now being modified to 
adapt it for changes that have been made in 
the application.

Not 
Implemented

Yellow 
asterisk

A business component request has been 
initiated in the Test Plan module. The 
component request status changes from Not 
Implemented to Under Development when 
you move the request from the Component 
Requests folder in the component tree in the 
Business Components module.

Note: This status is not available from the 
Business Components module.
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➤ The above icons represent components that have been automated using a 
testing tool such as QuickTest. 

➤ A manual component is indicated by an M symbol on the appropriate 
icon. For example, a component with an Under Development status that 
has not been automated would be indicated by the  icon.

Under 
Development

Yellow 
triangle

The business component is currently under 
development. This status is initially assigned 
to:

➤ New components created in the Business 
Components module.

➤ Component requests dragged or moved 
out of the Component Requests folder into 
a component folder in the component 
tree.

Error Red The business component contains errors that 
need to be fixed, for example, due to a change 
in the application. When a business process 
test or flow contains a component with this 
status, the status of the entire business 
process test or flow is also Error.

Status Icon
Color / 
Symbol

Description
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Business Component Status Life-cycle

The status of a business component shown in the component tree could 
change several times during its life-cycle, as illustrated in the example 
below:
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Understanding the Details Tab
The Details tab enables you to define component attributes, a general 
description of the business component, and detailed implementation 
requirements. It also enables you to communicate with the automation 
engineer and other component users and developers.

You can change the business component’s status and other details displayed 
in this tab by choosing alternative selections from the drop-down lists.
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Notes:

➤ You can add user-defined fields and change the label of the fields in the 
Business Components module. You can also customize project lists. For 
details, see the HP Application Lifecycle Management Administrator Guide.

➤ You can use the Script Editor to restrict and dynamically change the 
fields and values in the Business Components module. For details, see the 
HP Application Lifecycle Management Administrator Guide.

➤ For more information on the Details tab for a business component, see 
"Providing Component Details and Implementation Requirements" on 
page 94.

The Details tab can contain the following information:

➤ Component Name. The name of the selected component.

➤ Assigned To. The user to whom the business component implementation 
is assigned.

➤ Automation engine. How the component was converted to an automated 
component; QuickTestKeyword-Driven (abbreviated QT-KW) for a 
QuickTest keyword-driven component and QuickTestScripted 
(abbreviated QT-SCRIPTED) for a QuickTest scripted component, and 
SERVICE-TEST-AUTOMATED for a Service Test component. MANUAL is 
displayed for a component that has not been automated.

➤ Component ID. ID assigned to the component when the component was 
created. This data is automatically entered by ALM, and cannot be 
modified.

➤ Created by. The user that created the business component. This data is 
automatically entered by ALM, and cannot be modified.

➤ Creation date. The date that the business component was created. This 
data is automatically entered by ALM, and cannot be modified.

➤ Status. The status of the business component. For information on 
business component statuses, see "Business Component Life-cycle and 
Statuses" on page 58.
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➤ Deleted on (For components contained in the Obsolete folder only.) The 
date that the business component was deleted. This data is automatically 
entered by ALM.

➤ Original Location (For components contained in the Obsolete folder 
only.) The folder in which the business component was located when it 
was deleted. This data is automatically entered by ALM.

➤ Notes tab. This tab contains two areas for adding notes to the 
component: 

➤ Description. The Description area enables you to provide an overall 
textual summary of the business component’s purpose or contents, 
including the intended pre-condition and post-condition of the 
application at the start and end of the component run.

➤ Comments. The Comments area enables you to communicate with the 
automation engineer and other component users or developers by 
adding remarks, such as requests to the automation engineer for new 
operations or the need to update a step in the component.

Additional Version Control Fields

The Business Components module’s Details tab displays the following 
additional fields if version control is enabled:

➤ Version Check Out Date. The date the version was checked out.

➤ Version Check Out Time. The time the version was checked out.

➤ Version Checked Out By. The name of the user who checked out the 
version.

➤ Version Number. The version number.

➤ Version Status. The status of the version (Checked Out or Checked In).
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Understanding the Snapshot Tab
The Snapshot tab enables you to attach an image associated with the 
business component.

The Snapshot tab toolbar contains the following buttons:

➤ Snapshot. Opens the Snapshot dialog box. For information on attaching a 
snapshot, see "Attaching an Image to a Business Component" on page 98.

➤ Load from File. Enables you to load a previously saved .png, .jpg, .gif, or 
.bmp file containing the snapshot. For information on how to load 
snapshot files, see "Loading an Image" on page 99.

➤ Delete. Deletes the currently attached snapshot.
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A green asterisk icon  next to the Snapshot tab name indicates that the 
selected component has one or more snapshots.

For more information on the Snapshot tab, see "Attaching Images" on 
page 98.

Understanding the Parameters Tab
The Parameters tab enables you to define component parameters that allow 
a business component to receive data from an external source and/or return 
data for use in other components or flows.

Input component parameters make business components more flexible and 
make it easier to reuse the same component in multiple business process 
tests and flows—by supplying different input values, you can change how 
the component performs according to those values. Input component 
parameters also enable you to transfer multiple data values to the 
component in order to run the same component multiple times (iterations) 
in a business process test or flow.

Output component parameters allow data values retrieved from a 
component step in one component to be passed to a subsequent component 
in the business process test or flow.
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Tip: The Parameters tab for flows is very similar to the Parameters tab for 
business components.

The Parameters tab for Components (and flows) contains the following tabs:

➤ Input Parameters. Enables you to define component parameter names, 
default values, and descriptions of the input data that the business 
component can receive from a business process test or flow. 

The default value is used when the business component runs, if no other 
value is supplied by the business process test or flow.

➤ Output Parameters. Enables you to define component parameter names 
and descriptions of the output data that the business component can 
return to a business process test or flow.

A green asterisk icon  next to the Input Parameters or Output Parameters 
sub-tab name indicates that the selected component has one or more 
parameters.

The Input Parameters and Output Parameters sub-tabs each contain the 
following buttons:

➤ New Parameter. Enables you to create new component parameters. 

➤ Delete. Enables you to delete existing component parameters. 

➤ Refresh. Enables you to refresh the list of parameters.

➤ Set Filter. Enables you to filter or sort the parameters in the list using the 
Filter dialog box. For a list of parameter fields available for filtering and 
sorting, see "Understanding the Parameters Tab" on page 66.

➤ Select Columns. Opens the Select Columns dialog box, enabling you to 
specify which columns to display their order. You can also set the number 
of columns that remain stationary when you scroll horizontally.

➤ Parameter Details. Enables you to view the details of a parameter.

For details on the Parameters tab, see Chapter 9, "Working with Parameters." 
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Understanding the Dependencies Tab
The Dependencies tab displays the dependency relationships that exist 
between entities such as components, tests, flows, and test resources (such 
as application areas). For details, see the HP Application Lifecycle Management 
User Guide. 

To display the Dependencies tab, select a component in the component tree 
and click the Dependencies tab. 

A green asterisk icon  next to the Dependencies tab name indicates that 
the selected component has one or more dependencies.

Dependencies can only be created outside of ALM, such as in QuickTest. 

Understanding the History Tab
The History tab displays changes made to specified fields in an entity. For 
each change, the tab displays the date and time of the change and the name 
of the user who made the change. In addition, this tab displays a history of 
baselines in which the entity appears.

For details, see the HP Application Lifecycle Management User Guide.

Understanding the Component Steps Tab
The Component Steps tab provides an editable table in which you can 
create manual steps for your component. You can describe each step to be 
performed, create and insert parameters where required, and describe the 
expected result of the step.

You can include this manual component in a business process test or flow 
and then manually run the steps you created. Alternatively, you can choose 
to convert a manual component to an automated keyword-driven or a 
scripted component for a specific testing tool such as QuickTest.
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The Component Steps Tab

Below is a sample of the Component Steps tab before automation.

A green asterisk icon  next to the Component Steps tab name indicates 
that the selected component has one or more component steps.
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You create each step in the business component as a row in the Component 
Steps tab. A step is an operation to be performed on an application. For each 
step, you describe the procedure to be performed, and define a successful, 
expected result. When a business process test or flow runs in ALM, the steps 
defined in the associated business components are performed.

The rows in the Component Steps tab are divided into the following 
columns:

➤ Step Name column. Displays an incrementing number for each step that 
you create, for example, Step 1, Step 2, and so on. You can change this 
default to a more descriptive name if required.

➤ Description column. Describes the step procedure to be performed on the 
application.

➤ Expected Result column. Describes the expected result of performing the 
procedure described in the Description column.

Component Steps Tab Toolbar and Context Menu Commands

The Component Steps tab contains the following commands from its 
toolbar and its context menu:

➤ New Step. Opens the New Component dialog box, enabling you to add a 
step below the selected step. For more information, see "The New 
Component Dialog Box" on page 83.

➤ Edit step. (or double-click a step) Opens the Component Step Details 
Dialog Box, enabling you to edit the selected manual step. For more 
information, see "The Component Step Details Dialog Box" on page 87.

➤ Renumber Steps. Rearrange the steps in a different order by renumbering 
them. 

➤ Delete Selected. Deletes the selected component steps. 

➤ Copy steps. Copies the selected component steps to the clipboard. Use 
this button in conjunction with the Paste steps button. 

➤ Paste steps. Pastes the copied component steps to a new location. 
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➤ Generate Script. Converts the manual component to an automated 
QuickTest keyword-driven business component or a QuickTest scripted 
component, or a Service Test scripted component. For information on 
how to automate components, see "Generating a Script to Automate 
Components" on page 140. 

When automating a component, additional sub-tabs open:

➤ Manual Steps sub-tab. Displays or provides access to the original 
manual steps of the component. For more information, see 
"Understanding the Manual Steps and Automation Sub-tabs" on 
page 73.

➤ Automation sub-tab. Displays or provides access to automated 
components. For keyword-driven components, enables you to create 
and modify the steps of your automated business component in a 
keyword-driven, table format, and provides a plain-language textual 
description of each step of the implemented component. For more 
information, see "Understanding the Manual Steps and Automation 
Sub-tabs" on page 73.

For more information, see "Understanding the Manual Steps and 
Automation Sub-tabs" on page 73. 

➤ Insert Parameter. Inserts a parameter into the step. This command is 
enabled only when your focus is in the Description or Expected Result 
cells. For more information on inserting parameters, see "Defining Input 
and Output Component Parameters for a Business Component" on 
page 100.

➤ Find Text. Opens the Find dialog box, enabling you to search in the tab 
for steps that contain a specified text value. Select the column in which 
you want to search, and enter the value you want to find. For more 
information, see "Using the Find Dialog Box in the Component Steps Tab" 
on page 72.

➤ Select Columns. Opens the Select Columns dialog box, enabling you to 
specify which columns to display their order. You can also set the number 
of columns that remain stationary when you scroll horizontally.

➤ Adjust row heights. Changes the row height of the step so that more or 
less of the text in the step is visible.
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➤ Save steps. Saves the component steps that you have created or modified. 
New or changed steps are not saved until either you click this button or 
you leave the Component Steps tab. For more information, see "Saving 
Component Steps" on page 151.

➤ Move Up. Moves the selected step up or down in the list.

➤ Move Down. Moves the selected step up or down in the list.

➤ Export. This context menu command exports the information in the tab 
to several formats. For more information, see "Exporting Component 
Steps Data to a File" on page 73.

For more information on the Component Steps tab, see Chapter 4, "About 
Designing Manual Component Steps." 

Using the Find Dialog Box in the Component Steps Tab

You can search for values in the Component Steps tab using the Find dialog 
box.

To find a value:

 1 Click the Find Text button in the toolbar.

 2 In the Find in Field box, select the column in which you want to search 
for a specific value. 

 3 In the Value to Find box, enter the value to find. 

 4 To find exact matches only, select the Exact Match box. 
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 5 To distinguish between uppercase and lowercase characters, select the 
Case Sensitive check box. 

 6 To use pattern-matching wildcard characters in the search, select the Use 
Wildcard check box. 

 7 Click the Find Next button. ALM attempts to locate any steps with the 
specified value. If the search is successful, the step is highlighted. If the 
search is unsuccessful, an information box opens.

Exporting Component Steps Data to a File

You can export the information in the Component Steps tab to several 
formats, including text file, Microsoft Word document, Microsoft Excel 
spreadsheet, or HTML document. 

To export data to a file:

 1 Right-click in the Component Steps tab and select Export To. The Export 
All Grid Data dialog box opens.

 2 Navigate to the location for the exported file.

 3 In the File name box, enter a name for the file.

 4 In the Save as type box, select a file type. 

 5 Click Save.

Understanding the Manual Steps and Automation Sub-tabs

If automating a business component, the following two sub-tabs are 
displayed after clicking the Generate Script button in the toolbar of the 
Component Steps tab.

➤ Manual Steps. Displays the manual steps that were originally displayed in 
the Component Steps tab. These are the steps that you can automate 
using the Automation sub-tab, adding automated steps that can be run by 
a specific testing tool such as QuickTest.

For additional information on working with the Manual Steps sub-tab to 
create manual steps, see Chapter 4, "Designing Manual Component 
Steps."



Chapter 2 • Getting Started with Business Components

74

➤ Automation. Enables you to automate the component either as a 
keyword-driven or scripted component. 

The appearance and functionality of the Automation sub-tab depends on 
the development and use of the component selected in the component 
tree. 

➤ When automating a business component as a keyword-driven 
component in ALM, you add and modify the steps of a business 
component in a keyword-driven, table format. This format is called the 
Keyword view.

You can also automate a component as a keyword-driven component 
in a testing tool such as QuickTest, and save it to the current project. 
When accessing this type of automated component in ALM, the 
automated steps are displayed in Keyword view.

For more information, see Chapter 2, "Understanding the Automation 
Sub-tab - Keyword View."

➤ When automating as a scripted component, a Launch button displays 
enabling you to launch a testing tool, such as QuickTest. 

For more information, see Chapter 2, "Understanding the Automation 
Sub-tab - Scripted View."

For information on working with the Automation sub-tab to automate 
components, see Chapter 5, "Working with Automated Component Steps."

Understanding the Automation Sub-tab - Scripted View
Complex functionality, such as loops or conditional statements, is added to 
a keyword-driven component using operations from a function library that 
was created for your needs by the automation engineer. Scripted 
components can contain this type of programming functionality directly 
inside the steps. They can be created in ALM, QuickTest Professional, or 
another testing tool.

However, the individual steps in the scripted component are not shown in 
the Automation sub-tab, and they can be edited only in the appropriate 
testing tool. Click the Launch button in the Automation sub-tab to open the 
applicable testing tool and edit the component.
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You can include combinations of scripted, manual, and keyword-driven 
component types in business process tests and flows. 

For more information on creating and editing scripted components in 
QuickTest, see the HP QuickTest Professional for Business Process Testing User 
Guide. 

Automation Sub-tab Scripted View Buttons

The Automation sub-tab scripted view contains the following button:

➤ Launch. Launches the applicable testing tool, such as QuickTest, and 
enables you to edit the component directly in the tool.

Understanding the Automation Sub-tab - Keyword View
The Keyword View format of the Automation sub-tab is displayed when a 
component is created in ALM and then automated as a QuickTest keyword-
driven component, or is created as a business component in QuickTest or 
another testing tool. 

The Automation sub-tab of a keyword-driven business component enables 
you to create new steps and modify the existing steps of your business 
component in a keyword-driven, table format. You can provide additional 
information in the form of comments.

Each step or comment in the component is created as a row in the table. 
Columns separate the steps into individual parts, which you can modify if 
required. Each step of a keyword-driven component is automatically 
documented as you complete it, providing a plain-language textual 
description of the component. This information makes it easy to review the 
operations of an implemented (or under development) component.
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You can select which columns to display in the Automation sub-tab and 
their order in the tab. If you do not see one or more of the required columns 
in the tab, you can use the Keyword View Options dialog box to display 
them. You can display the Documentation column only, for example, if you 
want to use the steps as instructions for manual testing. For more 
information, see "Setting Keyword View Options" on page 144.

Note: To view content in the Automation sub-tab, the 
QuickTest Professional Add-in for Business Process Testing must be installed. 
For more information, see "Prerequisites" on page 42.

This topic also contains the following information:

➤ "Automation Sub-tab Example" on page 77

➤ "Automation Sub-tab Keyword View Commands" on page 78

➤ "Automation Sub-tab Keyword View Columns" on page 80
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Automation Sub-tab Example

The steps of the following component were created in ALM. The component 
was then automated as a QuickTest keyword-driven component. You can see 
the automatic conversion of the manual steps that were created in the 
Component Steps tab before the component was automated:

Note: In the sample Automation sub-tab above, an application area has not 
yet been chosen. 
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The following component was created as a business component in 
QuickTest Professional. It already contains automated steps.

Automation Sub-tab Keyword View Commands

The Automation sub-tab keyword view contains the following toolbar 
buttons and context menu commands: 

Toolbar Button Commands

➤ Save. Saves the business component steps and comments. Steps and 
comments you create or modify are not saved until either you click this 
button or you leave the Automation sub-tab. For more information, see 
"Saving Component Steps" on page 151. 

➤ Add Step. Enables you to add a step or comment below the selected step. 
For more information, see "Creating Steps in the Keyword View" on 
page 149. 

➤ Delete Step. Deletes the selected steps or comments.

➤ View Options. Opens the Keyword View Options dialog box, enabling you 
to specify which columns to display in the Automation sub-tab and the 
order in which they are displayed. For more information, see "Setting 
Keyword View Options" on page 144. 

➤ Select Application Area. Enables you to select an application area on 
which to base your business component, or select a different application 
area. For more information, see "Choosing the Application Area" on 
page 139. 
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➤ General Information. Displays information about the business 
component and its path.

➤ Information. Displays the QuickTest Professional Add-in for 
Business Process Testing version installed on your ALM client.

Context Menu Commands from Table Cells

➤ Insert New Step. Enables you to insert an new step below the selected 
row.

➤ Insert Operation. Enables you to insert an operation row below the 
selected row.

➤ Insert Comment. Enables you to insert a comment row below the selected 
row.

➤ Checkpoint Properties. Enables you to compare the current value of a 
specified property with the expected value for that property. For more 
information, see "Adding Additional QuickTest Functionality to the 
Automated Component" on page 82.

➤ Cut. Deletes the selected rows and stores them on the Clipboard.

➤ Copy. Copies the selected rows to the Clipboard.

➤ Paste. Pastes cut or copied rows below the selected row in the tab.

➤ Delete. Deletes selected steps or comments in the tab.

Context Menu Commands from Table Headings

➤ Item. Toggles the display of the Item column on/off.

➤ Operation. Toggles the display of the Operation column on/off.

➤ Value. Toggles the display of the Value column on/off.

➤ Output. Toggles the display of the Output column on/off.

➤ Documentation. Toggles the display of the Documentation column 
on/off.

➤ Documentation only. Hides all columns other than Documentation.

➤ Copy Documentation to Clipboard. Copies the contents of the 
Documentation column to the clipboard.
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Automation Sub-tab Keyword View Columns

The Automation sub-tab in the keyword view format can contain the 
following columns:

➤ Item Column

➤ Operation Column

➤ Value Column

➤ Output Column

➤ Documentation Column

Item Column

The Item column displays the objects in your application on which you 
perform operations. These objects are defined in the object repository that 
was prepared for you by the automation engineer and associated with the 
application area on which your business component is based.

You select the item from an icon-based list, which displays the item and all 
sibling objects of the previous step, as well as any child objects for the 
previous step. 

For example, if the previous step specifies the Login Window object, then 
the User name and Password objects might be displayed for the next step.

This column can also display the Operation item, which enables you to 
select from operations defined in the function libraries associated with your 
component’s application area. For example, operations that open an 
application at the start of a business component or check the value of a 
specific property.

For more information on selecting objects and operations, see "Selecting an 
Item for a Step" on page 152.

If you want to add a comment to your business component, you can select 
Comment from the list. Comments are displayed in a free-text cell that 
extends the entire width of the row.
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For more information on adding comments, see "Entering Comments in the 
Keyword View" on page 162.

Operation Column

The Operation column displays the operation to be performed on the item 
selected in the business component step. This column provides a list of all 
available operations that can be performed on the object selected in the 
Item column, for example, Click or Select.

The available operations change dynamically according to the item selected 
in the Item column. By default, the most commonly used operation for the 
object is displayed.

For more information on selecting operations, see "Selecting an Operation 
for a Step" on page 157.

Value Column

The Value column displays the values for the selected operation. The Value 
cell is partitioned according to the number of values that must or can be 
supplied for the selected operation.

The value can be a fixed value (a constant), a local parameter, or a 
component parameter. 

➤ Local parameter. A local parameter is specific to the business component. 
Its value is defined within the component and can be accessed by that 
component only. It is intended for use in a single step or between 
component steps, for example, as an output parameter for one step and 
an input parameter for a later step. For more information, see 
"Parameterizing in the Keyword View" on page 164.

➤ Component parameter. A component parameter is assigned a value from 
an external source, such as the business process test designer, test runner, 
or from a retrieved value of another component or flow. For more 
information, see Chapter 9, "Working with Parameters." 
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Output Column

The Output column displays the parameter in which output values for the 
step are stored. You can use the value stored in an output parameter later in 
the business component or as an input parameter in other business 
components or flows.

Similar to the Value column, you can use two types of parameters when 
specifying an output parameter—a local parameter or a component 
parameter.

For more information on defining the output type and settings for output 
values, see "Defining Output Values for Steps" on page 159.

Documentation Column

The Documentation column displays read-only auto-documentation of 
what the step does, in a plain-language textual description.

You can copy the contents of the Documentation column to the clipboard. 
Right-click the column header row and select Copy Documentation to 
Clipboard from the displayed menu. Right-click at the location you want to 
paste the text and select Paste.

Adding Additional QuickTest Functionality to the Automated 
Component

When creating steps in a component, automation engineers working in a 
testing tool such as QuickTest can also add standard checkpoint and output 
value steps:

➤ Checkpoint steps compare the current value of a specified property with 
the expected value for that property. 

➤ Output value steps capture one or more values at a specific point in your 
component and store them for the duration of the run session. The values 
can later be used as input at a different point in the run. 

Checkpoint and output value steps are visible and editable in ALM. For 
more information, see "Adding Checkpoints and Output Values to Steps" on 
page 174.
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The New Component Dialog Box

The New Component dialog box enables you to add manual steps to your 
component. You open this dialog box from the Component Steps tab by 
clicking the Add Step button in the toolbar.
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For information on working with the details of your components, see 
"About Designing Manual Component Steps" on page 121.

Note:

➤ You can add user-defined fields and change the label of any of the fields 
in the Components module. You can also customize project lists. For 
more details, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ You can use the Script Editor to restrict and dynamically change the 
fields and values in the Components module. For more details, refer to 
the HP Application Lifecycle Management Administrator Guide.

The New Component dialog box toolbar contains the following buttons:

➤ Clear All Fields. Clears all data in the dialog box. 

➤ Spell Checking. Checks the spelling of the selected word or all the words 
in the component.

➤ Thesaurus. Displays a synonym, antonym, or related word for the selected 
word. 

➤ Spelling Options. Configures the way ALM checks spelling.

For a list of available fields, see "Understanding the Details Tab" on page 62.
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The Component Details Dialog Box

The Component Details dialog box enables you to update the details of a 
business component. 

 

Note:

➤ You can add user-defined fields and change the label of any of the fields 
in the Components module. You can also customize project lists. For 
more details, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ You can use the Script Editor to restrict and dynamically change the 
fields and values in the Components module. For more details, refer to 
the HP Application Lifecycle Management Administrator Guide.
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The Component Details dialog box toolbar contains the following buttons:

➤ Send by E-mail. Sends an email with the component details. For more 
information, see the HP Application Lifecycle Management User Guide.

➤ Spell Checking. Checks the spelling of the selected word or all the words 
in the component.

➤ Thesaurus. Displays a synonym, antonym, or related word for the selected 
word. 

➤ Spelling Options. Configures the way ALM checks spelling.

The Component Details dialog box contains sidebar entries that provide 
additional information about the component. For details on these sidebar 
entries (tabs), see "Business Components Module Tabs" on page 45.

For a list of available fields, see "Understanding the Details Tab" on page 62.
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The Component Step Details Dialog Box

The Component Step Details dialog box enables you to edit a selected step. 

Click a component in the component tree and click the Add Step button or 
Edit Step button on the toolbar to open the dialog box. 

For information on working with the details of your components, see 
"About Designing Manual Component Steps" on page 121.

The Component Step Details dialog box toolbar contains the following 
buttons:

➤ First Step. Jumps to the first manual step in the component.

➤ Previous Step. Jumps to the previous manual step.

➤ Next Step. Jumps to the next manual step.

➤ Last Step. Jumps to the last manual step in the component.
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➤ New Step. Adds a step below the selected step. 

➤ Insert Parameter. Inserts a parameter into the step. This command is 
enabled only when your focus is in the Description or Expected Result 
cells. For more information on inserting parameters, see "Defining Input 
and Output Component Parameters for a Business Component" on 
page 100.

➤ Find Text. Opens the Find dialog box, enabling you to search in the tab 
for steps that contain a specified text value. Select the column in which 
you want to search, and enter the value you want to find. For more 
information, see "Using the Find Dialog Box in the Component Steps Tab" 
on page 72.

➤ Save steps. Saves the component steps that you have created or modified. 
New or changed steps are not saved until either you click this button or 
you leave the Component Steps tab. For more information, see "Saving 
Component Steps" on page 151.

➤ Spell Checking. Checks the spelling of the selected word or all the words 
in the component.

➤ Thesaurus. Displays a synonym, antonym, or related word for the selected 
word. 

➤ Spelling Options. Configures the way ALM checks spelling.
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3
Working with Business Components

You create business components and define their details in the Business 
Components module. You can then combine these components into 
business process tests and flows in the Test Plan module, as described in 
Chapter 6, "Getting Started with Business Process Tests." 

This chapter describes the basic management operations required to create 
and define business components.

This chapter includes:

➤ About Working with Business Components on page 90

➤ Creating a Component Tree on page 91

➤ Defining Business Components on page 93

➤ Viewing and Modifying Business Components on page 101

➤ Mailing Components on page 110

➤ Handling Component Requests on page 110

➤ Analyzing Your Project on page 114

Note: To control access to various modules and tasks, HP Application 
Lifecycle Management (ALM) enables you to configure access permissions 
for users. The procedures described in this chapter are dependent on the 
user or user group to which the user belongs having the proper permissions. 
For more information, see the HP Application Lifecycle Management 
Administrator Guide.
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About Working with Business Components

Before creating business components, you create a component tree in which 
to store them. For details, see "Creating a Component Tree" on page 91.

You create business components in the Business Components module by 
defining the details of the component’s shell (which comprises an overview 
of the information that is required at the test-creation level), such as the 
component’s description, status, implementation requirements, and so on, 
and storing the components in the component tree. You can then 
incorporate the components into business process tests and flows in the Test 
Plan module tabs.

Components created by converting manual tests, or by using other testing 
tools such as QuickTest Professional, are also stored in the component tree 
and can be included in business process tests and flows.

Business component definitions include a description of the component’s 
purpose, the conditions of the application being tested before and after the 
component steps are performed, and the actual steps that comprise the 
component. You can define the steps in the business component as manual 
steps, or you can automate them using a testing tool such as QuickTest.

You can also define manual steps for the component, and then choose 
whether to convert it to an automated QuickTest keyword-driven 
component, or QuickTest scripted component. For keyword-driven 
components, you can begin implementing the automated steps in the 
Keyword View. Components can be created and used to build business 
process tests and flows even if the implementation of the application has 
not yet begun.

You can define input component parameters that are required by the 
business component and output component parameter values returned to 
other components or flows.
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Several of the component shell settings that you define in the Business 
Components module, for example, the snapshot and the component 
parameters, can be viewed and modified in the Business Component 
Settings dialog box in QuickTest. 

Note: For more information on the Business Component Settings dialog 
box, see the HP QuickTest Professional for Business Process Testing User Guide. 

After the business component has been defined, the subject matter expert 
and the automation engineer can work independently of each other, in 
parallel or sequentially, depending on the status of the application being 
tested.

Creating a Component Tree

The component tree displays business components in a graphical hierarchy. 
Icons identify the status of the component and whether it is an automated 
or manual component. 

At the top level of the component tree is the Components root folder, which 
contains the:

➤ Obsolete folder, which contains any components that have been 
removed from the components folders but are still being used by one or 
more business process tests or flows.

➤ Component Requests folder, which contains requests for new 
components.

➤ Business components folders, which contains business components. 

The Components root folder, the Component Requests folder, and the 
Obsolete folder cannot be renamed or deleted. For information on the 
special Obsolete and Component Requests folders, see "Understanding the 
Obsolete Folder" on page 107 and "Requesting New Components for 
Business Process Tests or Flows" on page 227.
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Components cannot be created directly in the root folder. Create 
component folders in which to save your components.

In a version-controlled project, the new components you create are 
automatically checked out.

To create a component folder in the component tree:

 1 Log in to your ALM project as described in the HP Application Lifecycle 
Management User Guide. The ALM window opens.

 2 To access the Business Components module: In the ALM sidebar, under 
Testing, select Business Components. The Business Components module 
opens.

If Business Components is not displayed in the sidebar, see "Accessing 
Business Process Testing" on page 42.

 3 In the component tree, select the Components root folder, or another 
folder in the tree.

 4 Click the New Component Folder button in the tree toolbar, or right-click 
and select New Component Folder. The New Component Folder dialog 
box opens.

 5 Enter a descriptive name in the Component Folder Name box and click 
OK.

Note: Component folder names must not contain two consecutive 
semicolons (;;) or include any of the following characters: \ * ^ 

The new folder is displayed under the folder you selected in step 3.

To add a new business component to a folder:

 1 Select the folder and click the New Component button in the toolbar, or 
right-click the folder and select New Component. The New Component 
dialog box opens. For user interface details, see "The New Component 
Dialog Box" on page 83. 
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 2 Enter a descriptive name in the Component Name box and click OK. The 
new business component is displayed under the folder in the component 
tree. Components in a folder are displayed in alphabetical order. New 
components are automatically assigned the status of Under Development.

Note: Business component names cannot exceed 255 characters, contain 
two consecutive semicolons (;;), or include any of the following 
characters: ! % * { } \ | ‘ : “ / < > ? 
Spaces at the beginning or end of business component names are ignored. 

After you have created your business component, you define its shell and 
content, as described in "Defining Business Components" below.

Defining Business Components

After you create a business component and select it in the component tree, 
the component tabs are displayed. You define the component by entering 
the relevant details into the various component tabs.

This section contains the following topics: 

➤ "Providing Component Details and Implementation Requirements" on 
page 94

➤ "Attaching Images" on page 98

➤ "Defining Input and Output Component Parameters for a Business 
Component" on page 100
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Providing Component Details and Implementation 
Requirements
You provide or view the general details and attributes of the business 
component in the upper area of the Details tab. You can enter additional 
descriptive information in the Notes tab in the lower area of the window. 

You can also edit business components in the Component Details dialog 
box. 

This section describes:

➤ "Component Details Tab and Details Dialog Box" on page 94

➤ "Specifying General Component Details" on page 95

➤ "Specifying Implementation Requirements" on page 96

➤ "Adding Comments to the Business Component" on page 97

Component Details Tab and Details Dialog Box

An example of the Details tab for a component is shown below.
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An example of the Component Details dialog box is shown below.

For a list of the fields available in the Details tab and the Component Details 
dialog box, see "The Component Details Dialog Box" on page 85. 

Specifying General Component Details

You provide or view the general details and attributes of the business 
component in the upper area of the Details tab. 

To specify general component details:

 1 In the Assigned To box, enter or select the name of the user responsible 
for writing and maintaining the testing steps for this business 
component. You can click the arrow to search for a specific user in the 
user list or view users by user group.

 2 In the Status box, you can modify the status of the business component, 
if required. To do so, select a different status from the list. The icon in the 
component tree changes dynamically according to your selection.

Business component statuses and their corresponding icons are described in 
"Business Component Life-cycle and Statuses" on page 58.
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The status can also be modified by the automation engineer in the Business 
Component Settings dialog box in QuickTest.

Specifying Implementation Requirements

You can enter additional descriptive information and implementation 
requirements in the Notes tab in the lower area of the window.

In the Description area, enter a description of the business component’s 
purpose or contents, and the business component’s implementation 
requirements. 

You can use the following section headings that are provided by default:

➤ Summary. Enter an overall textual description of the business 
component’s purpose or contents.

➤ Pre-Condition. Describe the point in the application at which the current 
business component starts. This generally includes information on which 
applications should be open or closed, whether the component should 
launch an application, and/or the state of the application prior to the first 
step in the component.

➤ Post-Condition. Describe the point in the application at which the 
current business component ends. This generally includes information on 
whether the component steps should close any applications and/or 
information on the state of the application after the last step in the 
component. For example, if you want the component to allow iterations, 
the post-conditions should specify that the application’s end state should 
match its state at the beginning of the component.

For keyword-driven components, you can also use this area to specify 
additional functionality that needs to be provided by the automation 
engineer in the form of new, registered operations.
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Notes:

➤ The Description area provides a comprehensive selection of text editing 
and formatting commands. 

➤ The information that you enter in the Business Components module 
Description area can be viewed in the Business Component Settings 
dialog box in QuickTest.

➤ The information can also be viewed in the Component Details pane of 
the Test Script tab in the Test Plan module, as described in "Component 
and Flow Details Pane" on page 202. 

Adding Comments to the Business Component

The Comments Area in the Details tab provides a communication channel 
between different users of the component. 

The automation engineer, other component users, or developers can then 
view the information that you enter. These users may also provide feedback 
or instructions for you in this area. For more information, see "Components 
and Flows Pane" on page 200.

To add comments to the Comments Area:

 1 Click the Add Comment button to automatically insert your user name 
and the current server date into the Comments Area as an introduction to 
your comments.

 2 Enter any additional information or remarks that you want to 
communicate to the automation engineer or other users, such as requests 
for new operations, future changes planned for the component, or 
alternative tests or flows in which the component can be used.

Note: The Comments area provides a comprehensive selection of text 
editing and formatting commands. 
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Attaching Images
A snapshot of a specific part of the application provides a visual cue of the 
contents or purpose of the business component. You can view the image for 
each component in a business process test or flow in the Test Script tab of 
the Test Plan module by clicking the relevant thumbnail image. Viewing the 
sequence of these images can help you to better understand the business 
process test or flow.

You can capture and attach an image associated with the business 
component using the Snapshot dialog box, or you can load a previously 
saved .png, .jpg, .gif, or .bmp image from your local drive. 

Only one image can be attached to a business component.

For user interface details, see the HP Application Lifecycle Management User 
Guide.

➤ Attaching an image is described in "Attaching an Image to a Business 
Component" on page 98.

➤ Loading a saved image is described in "Loading an Image" on page 99.

Attaching an Image to a Business Component

You capture and attach an image associated with a business component in 
the Snapshot tab.

To attach an image to a business component:

 1 In the Business Components module, select the relevant business 
component in the component tree and click the Snapshot tab.

 2 Click the Snapshot button in the toolbar.
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The Snapshot dialog box opens.

 3 Display the object you want to capture on your desktop. The Snapshot 
dialog box remains in view.

 4 Drag and drop the camera icon from the Snapshot dialog box onto the 
object you want to use for your snapshot image. The image is captured 
and displayed in the Snapshot dialog box.

 5 Click the Attach button. The image is saved and displayed in the 
Snapshot tab of the component.

Loading an Image

You can load an image for your component from a local drive.

To load an image for a business component:

 1 Select the relevant business component in the component tree and click 
the Snapshot tab.

 2 Click the Load from File. button in the toolbar. The Select Snapshot dialog 
box opens.
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 3 Browse to the location of the snapshot you want to attach and click 
Open.

Note: The image that you attach or load in the Business Components 
module Snapshot tab can be viewed in the Test Script tab of the Test Plan 
module, as described in "Test Script Tab" on page 196. 

The image can also be viewed or replaced in the Business Component 
Settings dialog box in QuickTest. 

Defining Input and Output Component Parameters for a 
Business Component
In the Parameters tab, you can define the input component parameters that 
the business component can receive and the output component parameters 
that the component can pass to other components and flows. Input 
component parameters enable components to use data provided by an 
external source. Output values enable data from one component to be 
passed as an input value to a subsequent component or flow in the test.

Component parameter names, descriptions, and default values (in the case 
of input component parameters) are initially defined in the Business 
Components module. Actual values for input component parameters are 
assigned in the Test Plan module. 

For task details on working with parameters, see Chapter 9, "Working with 
Parameters." 
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Viewing and Modifying Business Components

You can view and modify business components and component folders in 
the component tree. 

Viewing and Modifying Business Components in the 
Component Tree
When the Business Components module is first accessed, the component 
tree displays only the highest level folder or business component in the 
hierarchy. Expand the folders as necessary.

To modify a component, select it in the tree and edit the data in the 
displayed tabs. Alternatively, double-click the component and edit the data 
in the Component Details dialog box. For more information, see "Defining 
Business Components" on page 93.

To refresh a folder or business component in the tree, select the folder or 
component and click the Refresh All button in the toolbar. 

To filter or sort the business components in the tree, click the Filter/Sort 
button in the toolbar to open the Filter components dialog box. Any 
currently applied filters or sort orders are displayed under the component 
tree toolbar. 

When defining a filter, you can also include a cross filter, which is available 
in the Cross filter tab of the Filter components dialog box. This is an 
advanced, second filter on fields in the Test Plan module. For example, you 
can define the cross filter to display the components in the component tree 
that exist in a specific business process test. 

For more information on filtering and sorting a tree, and on using a cross 
filter, see the HP Application Lifecycle Management User Guide.
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Copying Folders and Business Components
You can copy an existing business component or folder and paste it to 
another location in the component tree, or to another project or server. You 
can also share all the components in a project across multiple projects.

This section describes:

➤ "Copying Business Process Testing Entities to Other Projects" on page 102

➤ "Copying Components or Component Folders in the Current Project" on 
page 104

➤ "Copying Components or Component Folders between Projects" on 
page 105

➤ "Sharing Components and Component Resources" on page 107

Copying Business Process Testing Entities to Other Projects

When copying a business component, an application area, or a component 
folder to another project or server, consider the following:

When Copying... Consider the Following...

All Entities ➤ Both servers must be running the same version of 
ALM.

➤ The source and target projects must be opened in 
separate browsers.

➤ Before you copy components that were created in 
a previous version of Quality Center, you must 
upgrade them to the current version. For more 
information, see the HP Application Lifecycle 
Management Administrator Guide. 
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All Entities (continued) ➤ In a version-controlled project, you can copy and 
paste any checked in entity, as well as any entity 
that is checked out by another user - the copied 
entity will contain the last checked-in data. 
However, you cannot copy and paste an entity 
that is currently checked out by you. You must 
first check in the entity and all its checked-out 
dependencies before copying and pasting it. 

For example, consider a business process test 
containing a flow, which in turn contains a 
business component and a scripted component. 
Before copying and pasting the test, you need to 
check in the components in the Business 
Components module, the resources associated 
with those components in the Test Resources 
module, and the flow in the Test Plan module.

Business Components ➤ If the component path in the target project 
already exists, and a business component in a test 
or flow matches the name and signature of an 
existing component (meaning the number of 
parameters, parameter types, and so on), the 
existing component is linked to the business 
process tests or flows that include it, and the 
original component is not copied. 

➤ If the signatures do not match, the component is 
copied and a suffix, for example _Copy_1, is 
automatically added to the component name to 
create a unique name.

When Copying... Consider the Following...
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Copying Components or Component Folders in the Current 
Project

You can copy components or component folders within the same project. 
For more information, see "Copying Business Process Testing Entities to 
Other Projects" on page 102

To copy an existing folder or business component:

 1 Select the components or component folders that you want to copy in the 
component tree. 

Folders ➤ If a copied folder has the same name as a folder 
that already exists in the target folder, a duplicate 
name warning message is displayed. Click OK. 
The folder is copied to the new position in the 
component tree, and a suffix, for example 
_Copy_1, is automatically added to the folder 
name.

➤ Components within folders that are copied in 
the component tree are also copied. All 
considerations for copying individual 
components to other projects or servers, as 
described above, also apply to all components 
copied when you copy a folder. You can then use 
the settings and steps of the copied components 
as the basis for new components.

Application Areas When you copy a business component, its 
associated application area is also automatically 
copied, unless an application area with the same 
name already exists in the location in which you are 
copying the component.

Caution: If an application area with the same name 
already exists in the target location, the application 
area is not copied, and the new component is linked 
to the existing application area. You must check to 
ensure that the application area in the new location 
has the correct settings and resource files for the 
component you are copying.

When Copying... Consider the Following...
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 2 Right-click and select Copy. Alternatively, Select Edit > Copy.

 3 In the component tree, right-click the folder in which you want to paste 
the new folder or business component, and select Paste. The folder or 
component is copied to the new position in the component tree.

 4 If you want to change the name of the copied folder or business 
component, right-click the folder or component in the tree, select 
Rename from the context menu and then enter a new name.

 5 If required, select the copied business component in the tree and modify 
the settings in the tabs as described in "Defining Business Components" 
on page 93. 

Copying Components or Component Folders between Projects

You can copy components or component folders from one project to 
another. For more information, see "Copying Business Process Testing 
Entities to Other Projects" on page 102.

If the components or component folders have related entities, you can 
instruct ALM to copy them using one of the following methods: 

➤ Copy components or component folders and their related entities to the 
target project. Entities in the target project with duplicate names are 
renamed.

➤ Copy components or component folders to the target project and 
associate them to existing entities with the same name. 

➤ Copy components or component folders to the target project without 
copying related entities. The associations to the entities are removed.

To copy a component or component folder between projects: 

 1 If copying to another project or server, open the source and target projects 
in separate browsers.

 2 Select the components or component folders that you want to copy in the 
component tree.

 3 Right-click and select Copy. Alternatively, select Edit > Copy.

 4 Open another instance of ALM and log into the project to which you 
want to paste the components.
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 5 Select the folder to which you want to copy the components or 
component folders.

 6 Right-click and select Paste. Alternatively, select Edit > Paste. The Paste 
Components/Component Folders to Target Project dialog box opens.

 7 Select one of the following options:

➤ Copy components/component folders and link to associated entities. 
ALM copies the components or component folders and pastes them 
into the target project. The copied components or component folders 
are linked to related entities with the same name and path. If an entity 
does not exist in the target project, ALM copies it to the target project 
and links it to the component.

➤ Copy components/component folders and associated entities. ALM 
copies the components or component folders along with the related 
entities and pastes them into the target project. If a related entity 
already exists in the target project, the copied entity is renamed to 
resolve the duplicate name.

➤ Copy components/component folders without copying associated 
entities. ALM copies the components/component folders without 
copying related entities, and pastes them into the target project. The 
copied items are not associated with any entities.

Click OK. 
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Sharing Components and Component Resources

In addition to copying components, you can share all the components in a 
project across multiple projects. ALM enables you to create baseline libraries 
of components, tests, and other entities, together with their resources. These 
entities can then be reused in other projects. For more information, see the 
HP Application Lifecycle Management User Guide.

Understanding the Obsolete Folder
When you delete business components that are currently being used by one 
or more business process tests or flow, they are automatically transferred to 
the Obsolete folder.

Business components in the Obsolete folder are read-only, cannot be 
modified, and cannot be added to other tests and flows. 

Business components in the Obsolete folder can be restored to their original 
location using the Restore option, as described in "Restoring Obsolete 
Business Components" on page 109. They can also be transferred to any 
position in the component tree by dragging them from the Obsolete folder 
to the required position. 

Note: Business components whose original location folders have been 
deleted (and exist in the Obsolete folder), and component requests that 
were not previously located in the component tree, can be transferred to the 
component tree using the drag and drop method only.

You can delete business components from the Obsolete folder if they are no 
longer being used by any business process test or flow.

Tip: You can simultaneously delete from the Obsolete folder all the business 
components that are no longer being used by any business process test or 
flow. Right-click the Obsolete folder and select Clean unused components. 



Chapter 3 • Working with Business Components

108

When importing libraries, components in the Obsolete folder are not 
included in the process. 

In a version-controlled project, components in the Obsolete folder cannot 
be checked in or checked out. For information on working with version 
control in ALM, see the HP Application Lifecycle Management User Guide.

Removing Business Components
You can delete a folder or remove a business component that is not required.

Business components that are not being used by any business process test or 
flow are permanently deleted. Components that are being used by one or 
more business process tests or flows are automatically transferred to the 
Obsolete folder. Obsolete business components cannot be copied, modified, 
or added to other tests and flows. For more information on the Obsolete 
folder, see "Understanding the Obsolete Folder" on page 107.

The deletion date and original location of a removed business component in 
the Obsolete folder are shown in the component’s Details tab. 

In addition, the component status is displayed with the Obsolete icon in 
the Test Script tab in the Test Plan module, to indicate that the component 
should not be used in business process tests or flows.

If you delete a component folder in the component tree, its subfolders and 
all the business components in the folders are removed. Components 
contained in the folders that are being used by one or more business process 
tests or flows are transferred to the Obsolete folder.

Note: Business process tests or flows containing one or more obsolete 
components are assigned the status of Outdated, indicating that a more 
up-to-date component may be required in the test or flow. 

Before you choose to remove a business component, you can check whether 
any business process tests or flows are using that component by selecting it 
in the tree and clicking the Dependencies tab.
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To remove a folder or business component:

 1 Select the folder or business component in the component tree and click 
the Delete button in the toolbar, or right-click the folder or component 
and select Delete. A warning message is displayed.

 2 Click OK. The folder or business component is removed. Components 
that are currently being used by a business process test or flow are 
transferred to the Obsolete folder. 

Tip: To view a removed business component in the Obsolete folder in the 
component tree, you must first refresh the folder. Select the Obsolete 
folder and click the Refresh All button in the tree toolbar. 

Restoring Obsolete Business Components
Business components in the Obsolete folder can be restored to their original 
position in the component tree, if the folder still exists in the tree.

You can view the folder in which the business component was located when 
it was last deleted in the Original Location field in the Component Details 
tab. The date that the component was deleted is also displayed in the 
Deleted on field.
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To restore a business component, right-click the component in the Obsolete 
folder, and select Restore. The component is restored to its original location 
in the component tree.

Note: You can also select the component in the Obsolete folder and drag it 
to the appropriate folder in the component tree. This method must be used 
for business components whose original location folders have been deleted 
in the component tree.

Mailing Components 

You can send an e-mail about a component to another user. A link is 
included in the email message that enables the recipient to go directly to the 
component in the Business Components module.

To send an email about a business component in the tree, select the 
component and click the Send by E-mail button in the toolbar. 

For more information, see the HP Application Lifecycle Management User 
Guide.

Handling Component Requests

It is possible that none of the existing business components in the 
component tree meets the needs of a business process test or flow. If a 
necessary component has not been defined, a request for a new component 
can be initiated, created, edited, and submitted directly from the Test Plan 
module. This feature is especially useful when the roles of creating 
components in the Business Components module and building business 
process tests or flows in the Test Plan module are performed by different 
personnel.
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After a component request has been submitted from the Test Plan module, it 
is automatically displayed in the Component Requests folder in the 
component tree of the Business Components module. Component requests 
cannot be copied in the Component Requests folder, but they may be edited 
and version control is supported. Component requests can also be edited in 
the Test Plan module.

You can select the Dependencies tab to view details of the business process 
tests or flows that are already using the requested business component.

To change component requests to official business components of the 
project, you can drag them from the Component Requests folder and drop 
them in the appropriate folder in the component tree, or cut and paste them 
into a component folder. When the component requests are moved out of 
the Component Requests folder, their status changes from Not 
Implemented to Under Development.

You can also delete the request if an existing component already answers the 
same needs as the request, or you otherwise determine that the requested 
component is unnecessary.

When importing libraries, components in the Component Requests folder 
are not included in the process. 
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In a version-controlled project, component requests cannot be checked in or 
checked out. For information on working with version control in ALM, see 
the HP Application Lifecycle Management User Guide.

For more information on requesting business components for business 
process tests or flows, see "Requesting New Components for Business Process 
Tests or Flows" on page 227.

Adding Component Requests to the Component Tree as 
Business Components
If no existing business component answers the needs defined in the 
component request, create a business component and add it to the 
component tree. 

To add a component request to the component tree:

 1 Click the Refresh All button above the component tree to ensure that the 
most recent component requests are displayed in the tree.

 2 Select the required component request and drag it to the appropriate 
folder in the component tree. 

The request is displayed in the new position in the tree and its 
component tabs are displayed. The status of the request changes from Not 
Implemented to Under Development.

 3 To rename the request, select it in the tree and then click it. Alternatively, 
right-click the request and select Rename. Edit the request name and press 
ENTER.

 4 Edit the component in the Details, Snapshot, and Parameters tabs, and 
create component steps in the Component Steps tab, as described in 
"Defining Business Components" on page 93.
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Deleting Component Requests
If a requested business component is not required, you can remove the 
request from the Component Requests folder. 

Note: Business process tests or flows containing one or more obsolete 
component requests are assigned the status of Outdated.

Before you choose to remove a component request, you can check whether 
any business process tests or flows are using that component request by 
selecting it in the Component Requests folder and clicking the 
Dependencies tab.

Component requests in the Obsolete folder are read-only and cannot be 
modified, but they can be transferred to any position in the component tree 
by dragging them from the Obsolete folder to the required position. 

You can delete component requests from the Obsolete folder only if they are 
no longer being used by any business process test or flow.

To delete a component request from the Component Requests folder:

 1 Select the component request in the Component Requests folder and 
click the Delete button in the toolbar. A warning message is displayed.

 2 Click OK. The request is removed from the folder. Component requests 
that are currently being used by one or more business process tests or 
flows are transferred to the Obsolete folder. Component requests that are 
not currently being used by any business process test or flow are 
permanently deleted from the project.
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To permanently delete a component request:

 1 Select the component request in the Component Requests folder and 
click the Dependencies tab to check that the request is not currently 
being used by any business process test or flow. 

 2 Select the component request in the Obsolete folder and click the Delete 
button in the component tree toolbar, or right-click the request and select 
Delete. A warning message is displayed.

 3 Click OK. The component request is permanently deleted from the 
project.

Analyzing Your Project

ALM provides a number of features that enable you to analyze the business 
process testing data in your project.

This section contains the following:

➤ "Generating Reports and Graphs" on page 114

➤ "Generating Project Documents" on page 117

Generating Reports and Graphs
You can create Business Process Testing standard reports and graphs that are 
customizable in the ALM Dashboard module. 

You can also create Business Process Testing standard reports (quick reports) 
and graphs in the Analysis menu of the Business Components module (and 
the Test Plan module). You can use these quick reports for one-time 
reference, or you can save them in the Dashboard module, where you can 
continue to configure their data and appearance. The Dashboard module 
allows you to define the data that the report or graph includes, and add 
extra layers of related data in sub-reports. 

For a list of available predefined reports and graphs for Business Process 
Testing, see "Predefined Standard Reports" on page 115, and "Predefined 
Standard Graphs" on page 116.
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To create standard predefined (quick) reports in the Business Components 
module, see the HP Application Lifecycle Management User Guide.

To define what data appears in a graph, and how the data is organized, see 
the HP Application Lifecycle Management User Guide.

For more information on the Dashboard module, see the HP Application 
Lifecycle Management User Guide.

In addition, you can use the Graph Wizard from the Business Components 
module or the Dashboard module to create graphs of component data 
(Select Analysis > Graphs > Graph Wizard.) You use the Graph Wizard to 
create graphs of component data in the same way as you create graphs in 
other ALM modules. For task details on the wizard, see the HP Application 
Lifecycle Management User Guide.

This section contains the following:

➤ "Predefined Standard Reports" on page 115

➤ "Predefined Standard Graphs" on page 116

Predefined Standard Reports

To create business process testing reports, select from a list of predefined 
quick reports in the Analysis > Reports sub-menu of the Business 
Components and Test Plan modules.

The following quick reports are available in the Business Components 
module:

➤ Standard Component Report. Shows all the components currently in the 
ALM project, including all detail fields, the component descriptions, 
history, and whether it includes a snapshot.

➤ Component Hierarchy Report. Shows the components currently in the 
ALM project, including all detail fields and the component descriptions. 
Obsolete components and component requests are not shown in this 
report.

➤ Components with Design Steps. Shows all the components currently in 
the ALM project, including some detail fields, the component 
descriptions, and each component’s steps.
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➤ Components Used By. Shows all the components currently in the ALM 
project, including some detail fields, the component descriptions, and the 
business process tests and flows that use each component.

➤ Components with Application Area. Shows all the components currently 
in the ALM project, including some detail fields, the component 
descriptions, and the application area (if any) used by each component.

➤ Report Selected. Lists the components currently selected in the tree.

The following business process testing report is available in the Test Plan 
module:

➤ Business Process Tests with Script. Shows all the business process tests 
and flows currently in the ALM project, including some detail fields, the 
test or flow descriptions, and the components included in each test or 
flow. This report also includes information about groups, iterations, On 
Failure status, and contents of flows inside business process tests.

Predefined Standard Graphs

To create business process testing graphs, select from a list of predefined 
quick graphs in the Analysis > Graphs sub-menu of the Business 
Components module. 

The following quick graphs are available:

➤ Components Summary - Group by ’Status’. Shows how many 
components are currently in the ALM project. The number of 
components is displayed according to the criteria that you specify. You 
can specify the type of data displayed along the x-axis, and the test plan 
information by which ALM groups the data. By default, the graph appears 
as a bar chart.

➤ Components Progress - Group by ’Status’. Shows how many components 
existed in a ALM project at each point during a period of time. The 
number of components is displayed according to the criteria that you 
specify. You can specify the time interval displayed along the x-axis, and 
the test plan information by which ALM groups the data. You can also 
specify whether you want to view the history of the selected data field, 
and whether you want to view the number of tests or the change in the 
number of tests. The graph can be viewed as a line chart only. 
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➤ Components Trend - Group by ’Status’. Shows the history of changes to 
specific component fields in a ALM project, at each point during a period 
of time. You specify the field for which you want to view the number of 
changes, and the time period for which you want to view data. The graph 
can be viewed as a bar chart only.

Generating Project Documents
The ALM Document Generator enables you to create a Microsoft Word 
document that includes information about the project’s business 
components. 

Business component documentation can include the following for each 
component in the project: Description, Details, Snapshot, Steps, and Used 
By. 

For general information on how to generate project documents, see the 
HP Application Lifecycle Management User Guide.

For user interface information specific to Business Process Testing, see 
"Business Components Page" on page 118.
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Business Components Page

This page enables you to specify the component information from the 
Business Components module that should appear in the Components 
section of the project document.

To access Select Tools > Document Generator. Then, in the 
Document Generator tree, select the Business 
Components link.

Important 
information

Select the check box next to the Business Components 
link to include the data in the project document.

Relevant tasks “How to Generate a Project Document” in the 
HP Application Lifecycle Management User Guide

See also “Document Generator Window” in the HP Application 
Lifecycle Management User Guide



Chapter 3 • Working with Business Components

119

User interface elements are described below:

UI Elements (A-Z) Description

Components Select one of the following options:

➤ All components. Includes all the business components 
from the component tree.

➤ Selected. Includes only selected business components. 

Click the Filter & Sort button to specify the criteria for 
selecting requirements. For details on using the Filter 
dialog box, see the HP Application Lifecycle Management 
User Guide.

Full page layout Use to customize the page layout. Click the Customize 
button to choose the information that you want to 
appear in the document, such as the component status, 
description, and whether iterations of the component are 
allowed.

Page break after 
each component

Inserts page breaks in the project document after each 
component.

Snapshot Includes component snapshots in the document.

Steps Includes all the steps of the selected components. 

Click the Customize button to configure the tabular 
layout and the step information that you want to appear 
in the document, such as the step name, description, and 
expected result.

Tests that use the 
component

Includes a list of business process tests or flows that use 
the component.
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4
Designing Manual Component Steps

Use the Component Steps tab in the Business Components module to create 
or modify manual business component content in the form of steps and 
expected results. Combine your manual components into business process 
tests and flows and follow the steps to manually test your application.

This chapter includes:

➤ About Designing Manual Component Steps on page 121

➤ How to Design Manual Step on page 124

➤ Working with Parameters in Manual Steps on page 128

➤ An Example of Using Manual Steps to Manually Test an Application 
on page 130

About Designing Manual Component Steps

You design manual component steps by: 

➤ Creating and Modifying Steps in the Component Steps Tab on page 122

➤ Parameterizing Steps on page 122

➤ Automating Steps—Optional on page 123
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When you finish designing your manual steps, you can run tests containing 
components manually using the Test Lab module. You can check the actual 
results in the application against the expected results, and then indicate 
whether the individual steps of the components passed or failed.

Note: You can use your manual steps as guidelines for creating automated 
steps at a later time, using an applicable testing tool. You can use your 
manual steps even before the application is ready to be tested automatically, 
or before automated tests are complete. For more information, see 
Chapter 5, "Working with Automated Component Steps."

Creating and Modifying Steps in the Component Steps 
Tab
The Component Steps tab provides a tabular format in which you can create 
and modify manual steps in your business components. These steps 
represent operations that should be manually performed on your 
application when you run the component in a business process test or flow. 
You can also provide additional information in the form of expected results 
and comments.

In the Component Steps tab for manual components, you create each step 
in the component using the Component Details dialog box. For user 
interface details, see "The Component Details Dialog Box" on page 85. 

Each step comprises a step name, a textual description of the procedure to 
be performed on the application, and the expected result (if any), of 
performing that step.

Parameterizing Steps
You can expand the scope of your tests, flows, and business components by 
using variable input and output parameter values in your manual steps. 
Using variable values in your components can affect test results. When you 
run your component manually, the parameter is replaced with an assigned 
value.
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HP Application Lifecycle Management (ALM) enables you to create 
parameters directly from the Component Steps tab and insert them into 
your component steps. 

You can insert input and output parameters into your steps if required. 
When you enter parameters, you enclose the parameter names between 
three sets of angle brackets (<<<parameter>>>). (Parameters that you insert 
into your steps using the Select Parameter feature are automatically 
displayed between <<< >>> brackets.) 

Note: ALM recognizes the text between <<< >>> brackets as parameter 
names, and displays the parameters, or their defined values, for your use 
when you manually run the component. Therefore it is recommended that 
you avoid using < or > symbols in parameter names or text in your steps.

Automating Steps—Optional
Later, you can convert your manual component to an automated 
component. After you automate a component, you can still view its steps in 
the Manual Steps sub-tab in the Component Steps tab, and you can still run 
the tests containing this component manually, using the descriptions of the 
automated steps. 

After automating a component, the manual steps are displayed in read-only 
format. You can edit the content of your original manual steps from the 
Keyword View in the Automation sub-tab (for keyword-driven components) 
or the testing tool (for scripted components). This means that you can 
update automated components in either ALM or a testing tool and still 
continue to run them manually when needed.
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For more information on working with automated steps, see Chapter 5, 
"Working with Automated Component Steps."

How to Design Manual Step

You can design manual steps in the Component Step Details dialog box.

This section describes:

➤ "Creating Manual Steps" on page 124

➤ "Modifying Manual Steps" on page 127

➤ "Copying Manual Steps" on page 127

➤ "Deleting Manual Steps" on page 127

Creating Manual Steps
To design manual component steps:

 1 After you have created a new business component, as described in 
Chapter 3, "Defining Business Components," in the component tree, 
select the business component and click the Component Steps tab. 

Tip: Manual components in the component tree are indicated by an M 
symbol on the component icon, for example, .
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The Component Steps tab for a manual component opens.

 2 In the Component Steps tab toolbar, click the New Step button.

The Component Step Details dialog box opens.

 3 In the Step Name box, enter a descriptive name for the step. 
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 4 In the Description box in the Details tab, enter a full description of how 
to perform the first manual step.

 5 In the Expected Result box, enter the expected application response to 
performing the step.

 6 If you want to include parameters in the descriptions or expected results 
of your manual step, enter the parameter name at the appropriate point 
in the text, enclosed in three sets of angle brackets < > (that is, 
<<<parameter>>>). The parameter name is automatically validated when 
you move to another step. 

Note: If you apply any text formatting to the parameter name, you must 
apply the same formatting to the three sets of angle brackets <<<>>>. If 
you do not, a validation error message opens when you close the step.

Alternatively, click the Insert Parameter button after positioning the 
mouse pointer at the point in the text where you need to enter a 
parameter. Use the Parameters dialog box to either create a new parameter 
or to select an existing one from a list. 

Note: For more information on parameters, see Chapter 9, "Working with 
Parameters." 

 7 In the Component Step Details dialog box toolbar, click the Save Step 
button while you work to ensure you do not lose any data.

 8 In the Component Step Details dialog box toolbar, click the New Step 
button to create another new step.

 9 After saving your steps, click OK in the Component Step Details dialog 
box. The manual steps are displayed in the Component Steps tab.

 10 In the Component Steps tab toolbar, click the Save Steps button.
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Modifying Manual Steps
In a manual component, you can modify manual steps in the Component 
Step Details dialog box or directly in the Component Steps tab.

➤ To modify a manual component step in the Components Step Details 
dialog box, click the Edit Step button in the Component Steps tab 
toolbar. Click the Save steps button.

➤ To modify a manual component step in the Component Steps tab, select 
any cell, click the cell again, and modify the step. When you have 
finished, click the Save steps button.

Copying Manual Steps
When working in the Component Steps tab, you can use standard editing 
Copy and Paste commands in the context menu to make it easier to create 
and modify your steps. 

To copy a manual component step:

 1 In the Component Steps tab, right-click the step and select Copy.

 2 Right-click a folder and select Paste. 

Deleting Manual Steps
You can delete manual steps if required.

To delete manual component steps:

 1 In the Component Steps tab, select one or more steps that you want to 
delete.

 2 Click the Delete Selected button in the toolbar. A warning message is 
displayed.

 3 Click Yes to delete the selected items. 
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Working with Parameters in Manual Steps

You can use parameters to parameterize input and output values in steps.

➤ Input parameters pass values into your business component.

➤ Output parameters pass values from your component to later components 
in the business process test or flow, or from one step to another step later 
in the same business component. 

Generally, you define component parameters in the Parameters tab of the 
Business Components module. This is discussed in Chapter 9, "Working 
with Parameters."

You can also create and insert parameters directly from the Component 
Steps tab, as described in this section.

Inserting Parameters into Manual Steps
You can insert parameters into new or existing manual steps in the 
Description or Expected Result columns of the Component Steps tab or the 
Component Step Details dialog box. 

The parameters that you insert are enclosed in three sets of angle brackets, 
for example, <<<user_name>>>.

When you run your component manually, the inserted parameter is 
replaced with the value of that parameter. For example, if Tom was defined 
as the value for the user_name parameter, then when you run the manual 
test, the step “Enter <<<user_name>>> in the Agent Name box” would be 
displayed as “Enter Tom in the Agent Name box”.

To insert parameters into manual steps by typing:

If you know the exact name of the parameter, at the point in the text where 
you need to enter a parameter in the Description area or Expected Result 
area, enter the name enclosed in <<<>>> brackets. 

To insert parameters into manual steps by selecting from a list:

 1 In the Component Steps tab or the Component Step Details dialog box, 
enter the appropriate text for your step in the Description area or 
Expected Result area.
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 2 At the point in the text where you need to enter a parameter, click the 
Insert Parameter button in the toolbar. 

The Parameters dialog box opens. The dialog box contains a list of all the 
existing input and output parameters in the component, and enables you 
to create a new parameter.

Note: If the required parameter is not in the list, you can create it by 
clicking the New Parameter button in the toolbar. For more information, 
see "Inserting Parameters into Manual Steps" on page 128.

For details on the Parameters dialog box, see "The New Parameter and 
Parameter Details Pages" on page 297.

 3 Select the required parameter in the list and click OK. The parameter is 
inserted into the text, enclosed in <<< >>> brackets.
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An Example of Using Manual Steps to 
Manually Test an Application

Each manual component step you create comprises a row in the 
Component Steps tab. For example, you could create the manual 
component shown below. Its rows contain the steps that are performed to 
log into the Mercury Flight Reservations sample application. Using the 
manual steps as a guide, do the following manually:

➤ Access the application and open the Login page.

➤ Enter the value of the parameter <<<UserName>>> in the Agent Name 
edit box.

➤ Enter the value of the parameter <<<Password>>> in the Password edit 
box.

➤ Click the OK button and open the Flight Reservation page.

The Component Steps tab for the component is displayed as follows: 

For more details on running manual components, see Running a Business 
Process Test or Flow Manually on page 380.
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5
Working with Automated Component 
Steps

You create automated components by converting manual components to 
automated components. You use the Automation sub-tab from the 
Component Steps tab in the Business Components module to add or modify 
business component content in the form of automated steps, operations, 
and comments.

Note: This section primarily discusses automation using HP 
QuickTest Professional. However, you can also automate components with 
HP Service Test 11.10 or later. For more information, see the HP Service Test 
User Guide and HP Software Self-solve knowledge base article KM1016396 
(http://h20230.www2.hp.com/selfsolve/document/KM1016396).

This chapter includes:

➤ About Automating Components on page 132

➤ Working with Application Areas on page 136

➤ Generating a Script to Automate Components on page 140

➤ Automating Using the Scripted Automation Type on page 142

➤ Automating Using the Keyword-driven Automation Type on page 143

➤ Creating Steps in the Keyword View on page 149

➤ Entering Comments in the Keyword View on page 162

➤ Parameterizing in the Keyword View on page 164

http://h20230.www2.hp.com/selfsolve/document/KM1016396
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➤ Modifying Component Steps in the Keyword View on page 172

➤ Adding Checkpoints and Output Values to Steps on page 174

About Automating Components

You can automate previously-created manual component steps using the 
applicable testing tool, and use the manual step operations as guidelines for 
your automated steps. Automate using the Automation sub-tab of the 
Component Steps tab, which provides: 

➤ For keyword-driven automated components: A graphical format in which 
to create and modify automated keyword-driven business component 
steps. This format is called the Keyword View. The steps in the Keyword 
View represent the operations that are performed automatically on your 
application when you run the component using a testing tool. 

➤ For scripted automated components: A way to launch the relevant testing 
tool. When working with scripted components, the component steps can 
be viewed or modified only within the relevant testing tool. 

Note: The Automation sub-tab for keyword-driven steps provides similar 
functionality to the Business Component Keyword View in QuickTest. For a 
full description of the functionality provided in QuickTest, see the 
HP QuickTest Professional for Business Process Testing User Guide. 

The workflow for automating manual component steps comprises the 
following: 

➤ Preparing Automation Resources on page 133

➤ Generating a Script on page 134

➤ Adding Operations and Comments to the Steps on page 134

➤ Parameterizing the Steps—Optional on page 135

➤ Adding Checkpoints and Output Values—Optional on page 135
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Preparing Automation Resources 
The business component resources for the project are created automatically 
in the Test Resources module by the QuickTest Professional Add-in for 
Business Process Testing. This occurs the first time you click the Automation 
sub-tab in a new project, when you create a QuickTest automated 
component for the first time, or when QuickTest connects to HP Application 
Lifecycle Management (ALM) for the first time. These resources are stored in 
the BPT Resources folder.

For business process tests or flows to perform properly, this folder and its 
subfolders should not be renamed or deleted.

Note: In previous versions of Quality Center, the BPT Resources folder was 
created in the Test Plan module. When upgrading from Quality Center 
version 9.2, a BPT Resources folder that already exists in the Test Plan 
module must be moved to the Test Resources module using the QuickTest 
Asset Upgrade Tool for Quality Center. 

The BPT Resources folder contains all the QuickTest resources available for 
business components in the project, and includes the following subfolders:

➤ Application Areas. Provides all of the settings and resources required to 
create the content of keyword-driven business components for a 
particular application or part of an application. The application area 
typically contains all the items contained in the folders listed below.

➤ Libraries. Contains all the function libraries available for business 
components in the QuickTest project. Function libraries provide 
customized operations for business components. 

The Libraries folder contains the default function library containing 
operations that can be used when creating business component steps. The 
automation engineer can store additional function libraries in this folder.

➤ Object Repositories. Contains all the shared object repository files 
available for business components in the QuickTest project. Object 
repository files define the test objects that can be used in the steps of a 
business component. 
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➤ Recovery Scenarios. Contains all the recovery scenario files available for 
business components in the QuickTest project. Recovery scenarios define 
special operations to recover from errors and unexpected events during 
the component run. By default, the Recovery Scenarios folder contains 
the DefaultWeb.qrs file, which is a recovery scenario file that can be used 
in the Web environment.

For conceptual information about application areas, see "Working with 
Application Areas" on page 136.

Generating a Script
You create manual components in the Component Steps tab. For more 
information on manual components and steps, see Chapter 4, "Designing 
Manual Component Steps."

You can then automate the manual components using the applicable testing 
tool and use the existing manual steps as guidelines to create automated 
steps.

For conceptual details about generating the script for automation, see 
"Generating a Script to Automate Components" on page 140.

For task details about generating the script for automation, see "How to Start 
Automating Manual Component Steps by Generating a Script" on page 141.

Adding Operations and Comments to the Steps
You can provide additional information in the form of free-text comments. 
You can mix and match entries in a component by including standard steps, 
operations, and comments, thereby ensuring that every aspect of the 
application to be tested is covered, even before the application is ready to be 
tested.

For details about adding operations and steps, see "Creating Steps in the 
Keyword View" on page 149.

For details about adding comments, see "Entering Comments in the 
Keyword View" on page 162.
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Parameterizing the Steps—Optional
You can also expand the scope of your tests, flows, and business 
components by using variable input and output parameter values in your 
business process test or flow. Using variable values in your components can 
affect test results.

For more information, see "Parameterizing in the Keyword View" on 
page 164.

Adding Checkpoints and Output Values—Optional
When creating a component, automation engineers working in QuickTest 
can add standard checkpoints. A checkpoint compares the current value of a 
specified property with the expected value for that property, and can help 
identify whether your application is functioning correctly. 

The checkpoint is visible and editable in the Checkpoint Properties dialog 
box in ALM, enabling you to view which properties are set to be checked 
during the run. 

For more information, see "Adding Checkpoints and Output Values to Steps" 
on page 174.



Chapter 5 • Working with Automated Component Steps

136

Working with Application Areas

An application area provides all of the settings and resources required to 
create the content of keyword-driven business components for a particular 
application or part of an application. These include:

➤ Representations of the objects from your application, contained in the 
shared object repository.

Note: The automation engineer can change the behavior of these objects 
in the application using the RegisterUserFunc utility statement in 
QuickTest. For more information, see the QuickTest Professional Object 
Model Reference.

➤ User-defined operations, contained in function libraries.

All application area settings are automatically inherited by the business 
components that are based on that application area.

Depending on your specific requirements, you can create multiple 
application areas, each representing a different area or aspect in your 
application. It is important that you select the correct application area on 
which to base your business component. Each application area should have 
a detailed description to help you to make the correct choice. 
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When you create a business component and choose an associated 
application area, the settings and resources that are defined in the current 
application area are embedded in the component. Therefore, any changes 
that are made to the application area in QuickTest Professional at a later 
time are applied directly to the component.

Note: The shared object repository, function libraries and scenario files that 
comprise an application area are links to the actual repository and files 
stored in ALM. Changes to the stored repository and files affect all the 
components that reference them, and it is not necessary to update the 
application area for such changes.

A keyword-driven component must be associated with an application area 
to create steps for it, but you can also change the application area that is 
associated with a specific business component when required.

The following topics are described in this section: 

➤ "Creating the Application Area" on page 137

➤ "Choosing the Application Area" on page 139

Creating the Application Area

When you create a new application area, you define all of the application 
area settings and resources needed to create a new business component.

The following users can create application areas: 

➤ The automation engineer, in QuickTest Professional. For more 
information on working with and creating application areas in QuickTest, 
see the HP QuickTest Professional for Business Process Testing User Guide.
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➤ Either the subject matter expert or the automation engineer in the Test 
Resources module in ALM. The application area entity that is created in 
ALM provides the structure for automation, using default resources.

Note: You can start to create an automated component, even if its 
application area has not yet been created or fully-defined by the automation 
engineer. Create the automated component by adding comments describing 
the steps you need to create when the application area is available. However, 
if the application area has not yet been created, you cannot add keyword-
driven steps to your component.

To create a new application area from within ALM:

 1 If not yet connected, connect to the ALM project (for which you want to 
create the application area) from QuickTest Professional.

For more information, see “Connecting to Your ALM Project” in the 
HP QuickTest Professional for Business Process Testing User Guide.

 2 Create the application area resource in ALM’s Test Resources module. You 
can also create other resources with which the application area is 
associated, such as libraries, object repositories, and recovery scenarios in 
ALM (and associate them to the application area in 
QuickTest Professional). For details, see the HP Application Lifecycle 
Management User Guide: 

 3 In QuickTest Professional, define the settings, and resource files that you 
want business components associated with the application area to use. By 
associating a component with an application area, the component is 
automatically linked to these settings and resource files.

 4 In QuickTest Professional, define dependencies between entities. For more 
information, refer to the HP QuickTest Professional for Business Process 
Testing User Guide. 

You can view the associations between the application area and the other 
resources in the Dependencies tab in the Test Resources module in ALM.
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Choosing the Application Area
After an application area is created, the next stage in adding content to an 
automated, keyword-driven business component is to choose the associated 
application area. 

A business component that does not have an associated application area 
displays the following message at the top of the Automation sub-tab:

“To create steps, you must first select an application area by clicking the Select 
Application Area button.”

To select or change the application area:

 1 In the Automation sub-tab of the Component Steps tab, click the Select 
Application Area button in the toolbar. The Select Application Area dialog 
box opens.

Note: You may be prompted to connect to the project from within 
QuickTest Professional the first time you try to select an application area. 
For instructions, see the HP QuickTest Professional User Guide.

 2 Select the required application area.
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 3 Click OK to associate the business component with the selected 
application area.

All of the application objects in the associated object repository, and any 
operations defined in associated function libraries, are now available for 
you to choose when automating your component steps.

Note: Changing an application area may affect the business component and 
prevent it from running correctly. For example, if a component step uses an 
object that is not contained in the object repository of the new application 
area, the step fails. 

Generating a Script to Automate Components

When your application is ready to be tested, and all of the required 
automation resources have been prepared, you can create the automated 
keyword-driven or scripted business component steps required to test your 
application. 

The conversion process from manual to automated components is 
irreversible. However, you can still use the steps in the Manual Steps sub-tab 
of the Component Steps tab to run the component manually, as described 
in "Running a Business Process Test or Flow Manually" on page 380. 

After generating a script to automate components, the manual steps in the 
Manual Steps tab are read-only. You can update the steps: 

➤ For keyword-driven components: Only by modifying the automated 
component in the Automation sub-tab of the Component Steps tab. 

➤ For scripted components: Directly in a testing tool.
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How to Start Automating Manual Component Steps by 
Generating a Script
This section describes how to automate manual components.

To automate manual components:

 1 Select the manual component in the component tree and click the 
Component Steps tab.

Tip: Manual components in the component tree are indicated by an M 
symbol on the component icon, for example, .

 2 In the toolbar, click the Generate Script button. The available automated 
component types are displayed in a list.

Note: An item in the automated component list is displayed only if the 
appropriate testing tool add-in is installed. 

 3 Select the applicable component type from the list to automate your 
manual component. The Automation sub-tab is displayed, and the format 
of the Automation sub-tab changes to one of the following views, 
according to your selection.

➤ Selecting QuickTestKeyword-Driven converts the component to an 
automated QuickTest business component. The Automation sub-tab 
displays the existing manual component steps as Manual Step 
operations in a keyword view format. For more information, see 
"Automating Using the Keyword-driven Automation Type" on 
page 143.
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➤ Selecting QuickTestScripted converts the component to an automated 
QuickTest scripted component. The Automation sub-tab provides a 
Launch button that enables you to view or edit the steps in QuickTest. 
For more information, see "Viewing Scripted Components" on 
page 142.

Automating Using the Scripted Automation Type

Scripted components are maintainable, reusable modules that perform a 
specific task when testing your application. 

Scripted component steps can contain programming logic and can be edited 
only in the testing tools in which they were created, such as 
QuickTest Professional. They cannot be modified by the subject matter 
expert in ALM, but you can include these scripted components in business 
process tests.

Viewing Scripted Components 
After selecting a business component that was automated as a scripted 
component in the component tree, you can click the Launch button in the 
Automation sub-tab to open the applicable testing tool and edit the scripted 
component. 

Note: The manual steps of a scripted component that was created in ALM 
can be modified in the Manual Steps sub-tab and used in manual tests if 
required.

When you convert a manual component to a scripted component in 
QuickTest (using the Generate Script. button in the Component Steps tab), 
your manual steps are converted to ManualStep operations in the script in 
QuickTest. The step name, description, and expected results are displayed in 
the QuickTest Keyword and Expert views. 
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Automating Using the Keyword-driven Automation Type

Keyword-driven business components are maintainable, reusable modules 
that perform a specific task when testing your application. 

The automated steps of keyword-driven components can be created and 
edited in ALM. 

The following topics are described in this section: 

➤ "The Keyword View" on page 143

➤ "Keyword View Example" on page 144

➤ "Setting Keyword View Options" on page 144

The Keyword View
You create each item in the business component, comprising a step or a 
comment, as a row in the keyword view format of the Automation sub-tab 
of the Component Steps tab. 

A step is an operation to be performed in a business component. After you 
create a step, you specify its contents. For example, you can select the object 
on which the step is performed, specify the operation to be performed in the 
step, and specify any relevant input or output parameters. When a business 
process test runs in ALM, the steps defined in the associated business 
components are performed automatically on the application being tested.

In keyword view, columns divide the items into individual cells. You can 
choose which columns to display, and you can modify the contents of the 
cells, if required. Steps are automatically documented in the Documentation 
column of the Automation sub-tab, providing a plain-language textual 
description of what the step does in the component. For information on 
selecting which columns to display in the Automation sub-tab, see "Setting 
Keyword View Options" on page 144.

Creating business component steps in the Automation sub-tab requires little 
or no programming or scripting knowledge. The programming required to 
perform each step of the component is done behind-the-scenes in Business 
Process Testing.

Each component step you create comprises a row in the Automation tab. 
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Keyword View Example
The Automation sub-tab could contain rows that show the steps that are 
performed on the Mercury Flight Reservations sample application. For 
example:

➤ The Login dialog box is opened.

➤ mercury is entered in the Agent Name edit box.

➤ mercury is entered in the Password edit box.

➤ The OK button is clicked.

The Documentation column automatically translates each of the steps into 
understandable sentences. 

Setting Keyword View Options
You can select which columns to display in the Automation sub-tab, specify 
their order, and set the number of columns that remain stationary when 
you scroll horizontally. You can also set the font and color of many elements 
in the Automation sub-tab.

The following tasks are described in this section: 

➤ "To select columns to display or hide in the Keyword View Options dialog 
box:" on page 145

➤ "To display or hide specific columns using the context menu:" on 
page 146
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➤ "To rearrange columns in the Automation sub-tab:" on page 147

➤ "To set font and color options for the Automation sub-tab:" on page 147

To select columns to display or hide in the Keyword View Options dialog 
box:

 1 In the Automation sub-tab, click the View Options button in the toolbar. 
The Keyword View Options dialog box opens.

In the Columns tab, the Available columns box lists columns not 
currently displayed in the Automation sub-tab. The Visible columns box 
lists columns currently displayed in the Automation sub-tab.

 2 Double-click column names, or select column names and click the arrow 
buttons (> and <), to move them between the Available columns and 
Visible columns boxes.
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 3 In the Visible columns box, set the order in which columns appear in the 
Automation sub-tab by selecting one or more columns and then using the 
Up and Down arrow buttons.

Note: The order of the columns in the Automation sub-tab does not affect 
the order in which the cells need to be completed for each step. For 
example, if you choose to display the Operation column to the left of the 
Item column, you select the item first, and the Operation column list is 
then refreshed to match the selection you made in the Item column.

 4 Click OK to close the dialog box and apply the new column display.

To display or hide specific columns using the context menu:

➤ Display a hidden column by right-clicking the column header row and 
then selecting the required column name from the displayed menu.

➤ Hide a displayed column by right-clicking the column header row and 
then selecting the column name from the displayed menu. 

Tip: You may want to display only the Documentation column, for 
example, if you want to use the steps as instructions for manual testing. 
You can do this by selecting Documentation Only. The Documentation 
column and any comments defined in the business component are 
displayed.



Chapter 5 • Working with Automated Component Steps

147

To rearrange columns in the Automation sub-tab:

Drag a column header and drop it at a new location. Red arrows are 
displayed when the column header is dragged to an available location.

To set font and color options for the Automation sub-tab:

 1 In the Automation sub-tab, click the View Options button in the toolbar. 
The Keyword View Options dialog box opens. 

 2 Click the Fonts and Colors tab.
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 3 Set the display options according to your preferences.

➤ Element. Select the rows for which your font and color selections 
apply. 

➤ Default. Applies your selections to all rows.

➤ Selected Row. Applies your selection of text and background color 
to the currently selected row only.

➤ Alternate Rows. Applies your selection of a background color to 
alternate rows.

➤ Comment. Applies your selections to comment rows.

➤ Font name. Select the font in which the text displays.

➤ Size. Select the font size in which the text displays.

➤ Style. Select the font style; Regular, Bold, Italic, or Underline.

➤ Foreground. Select the color in which the text displays.

➤ Background. Select the background color of the rows.

➤ Foreground for read-only. Select the color in which read-only text 
displays.

Tip: Click Reset all to change all your selections back to the default.

 4 Click OK to save your settings.
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Creating Steps in the Keyword View

You create the sequential steps that comprise your automated business 
component content by selecting specific objects from the object repository 
(created in QuickTest Professional by the automation engineer). You then 
select the operation to be performed on each object, and define any required 
values. 

It is important to note that when the business component runs, the context 
of each step in the component must be set by an earlier step or steps. This 
means that for an operation on an object to be performed successfully, the 
object must be currently displayed.

For example, consider a business component that opens an existing order in 
a flights reservation application. Before the Customer Name check box can 
be clicked in a component step, both of the following steps must first be 
performed:

➤ The application must be opened

➤ The Open Order dialog box must be opened
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Creating a New Step

After you have selected an associated application area for your component, 
you can create new automated steps in the Automation sub-tab.

To create a new step in a business component:

 1 In the Automation sub-tab, select the row after which you want to add 
the new step and click the Add Step button in the toolbar, or right-click 
and select Insert New Step. The Select an Item list opens.

 2 Define the step by clicking in the cell for the part of the step you want to 
add content, as described below. Each cell in the step row represents a 
different part of the step.

For each step, you can define the following:

➤ Item. Either an object on which you perform a step, or a user-defined 
function (Operation). You must select an option from the Item column 
before you can add additional content to a step. For more information, 
see "Selecting an Item for a Step" on page 152.

Alternatively, you can choose to add a Comment, which enables you 
to add a manual step or other text information between steps. For 
more information, see "Entering Comments in the Keyword View" on 
page 162. 
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➤ Operation. The operation to be performed on the item. For more 
information, see "Selecting an Operation for a Step" on page 157.

➤ Value (if relevant). The argument values for the selected operation. For 
more information, see "Defining Values for Operations" on page 158.

➤ Output (if relevant). The parameter in which output values for the step 
are stored. For more information, see "Defining Output Values for 
Steps" on page 159.

 3 Save the steps as described in "Saving Component Steps" on page 151.

Note: The Documentation cell is read-only. This cell displays an explanation 
of what the step does in a plain-language textual description, for example, 
Click the “Sign-in” image, or Select “San Francisco” in the “toPort” list. The 
documentation sentence is displayed only after you have entered the item, 
operation, and any required values for the selected operation.

You can use these Documentation descriptions to run your automated 
components manually. For more information, see "Running a Test or Flow 
Manually" on page 381.

Saving Component Steps

You must save your component steps and any other changes that you make 
in the Automation sub-tab. Since changes you make in the Automation sub-
tab are not saved automatically, it is recommended that you save them 
periodically. 

To save component steps:

Click the Save button in the Automation sub-tab toolbar.

or

Select another tab in the component, another location in the component 
tree, or another module.
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Selecting an Item for a Step

An item can be an object in the shared object repository, a comment, or it 
can indicate a function from a function library. (The Operation item is 
available only if functions were added by the automation engineer to a 
function library that is associated with the application area on which your 
business component is based.)

After you select an item, you specify an operation for it. For more 
information, see "Selecting an Operation for a Step" on page 157.

This section describes:

➤ "Selecting an Object from the Item List" on page 153

➤ "Selecting an Object from the Shared Object Repository" on page 154

➤ "Selecting an Operation Item from the Item List" on page 156

In addition to selecting an item or operation in the Item cell, you can also 
select to include a Comment. You use the Comment option to add notes 
about your component or to provide information about adjacent steps. For 
more information on comments, see "Entering Comments in the Keyword 
View" on page 162. 
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Selecting an Object from the Item List

The objects available in the Select an Item list are the sibling and child 
objects of the previous step’s object. These objects, for example, the Login 
dialog box, or User Name text box, are contained in the shared object 
repository that is associated with the application area on which your 
business component is based.

If you want to select an item other than a sibling or child object of the 
previous step’s object, you can select the Select another object item. The 
example below shows the objects available for the step following a 
userName edit box object. 

Notes:

➤ If no application area is associated with the component, and/or no 
objects are available, only the Operation and Comment items are 
included in the Select an Item list. Some operation functions, such as 
OpenApp, are available without an associated application area.

➤ If an object included in a step is later removed from the shared object 
repository by the automation engineer, the component run fails. Objects 
that are missing from the shared object repository are indicated in the 
Automation sub-tab by the  icon. 
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To select an object from the displayed Item list:

 1 In the Automation sub-tab, click in the Item cell, and then click the arrow 
button to display the Select an Item list. If you have just created a new 
step, the list opens automatically as soon as you create the new step.

 2 In the Select an Item list, select the object on which you want to perform 
the step. The item you select is displayed in the Item cell. 

You now need to specify an operation for the step. For more information, 
see "Selecting an Operation for a Step" on page 157.

Selecting an Object from the Shared Object Repository

The shared object repository includes all of the objects that were defined for 
the application area on which your business component is based. If the 
object for which you want to add a step is not displayed in the item list, you 
can select any object from the object repository using the Select Test Object 
dialog box.

For more information on the shared object repository, see the HP QuickTest 
Professional for Business Process Testing User Guide.

To select an object from the shared object repository:

 1 Click in the Item cell, then click the arrow button to display the Select an 
Item list. If you have just created a new step, the list opens automatically 
as soon as you create the new step. 

 2 In the Select an Item list, select Select another object. 



Chapter 5 • Working with Automated Component Steps

155

The Select Test Object dialog box opens.

Tip: You can search for the object you require by entering the object name 
(or the beginning letters of the name) in the Name box and clicking the 
Find Next button. You can also limit the number of objects displayed in 
the list by selecting the type of object you require from the Type list, for 
example, Check Box, or Button.

 3 Select an object from the shared object repository tree and click OK. The 
selected object is displayed in the Item cell and is also added to the Select 
an Item list.

You now need to specify an operation for the step. For more information, 
see "Selecting an Operation for a Step" on page 157.
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Selecting an Operation Item from the Item List

Operations, or keywords, are customized functions that may group together 
multiple steps, as well as programming logic that can perform a specific task 
in your application. For example, you can use an operation to open an 
application at the start of a business component, or check the value of a 
specific property of an object in your application.

Business Process Testing provides a set of basic keywords for you to use. The 
automation engineer can add to or enhance the keywords in 
QuickTest Professional. These keywords are derived from built-in methods 
and properties, as well as user-defined functions associated with the 
application area. The automation engineer manages the keywords and 
selects which of them should be available in the Item list when creating 
automated components. 

Note: If an operation included in a step is later removed from the 
application area by the automation engineer, the component run fails. 
Operations that are missing from the application area are indicated in the 
Automation sub-tab by the  icon. 

For more information on managing keywords, see the HP QuickTest 
Professional for Business Process Testing User Guide.

To select an Operation item:

 1 Click in the Item cell and then click the arrow button to display the Select 
an Item list. If you have just entered a new step, the list opens 
automatically as soon as you create the new step.

 2 In the Select an Item list, select Operation. The Operation item is 
displayed in the Item cell. 

You now need to specify an operation for the step. For more information, 
see "Selecting an Operation for a Step", below.
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Selecting an Operation for a Step

In the Operation cell, you specify the operation to be performed on the item 
selected in the Item column. The available operations vary according to the 
item selected. The default operation (most commonly-used operation) for 
the item is automatically displayed in the Operation column. 

If you select an application object in the Select an Item list, the Operation 
list for that object includes built-in operations and any operations that were 
created for that specific object type in the application area’s function 
libraries. For example, if you selected a button object, the list contains the 
most commonly used methods available for the button object, such as Click.

If you select Operation in the Item column, the list contains the operations 
defined in the function library or libraries associated with the component’s 
application area. For information on function libraries, see the HP QuickTest 
Professional for Business Process Testing User Guide.

To select an operation for a step:

In the Automation sub-tab, click in the Operation cell, then click the arrow 
button and select the operation to be performed on the item. The operation 
can be either a built-in operation or an operation from a function library, 
depending on the item you selected.

Tip: When you position the cursor over an operation in the list, a tooltip 
describes the operation.
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Defining Values for Operations

The Value cell lists the values for the operation arguments. An operation 
argument provides the specific information that an operation uses to 
accomplish a specific purpose. For example, the argument of an edit box Set 
operation indicates the specific value to enter in the edit box. The argument 
numbers for a Click operation can optionally indicate the specific 
coordinates of the click. A particular operation may have required 
arguments, optional arguments, or no arguments at all.

The Value cell is partitioned according to the number of possible arguments 
of the selected operation. Each partition contains different options, 
depending on the type of argument that can be entered in the partition, as 
follows:

Argument 
Partition

Argument 
Type

Instructions

String Enables you to enter any alphanumeric string 
enclosed by quotes. If you do not enter the 
quotes, Business Process Testing adds them 
automatically. If you modify a cell that 
contains a string enclosed by quotes by 
removing the quotes, Business Process Testing 
does not restore the quotes, and the value is 
treated as a variable name.

Integer Enables you to enter any number, or use the up 
and down arrows to select a number.

Boolean Enables you to select a True or False value from 
the list.

Predefined 
constant

Enables you to select a value from the list.
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To define or modify a value:

Click in each partition of the Value cell and enter the argument values for 
the selected operation, or click the parameterization button  to parameterize 
the value. When you click in the Value cell, a tooltip displays information 
for each argument. In the tooltip, the argument for the partition that is 
currently highlighted is displayed in bold, and any optional arguments are 
enclosed in square brackets.

You can parameterize the value for an argument using a local or component 
parameter. For more information, see "Parameterizing in the Keyword View" 
on page 164.

Defining Output Values for Steps

For component steps that return an output value, you define the settings in 
the Output cell. This determines where the output value is stored and how it 
is used during the component run session. When the output value step is 
reached, each value set for output is retrieved and stored in the specified 
location for use later in the run session. 

You can modify the output parameter, as required. If you select a local 
parameter, you can modify its name and description directly in the Output 
Options dialog box. If you select a component parameter, its name and 
description are read-only. You can modify the parameter details in the 
Parameters tab of the Business Components module. For more information 
on local and component parameters, see "Parameterizing in the Keyword 
View" on page 164.

If, after you specify an output value, you choose not to save the output 
value, you can cancel it. For more information, see "Canceling Output for a 
Parameter" on page 161.
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To configure output for a parameter:

 1 Click in the Output cell of a component step that returns an output value. 
Click the Specify parameter for output button. The Output Options 
dialog box opens. 

Note: The default output type is Component parameter if at least one 
output parameter is defined in the business component Parameter tab. If 
you select Local parameter, the dialog box changes to the Output Options 
dialog box for a local parameter. 
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 2 In the Output Types box, select either Component parameter or Local 
parameter. 

➤ If you select Component parameter, the Parameter box displays the 
available component parameters. The information displayed is read-
only. 

➤ If you select Local parameter, the dialog box changes to the Output 
Options dialog box for a local parameter. The Details area displays the 
name and description of the available local parameters. You can select 
a local parameter and specify the details for it, or create a new local 
parameter if needed.

For more information, see "Parameterizing Output Values" on page 169.

Tip: If you click in the Output cell after you specify an output parameter 
for an item, the  icon is displayed in the cell for a local parameter, and 
the  icon is displayed in the cell for a component parameter. 

Canceling Output for a Parameter

If you do not want to store the output value for a business component step, 
you can cancel it. 

To cancel output for a parameter:

Click in the Output cell. Then click the Cancel button to cancel output for 
the parameter.
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Entering Comments in the Keyword View

A comment is a free text entry that you can enter on a new line below the 
currently selected step in a business component. Comments span an entire 
row in the Automation sub-tab.

The  icon indicates a comment in the Automation sub-tab. You can use 
comments for several purposes. For example, you may want to use 
comments to plan steps to be included in a business component before your 
application is ready to be tested. 

Then, when the application is ready, you can use your plan (comments) to 
verify that every item that needs to be tested is included in the component 
steps.

You may want to add comments to a business component to improve 
readability and make it easier to update. For example, you may want to add 
a comment before each section of a component to specify what that section 
includes.

After you add a comment, it is always visible in your component, as long as 
one or more columns are displayed. In addition, as you scroll from side to 
side across the tab, the comment can always be seen. Comments are not 
processed when business components run.

Note: After you insert a comment, you cannot change it to a step. 
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To add a comment to your business component:

 1 Select a row after which you want to add a comment, click in the Item cell 
and select Comment from the list, or right-click a component step and 
select Insert Comment. 

Note: You can also click the Add Step button in the toolbar and select 
Comment from the list.

A comment row is added below the selected step.

 2 Enter text in the comment row.

To modify an existing comment:

Double-click the comment. The text box becomes a free-text field. 
Alternatively, you can click the  icon.

To delete a comment:

Select the comment and click the Delete Step button in the toolbar. The 
comment is permanently removed from the business component. 
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Parameterizing in the Keyword View

You can define input parameters that pass values into your business 
component, and output parameters that pass values from your component 
to external sources or from one step to another step. You can also define 
local parameters for use within the component only. You can then use these 
parameters to parameterize input and output values in steps. 

You can define two types of parameters—local parameters and component 
parameters.

Local parameter. A local parameter is defined for a specific business 
component. It is not accessible by other business components. You define 
local parameters in the Automation sub-tab using the Value Configuration 
Options dialog box for input parameters and the Output Options dialog box 
for output parameters. You cannot delete local parameters, but you can 
cancel their input or output.

Component parameter. A component parameter whose value is set can be 
returned to or retrieved from a location outside the component. The values 
of these parameters can be passed from one component in a business 
process test or flow to a later one during a test run. You define component 
parameters in the Parameters tab of the Business Components module. 

This section describes how to configure local parameters and parameterize 
input and output values using local and component parameters. For more 
information on parameters, see Chapter 9, "Working with Parameters." 

After you define a parameter you can use it to parameterize a value. You can 
also change the parameterized value back to a constant value by entering it 
directly in the Value cell.
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Parameterizing Input Values
In the Value cell, you can parameterize input values for a step using local or 
component parameters.

To parameterize an input value using a local parameter:

 1 In the Value cell, click the Configure the value button. The Value 
Configuration Options dialog box opens.

If at least one input component parameter is defined in the component, 
the default input type is Component parameter.

 2 Select the Parameter radio button and then select Local Parameter from 
the list. 
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The details for the local parameter type are displayed. 

 3 Specify the property details for the local parameter:

➤ Name. Enter a meaningful name for a new parameter or select an 
existing parameter name from the list.

➤ Value. Enter an input value for the parameter. 

➤ Description. Enter a brief description for the parameter. 
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 4 Click OK. The local parameter is displayed in the Value cell of your step. 
When the business component runs, it uses the value specified in the 
parameter for the step.

Tips:

➤ You can cancel the parameterization of a value by selecting the 
Constant radio button in the Value Configuration Options dialog box 
and entering a constant value.

➤ If you click a partition in the Value cell of a step after you define a local 
parameter for it, the  icon is displayed in that partition of the cell.

To parameterize an input value using a component parameter:

 1 In the Value cell, click the Configure the value button. The Value 
Configuration Options dialog box opens.
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If at least one input component parameter is defined in the business 
component, the default input type is Component parameter and the 
default input name is the first input parameter from the Parameters tab of 
the Business Components module.

Note: If no component parameter is defined, you must define one before 
you can use it to parameterize an input value. For more information, see 
Chapter 9, "Working with Parameters."

 2 Select the Parameter radio button and then select Component Parameter 
from the list. Click the list arrow to view the available component 
parameters and their descriptions. Select the component parameter you 
want to use for the parameterized value.

 3 Click OK. The component parameter is displayed in the Value cell of your 
step. When the business component runs, it uses the value specified in 
the parameter for the step.

Tips:

➤ You can cancel the parameterization of a value by selecting the 
Constant radio button in the Value Configuration Options dialog box 
and entering a constant value.

➤ If you click a partition of the Value cell after you define a component 
parameter for it, the  icon is displayed in that partition of the cell.
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Parameterizing Output Values
You can parameterize output values for a step using local or component 
parameters in the Output cell of a step. You can then use the output 
parameter value as an input value in a later step in the component, or in a 
later component or flow in the test.

To parameterize an output value using a local parameter:

 1 In the Output cell, click the Specify parameter for output button. The 
Output Options dialog box opens.

If at least one output component parameter is defined in the business 
component, the default output type is Component parameter and the 
default output name is the first output parameter from the Parameters tab 
of the Business Components module.
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 2 In the Output Types box, select Local parameter. The details for the local 
parameter type are displayed. 

 3 Specify the property details for the local parameter:

➤ Name. Enter a meaningful name for a new parameter or choose an 
existing parameter name from the list.

➤ Description. Enter a brief description for the parameter. 

 4 Click OK. The local parameter is displayed in the Output cell of your step. 
When the business component runs, it outputs the value to the output 
parameter specified for the step.

Tip: If you click the Output cell after you define a local parameter for it, 
the  icon is displayed in that partition of the cell.
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To parameterize an output value using a component parameter:

 1 In the Output cell, click the Specify parameter for output button. The 
Output Options dialog box opens.

If at least one output component parameter is defined in the business 
component, the default output type is Component parameter and the 
default output name is the first output parameter from the Parameters tab 
of the Business Components module. 

Note: If no component parameter is defined, you must define one before 
you can use it to parameterize an output value. For more information, see 
Chapter 9, "Working with Parameters."

 2 In the Parameter box, click the list arrow to view the available 
component parameters and their descriptions. The details for the 
component parameter are displayed in read-only format. Select the 
component parameter you want to use to store the output value.



Chapter 5 • Working with Automated Component Steps

172

 3 Click OK. The component parameter is displayed in the Output cell of 
your step. When the business component runs, it outputs the value to the 
output parameter specified for the step.

Tip: If you click a partition of the Output cell after you define a 
component parameter for it, the  icon is displayed in that partition of 
the cell.

Modifying Component Steps in the Keyword View

You can modify any part of a step in the Automation sub-tab. For example, 
you can change the object on which the step is performed or change the 
operation to be performed in the step.

Note: Business components that are currently open in another session of 
ALM or in QuickTest are locked and open in read-only mode.

When working in the Automation sub-tab, you can use the standard editing 
commands (Cut, Copy, Paste and Delete) in the context-sensitive menu to 
make it easier to modify your steps, operations, or comments. You can also 
drag and drop these items to move them to a different location within a 
business component.

For more information, see:

➤ Moving a Component Step

➤ Deleting a Component Step
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Moving a Component Step
You can move a step (or other item) to a different location within a business 
component.

To move a step in the component, perform one of the following:

➤ In the Item column, drag the step up or down and drop it at the required 
location. The step is positioned below the item over which it is dropped.

➤ Right-click the step and select Cut to cut it to the Clipboard. Right-click 
an item and then select Paste to paste the step from the Clipboard. The 
step is positioned below the selected item. 

➤ To duplicate a step, right-click it and select Copy. Then right-click an item 
and select Paste. The step is positioned below the selected item.

Deleting a Component Step
You can delete a business component step (or other item), if required. Before 
you delete a step, make sure that removing it does not prevent the 
component from running correctly.

Note: You cannot delete a step if one of its cells is in edit mode.

To delete a step in the Automation sub-tab:

 1 Select the step that you want to delete.

 2 Click the Delete Step button in the toolbar. A warning message is 
displayed.

Note: A warning message is not displayed when a comment is deleted.

 3 Click Yes to delete the selected item. 
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Adding Checkpoints and Output Values to Steps

When creating steps in a component, automation engineers working in 
QuickTest can add checkpoint and output value steps. In ALM, you can view 
details of, and sometimes edit, these steps.

This section contains the following:

➤ "Checkpoints" on page 174

➤ "The Checkpoint Properties Dialog Box" on page 175

➤ "Output Value Steps" on page 178

➤ "The Output Value Properties Dialog Box" on page 179

Checkpoints
When creating a component, automation engineers working in QuickTest 
can add standard checkpoints. A checkpoint compares the current value of a 
specified property with the expected value for that property, and can help 
identify whether your application is functioning correctly. 

The checkpoint is visible and editable in the Checkpoint Properties dialog 
box in ALM, enabling you to view which properties are set to be checked 
during the run. The properties for the object are listed in the Properties pane 
of the dialog box. The pane includes the properties, their expected values, 
and their value types. For more information, see "The Checkpoint Properties 
Dialog Box" on page 175.

When a component containing one or more checkpoints runs, QuickTest 
compares the expected value of the checkpoint to the actual value. If the 
value does not match, the checkpoint fails. You can view the results of the 
checkpoint in the Run Results Viewer. For more information, see "Viewing 
Run Results of Business Process Tests or Flows" on page 410. 
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The Checkpoint Properties Dialog Box 

Below is an image of the Checkpoint Properties dialog box.

 

Description Enables you to accept or modify the property values 
of the checkpoint. 

To Access Select an automated component in the business 
components module, open the Automation sub-tab, 
and click the Checkpoint Properties button  in 
the Value column of a checkpoint step.

See Also ➤ "Checkpoints" on page 174

➤ "Editing the Expected Value of an Object 
Property" on page 177

➤ "Viewing Run Results of Business Process Tests or 
Flows" on page 410
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The dialog box displays the following information about the checkpoint:

Checkpoint Properties Dialog Box Options 

Additional References 

Information Description

Name The name assigned to the checkpoint.

Value Type The expected value type of the property. 

➤ The  icon indicates that the value of the property is currently 
a constant. 

➤ The  icon indicates that the value of the property is currently 
a parameter.

➤ The  icon indicates that the value of the property is currently 
a component parameter.

Option Description

Check box You can accept the selected checks or modify them 
accordingly.

➤ To check a property, select the corresponding 
check box.

➤ To exclude a property check, clear the 
corresponding check box.

Browse When you click the Browse button for a property 
in the Checkpoint Properties dialog box, the 
Parameterization / Properties dialog box opens, in 
which you can set the property value as a Constant 
or a Parameter. 

See "Editing the Expected Value of an Object 
Property" on page 177.

Related Concepts "Output Value Steps" on page 178
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Editing the Expected Value of an Object Property

When you click the Browse button for a property  in the Checkpoint 
Properties dialog box, the Parameterization / Properties dialog box opens. In 
this dialog box, you can set the expected property value as a Constant or a 
Parameter.

➤ Constant. A value that is defined directly in the step and remains 
unchanged when the component runs. 

If you select Constant, you can edit the value directly in the Constant 
box.

➤ Parameter. A value that is defined or generated separately from the step 
and is retrieved when the specific step runs. 

If you select Parameter for a value that is already parameterized, the 
Parameter box displays the current parameter definition for the value. If 
you select Parameter for a value that is not yet parameterized, you can 
click the Parameter Options button to open the Parameter Options dialog 
box.

Specify the property details for the parameter. For more information on 
using parameters in your components, see "Working with Parameters" on 
page 263.
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Output Value Steps
When creating steps in a component, automation engineers working in 
QuickTest can add output value steps. An output value step is a step in 
which one or more values are captured at a specific point in your 
component and stored for the duration of the run session. The values can 
later be used as input at a different point in the run session. However, 
output values are stored only for the duration of the run session. When the 
run session is repeated, the output values are recaptured. 

You can use standard output value steps to output property values of most 
objects. For example, you can use an output value step to output text strings 
by specifying to output the text property of an object.

The output value steps determine where the values are stored during the run 
session and how they can be used. When you run a component containing 
one or more output value steps, QuickTest retrieves each value at the 
specified point and stores it in the specified location. When the value is 
needed later in the run session, QuickTest retrieves it from this location and 
uses it as required. 

After the run session, you can view the values retrieved during the session as 
part of the session results. For more information, see "Viewing Run Results 
of Business Process Tests or Flows" on page 410. 

The output value step is visible and editable in ALM in the Output Value 
Properties dialog box. The properties are listed in the Properties pane of the 
dialog box. The pane includes the properties, the property values that are 
currently stored with the object in the object repository, and their value 
types. The Output Value Properties dialog box enables you to choose which 
property values to output and to define the settings for each value that you 
select. 

You can select a number of properties to output for the same object and 
define the output settings for each property value. When the output value 
step is reached during the run session, QuickTest retrieves all of the specified 
property values. 
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The Output Value Properties Dialog Box 

Below is an image of the Output Value Properties dialog box.

 

Description Enables you to choose which property values to 
output and to define the settings for each value that 
you select.

To Access Select a component in the business components 
module, open the Automation sub-tab, and click 
the Output Value Properties button  in the 
Value column for an output value operation.

See Also Conceptual overview: "Output Value Steps" on 
page 178

Related tasks:

➤ "Defining Output Values for Steps" on page 159

➤ "Parameterizing Output Values" on page 169

➤ "Specifying the Output Settings for a Property 
Value" on page 180

Additional related topic: "Additional References" on 
page 180
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The dialog box displays the following information about the checkpoint:

Output Value Properties Dialog Box Options 

Additional References 

Specifying the Output Settings for a Property Value

When you click the Browse button for a selected property  in the Output 
Value Properties dialog box, the Parameterization / Properties dialog box 
opens. 

Item Description

Name The name assigned to the output value. 

Value Type The expected value type of the property. 

The  icon indicates that the value of the property is 
currently a constant.

The  icon indicates that the value of the property is 
currently a parameter.

The  icon indicates that the value of the property is 
currently a component parameter.

Option Description

Check box To specify a property to output, select the 
corresponding check box. You can select more than 
one property for the object and specify the output 
options for each property value you select.

Browse When you click the Browse button for a property 
in the Output Value Properties dialog box, the 
Parameterization / Properties dialog box opens, in 
which you can modify the property value. 

See "Specifying the Output Settings for a Property 
Value" on page 180

Related Tasks "Viewing Run Results of Business Process Tests or 
Flows" on page 410

Related Concepts "Checkpoints" on page 174
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The dialog box displays the output definition for the selected property 
value.

When you select a property value to output, you can:

➤ Change the output type and/or settings for the selected value by clicking 
the Modify button. The Output Options dialog box opens and displays 
the current output type and settings for the value. For more information, 
see "Defining Output Values for Steps" on page 159.

➤ Accept the displayed output definition by clicking OK.
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6
Getting Started with Business Process 
Tests

You use the Test Plan module to build and configure business process tests 
and flows by combining business components into an effective testing 
structure.

This chapter introduces the elements of the Test Plan module that are 
available for business process tests and flows. Chapter 7, "Managing Business 
Process Tests" describes how to work with the features and other options 
available in the Test Plan module.

This chapter includes:

➤ About Getting Started with Business Process Testing in the Test Plan 
Module on page 184

➤ The Test Plan Module Window for Business Process Testing on page 186

➤ Test Plan Module Tabs for Business Process Testing on page 190

➤ Test Plan Module Components and Flows Pane on page 210
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About Getting Started with Business Process Testing
in the Test Plan Module

You create and manage business process tests and flows in the Test Plan 
module. 

➤ Business process tests are testing scenarios comprised of business 
components and flows. 

➤ Flows are a type of test that comprise a sequence of business components. 

For information on creating components in the Business Components 
module, see Chapter 3, "Working with Business Components." For 
information on creating flows in the Test Plan module, see Chapter 8, 
"Working with Flows."

Business process tests and flows are used to challenge the application 
implementation by testing the processes on which the whole application is 
based.

Note: The Test Plan module can be used to design manual tests, automated 
business process tests and flows, and automated tests using other products, 
such as HP QuickTest Professional. The information and procedures 
described in this chapter are relevant only to Business Process Testing, and 
are viewed using the Test Plan Tree view of the Test Plan module.

All the standard functionality in the Test Plan module applies to Business 
Process Testing as well. For more information on using the Test Plan 
module, see the HP Application Lifecycle Management User Guide.
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To access a business process test or a flow in the Test Plan module:

 1 If not already logged in, log in to your HP Application Lifecycle 
Management (ALM) project as described in the HP Application Lifecycle 
Management User Guide. The ALM main window opens.

Note: After login, ALM displays the module in which you last worked. 

 2 In the ALM sidebar, under Testing, select Test Plan. 

 3 If the Test Plan module opens to the Test Grid, select View > Test Plan 
Tree to work with business process tests or flows as described in this 
chapter.

 4 Select a business process test or a flow in the Test Plan tree. 

Note: 

Data in the Test Plan module is read-only under the following 
circumstances:

➤ The data in the Test Plan module tabs when a business process test or 
flow is selected are read-only if no Business Process Testing license is 
available. 

➤ Business process tests that are currently open in another session of 
ALM are locked and can be opened only in read-only mode. 
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The Test Plan Module Window for 
Business Process Testing

This section introduces the Test Plan module window for Business Process 
Testing. The Test Plan module for Business Process Testing differs from the 
Test Plan module for other ALM test types. 

The Test Plan module window is shown below, with a business process test 
selected and the Test Script tab chosen. Different tabs appear when a folder, 
a flow, or other test types are selected.

 

Depending on whether a business process test, flow, or folder is selected in 
the Test Plan tree, the interface may contain the following key elements:

➤ "Test Plan Module Menu Bar" on page 187

➤ "Test Plan Module Toolbar" on page 187

➤ "Test Plan Tree" on page 188

➤ "Test Plan Module Tabs for Business Process Testing" on page 190

➤ "Test Plan Module Components and Flows Pane" on page 210
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➤ Filter information, which describes the filter currently applied to the grid 
or tree. Located directly above the grid filter boxes or tree. 

Test Plan Module Menu Bar
The Test Plan menu bar contains the Tests, Edit, View, Favorites, and 
Analysis menus, from which you can create and modify tests (including 
business process tests and flows), remove tests, change the displayed view, 
and generate reports. 

For more information on the Test Plan menu bar, see the HP Application 
Lifecycle Management User Guide.

Test Plan Module Toolbar
The Test Plan toolbar contains buttons for commands that are commonly 
used when creating and modifying the Test Plan tree, such as creating or 
deleting business process tests and flows, refreshing the data, and filtering 
the tree. For more information on these commands, see the HP Application 
Lifecycle Management User Guide.

Tip: You can navigate the Test Plan module, and perform many Test Plan 
module commands, using shortcut keys. For a list of shortcut keys, see "Test 
Plan Module Shortcuts for Business Process Testing" on page 417.

When working with Business Process Testing, the Test Plan toolbar also 
contains the following button:

Convert to Component. Opens the Select Destination Folder dialog box, 
which enables you to convert existing manual tests to manual components. 
For more information, see "Converting Manual Tests to Components" on 
page 235.
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Test Plan Tree
The Test Plan tree is a graphical representation of your test plan, displaying 
subject folders, business process tests, and flows according to the 
hierarchical relationship of their functions within the business process.

The entities that comprise the Test Plan tree are described under: 

➤ "Test Plan Tree Folders" on page 188

➤ "Statuses and Icons" on page 190

After you have built the basic structure of your plan in the Test Plan tree, 
you can create business process tests and flows and assign them to the 
appropriate subjects in the tree. You build the content of a flow by dragging 
business components from the component tree and dropping them in the 
flow or business process test. For more information, see Chapter 8, "Working 
with Flows," and Chapter 7, "Managing Business Process Tests." 

Test Plan Tree Folders

The Test Plan tree contains the following folders: 

➤ The top level in the Test Plan tree is the Subject root folder, which 
contains the Unattached folder and the test folders.



Chapter 6 • Getting Started with Business Process Tests

189

The Subject folder cannot be renamed or deleted. You can click the Set 
Filter/Sort button in the toolbar to sort the other folders in the tree 
according to your own requirements.

Selecting the subject folder displays Description, Attachments, and Live 
Analysis tabs that enable you to provide a descriptive overview of the 
folder’s contents, attach appropriate files, URLs or other information, and 
create a graphical representation of data related to test plans and test sets. 
For more information on these tabs, see the HP Application Lifecycle 
Management User Guide.

➤ The Unattached folder contains tests whose folders have been removed 
from the tree and which have not been assigned to any other folder.

The Unattached folders cannot be renamed or deleted. You can click the 
Set Filter/Sort button in the toolbar to sort the other folders in the tree 
according to your own requirements.

➤ Test folders contain your tests and flows. These folders can be renamed 
and deleted. You can click the Set Filter/Sort button in the toolbar to sort 
the other folders in the tree according to your own requirements.

Selecting a test folder in the Test Plan tree displays Description, 
Attachments, and Live Analysis tabs that enable you to provide a 
descriptive overview of the folder’s contents, attach appropriate files, 
URLs or other information, and create a graphical representation of data 
related to test plans and test sets. For more information on these tabs, see 
the HP Application Lifecycle Management User Guide.

➤ In previous versions of Quality Center: The BPT Resources folder was 
created in the Test Plan module. For business process tests or flows to 
perform properly in ALM, this folder and its subfolders should not be 
renamed or deleted.

In ALM, the BPT Resources folder no longer exists in the Test Plan 
module. This folder, which contains the business component resources in 
the project, is created automatically in the Test Resources module the first 
time you click the Automation sub-tab in a new project, when you create 
a QuickTest automated component for the first time, or when QuickTest 
connects to ALM for the first time.
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Statuses and Icons

Note the following status indicators and icons in the Test Plan tree:

➤ The status of business process tests and flows in the Test Plan tree are 
indicated by their icon colors. For more information, see "Understanding 
Business Process Test and Flow Statuses" on page 193.

➤ Tests and flows in the Test Plan tree to which an alert has been sent are 
indicated by a red exclamation mark  icon to the left of the test or flow 
name. Clicking the red exclamation mark opens the alert.

➤ In a version-controlled project, tests and flows checked out by the current 
user are displayed with an open green lock icon . Tests and flows 
checked out by another user are displayed with a red lock icon , together 
with the name of the user. No lock icon indicates that the test or flow is 
checked in.

Test Plan Module Tabs for Business Process Testing

Selecting a business process test or flow in the Test Plan tree displays tabs 
that provide an overview of the business process test or flow, and its status. 

The tabs are described in this section. 

➤ "Details Tab" on page 191

➤ "Test Script Tab" on page 196

➤ "Parameters Tab" on page 203

➤ "Test Configurations Tab" on page 205 (for business process tests only)

➤ "Attachments Tab" on page 206

➤ "Req Coverage Tab" on page 207

➤ "Linked Defects Tab" on page 207

➤ "Dependencies Tab" on page 208

➤ "Business Models Linkage Tab" on page 208

➤ "Criteria Tab" on page 209 (for business process tests only)

➤ "History Tab" on page 210



Chapter 6 • Getting Started with Business Process Tests

191

Details Tab
The Details tab enables you to enter details and a general description of the 
business process test or flow. 

Note:

➤ You can add user-defined fields and change the label of any of the fields 
in the Test Plan module. You can also customize project lists. For more 
details, refer to the HP Application Lifecycle Management Administrator 
Guide.

➤ You can use the Script Editor to restrict and dynamically change the 
fields and values in the Test Plan module. For more details, refer to the 
HP Application Lifecycle Management Administrator Guide.
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The following information is generally displayed in the Details tab:

Field/Tab Description

Test Name The current name of the business process test or 
flow. 

Tip: This field is read-only in the Details tab, but 
you can rename a business process or flow in the 
Test Plan Tree. Select the name in the tree, and 
then click it again to activate the name label for 
editing. Alternatively, right-click it in the tree 
and select Rename. Then edit the name and 
press ENTER.

Creation Date The date on which the business process test or 
flow was created.

Designer The user responsible for designing the business 
process test or flow. By default, the user who 
created the test or flow is displayed in this box. 
You can select another user from the list, if 
required. Clicking the e-mail button 

enables you to send an e-mail message 
about the test or flow to the specified designer.

Status The status of the business process test or flow. 
This box is read-only because the status of the 
test or flow is determined by the status of its 
business components. The component with the 
most severe status determines the test or flow 
status. 

For more information on component statuses, 
see "Component Tree" on page 46. For more 
information on test or flow statuses, see 
"Understanding Business Process Test and Flow 
Statuses" on page 193.

Test ID A unique numeric ID automatically assigned by 
ALM to the business process test or flow. This 
field is read-only.
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Note: The Details tab’s Description and Comments tabs provide a 
comprehensive selection of text editing and formatting commands. 

Understanding Business Process Test and Flow Statuses

Business process test and flow statuses are identified in the Test Plan module 
tree by specific icons, and in the Status box in the test or flow’s Details tab. 
The icons are colored and the symbols shown in the icons vary according to 
the status of the business process test or flow. For example, a green Ready 
icon indicates that all the business components in the test or flow are ready 
to be run, and a red Error icon indicates that at least one component has 
one or more errors that require attention. 

The status of a business process test or flow is set to Design when the test or 
flow is created, and changes to Maintenance when it has been modified. The 
status is subsequently determined by the business component in the test or 
flow with the most severe status. For example, suppose you have a business 
process test that contains: 

➤ 2 Ready components

➤ 1 Maintenance component 

Description tab A rich text edit area enabling you to enter an 
overall textual summary of the business process 
test or flow’s purpose, or any other relevant text.

Comments tab A rich text edit area enabling you to enter any 
additional information or remarks that you want 
to communicate to other users, such as future 
changes planned for the test or flow, or 
alternative tests or flows in which the 
components can be used. You can click the Add 
Comment button in the tab to automatically 
insert your user name and the current server date 
into the area as an introduction to your 
comments. 

Field/Tab Description
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➤ 1 Under Development component

➤ 1 Error component

➤ 1 Under Development (requested) component

In this example, the test status is Error, because Error is the most severe 
status of a business component in the test.

If one of the business components was deleted and moved to the Obsolete 
folder in the component tree, then the test or flow status would change to 
Outdated, because an Obsolete component is more severe than the Error 
status.

Business process test and flow statuses and their corresponding icons are 
described in the following table, from the least severe status to the most 
severe status:

Status Icon Color Description

Ready Green All the business components included in the 
business process test or flow have Ready status, 
indicating that they are fully implemented and 
ready to be run.

Maintenance Yellow The business process test or flow has been 
modified since it was created, or one or more 
business components included in the test or 
flow are being modified or are not yet 
complete, and have Under Development or 
Maintenance status (and no components in 
the test or flow have a more severe status). 

The Under Development component status is 
initially assigned to:

➤ New components created in the Business 
Components module.

➤ Component requests dragged into a 
component folder in the component tree.
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Note: Tests created in other testing tools can also be included in the Test 
Plan module tree, and are identified by other icons. 

User Defined Fields

If relevant test fields were defined in the Project Customization window in 
ALM, the Required Test Fields dialog box opens when a new test or flow is 
created. These fields are displayed in the Details tab.

For more information on user defined fields, see the HP Application Lifecycle 
Management Administrator Guide.

Error Red One or more business components included in 
the business process test or flow have Error 
status, indicating that they have errors that 
will or may cause a test run to fail.

Outdated Gray One or more business components included in 
the business process test or flow are Obsolete, 
indicating that they are outdated and are 
included in the Obsolete folder in the 
component tree in the Business Components 
module. 

Status Icon Color Description
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Test Script Tab
The Test Script tab enables you to build the structure of the business process 
test or flow by adding business components (and, in the case of tests, flows). 

You use this tab to: 

➤ Add business components (created in the Business Components module 
or in a testing tool such as QuickTest Professional) to a business process 
test or flow.

➤ Group components in a business process test or flow.

➤ Add flows to a business process test. 

➤ View and set values for input and output component parameters. 

➤ Define flow parameters and their default values.

➤ Define failure conditions.

➤ Add run conditions to a flow.

➤ Create iterations of components, groups, and flows.

➤ Validate tests and flows. 

➤ Run tests or flows in Debug mode. 

➤ Generate requests for additional business components that you require 
for your test or flow.

A green asterisk icon  next to the Test Script tab name indicates that the 
selected business process test contains one or more business components or 
flows, or the selected flow contains one or more business components.

In addition to the standard functionality available for business process tests, 
the Test Script tab includes additional functionality when working with 
flows. For more information on using this tab when working with flows, see 
"Understanding the Test Script Tab for Flows" on page 258.

For task information, see "Creating Business Process Tests" on page 213.
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The Test Script tab comprises the following panes:

➤ Test Script Pane

➤ Components and Flows Pane

➤ Component and Flow Details Pane

Test Script Pane

For each business component in the business process test or flow, the Script 
pane displays the name, status, input and output component parameters, 
iterations, run conditions, comments, and whether the test or flow 
continues if the component fails during the run. 

This section contains:

➤ "Test Script Pane Links" on page 197

➤ "Test Script Pane Toolbar" on page 198

➤ "Test Script Pane Context Menu" on page 199

Test Script Pane Links

The Test Script pane contains the following links for each business 
component:

I/O Parameters. Displays the input and output parameters defined for the 
business component in the I/O Parameters dialog box. For user interface 
details, see "The I/O Parameter Dialog Box" on page 325.

Iterations. Lets you manage the iterations for the business component, flow, 
or group, including setting parameter values for each iteration in the 
Iterations dialog box. For task details, see "How to Define Iterations to Run 
with Different Values" on page 334.
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Test Script Pane Toolbar

The Test Script pane toolbar contains the following toolbar buttons:

➤ Select Components. Opens the Components and Flows pane on the right 
side of the Script pane. The pane displays a tree of the business 
components defined for the project in the Components tab. If the item 
selected in the Script pane is a business process test, the pane also displays 
a tree of the flows defined for the project in the Flows tab. For more 
information on building a business process test using these components, 
see "Adding Components and Flows to a Business Process Test" on 
page 216. For more information on building a business process test using 
these flows, see "Adding Flows to Business Process Tests" on page 261.

➤ New Component Request. Enables you to request a new business 
component. For more information on generating a request for a new 
component, see "Requesting New Components for Business Process Tests 
or Flows" on page 227.

➤ Move Up/Move Down.Enables you to change the testing order in the 
business process test by moving a selected component or flow up or down 
in the order. If you select a group node, you can move the group within 
the business component or flow.

➤ Remove from Test. Removes the:

➤ Selected business component from the business process test or flow. 

➤ Selected group from the business process test or flow. 

➤ Selected flow from the business process test.

If criteria are specified for a component that is about to be removed, a 
warning message is displayed. The component is still available for future 
use, if required, from the component tree pane.

➤ Go to Component/Flow. Goes to and opens the selected business 
component or flow.

➤ Group. Creates a new group that includes the selected business 
components and flows. For more information, see "Grouping 
Components and Flows" on page 222.
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➤ Ungroup. Removes the selected group, or the grouping in which the 
selected business component or flow is a member. For more information, 
see "Grouping Components and Flows" on page 222.

➤ Show Test Parameters Promotion Status. Enables you to view a list of test 
and flow parameters that were promoted and where they were originally 
defined. For task details, see "How to View the Promotion Status for Test 
and Flow Parameters" on page 284

➤ Refresh. Updates the data, such as the component parameter data and 
snapshot, for each business component in the business process test. The 
test itself is not updated. 

➤ Validate Test. Checks the business process test or flow and all the test 
instances within the test set for errors. For more information, see 
"Validating Business Process Tests and Flows" on page 234. 

➤ Run or Debug Test. Enables you to run and debug a business process test. 
For more information, see "Debugging Tests in the Test Plan Module" on 
page 400.

When you select a flow in the Test Plan tree, the Test Script tab includes the 
following toolbar buttons:

➤ Add/Edit Run Condition. Enables you to add run conditions to your flow. 
For more information, see "Adding Run Conditions" on page 371.

➤ Remove Run Condition. Enables you to remove an existing run condition 
from your flow. For more information, see "Managing Run Conditions" 
on page 374.

Test Script Pane Context Menu

The right-click context menu in the Test Script pane includes many of the 
above options, as well as the following commands, which provide 
additional functionality and information about the business process test or 
flow:

➤ Go To Component. Goes to the component in the Business Components 
module. 

➤ Iterations. Opens the Iterations dialog box for the selected business 
component or flow.
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➤ Grouping. Opens a submenu with the Group and Ungroup options.

➤ Expand all below this node. Expands the business components in the tree 
for the selected group or flow. 

➤ Collapse. Collapses the business components in the tree for the selected 
group or flow. 

➤ Details. Opens the Details dialog box for the component or flow so that 
you can view its details. If you select a component request, opens the 
Details dialog box for the component request and you can edit the 
request.

Components and Flows Pane

The Components and Flows pane can be optionally displayed on the right 
side of the Test Script tab. The pane comprises two tabs, the Components 
tab and the Flows tab, that display the hierarchical structure of all business 
components and flows in the project. The Component Requests branch in 
the Components tab shows any additional components that may have been 
requested from the Test Plan module.

If the Components and Flows pane is not visible, click the Select 
Components button in the Test Script tab toolbar.

An example of the Components and Flows pane is shown below:
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You use the Components and Flows pane to build a business process test by 
dragging and dropping one or more business components, flows, or 
component requests from the relevant tabs into the Script pane (or by 
clicking the Quick Add button in the tab toolbar).

The Components tab and the Flows tab each contain the following toolbar 
buttons:

➤ Quick Add. Adds the selected business component or flow after the 
component, group or flow selected in the Test Script pane (or at the end 
of the test if no component or flow is selected). As the component or flow 
is added, parameters, if any exist, are promoted according to the last 
promotion method used. 

Alternatively, to explicitly set the promotion method, click the down 
arrow and choose one of the following options:

➤ Add And Automatically Promote All Parameters. All parameters are 
promoted to the next level as the component or flow is added.

➤ Add Without Promoting Parameters. Parameters are not promoted to 
the next level as the component or flow is added.

➤ Add while Setting Promote Options. The Promote Parameters dialog 
box opens, enabling you to individually set which parameters should 
be promoted. For user interface details, see "The Promote Parameters 
Dialog Box" on page 310.

For task details on promoting parameters, see "Promoting Parameters and 
Viewing Their Status" on page 282.

➤ Refresh Selected. Updates the data in the Components tab or Flows tab.

➤ Find. Enables you to search for a folder in the tree using the Find dialog 
box. For information on Find and Replace functionality, see the 
HP Application Lifecycle Management User Guide.

➤ Set Filter/Sort. Enables you to filter and sort the business components or 
flows in the tree. For more information on filtering and sorting a tree, see 
the HP Application Lifecycle Management User Guide.

➤ Go to Component/Test by ID. Displays and highlights the selected 
component, flow, or test in the tree. 
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Component and Flow Details Pane

The Component and Flow Details pane can be optionally displayed at the 
bottom of the Test Script tab. This pane contains different tabs depending 
on whether a flow, group, or a business component is selected in the Test 
Script tab.

The following tabs may be displayed, depending on the entity selected in 
the component tree: 

➤ The Notes tab displays the description and comments of the business 
component, flow, or group in read-only format. For more information on 
editing or entering implementation requirements for a business 
component, see "Providing Component Details and Implementation 
Requirements" on page 94.

➤ The Manual Steps tab displays the manual component steps defined for 
the component. This tab is not displayed for flows. For more information, 
see Chapter 4, "Designing Manual Component Steps."

➤ The Snapshot tab displays the full-sized image of the snapshot attached to 
the business component. This tab is not displayed for flows. For more 
information on adding an image, see "Attaching Images" on page 98.

➤ The Parameters tab lists the parameters defined for the component or 
flow. For more information, see Chapter 9, "Working with Parameters."
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➤ The Comments tab displays additional comments for the component 
instance that can be used to communicate between various users. For 
more information, see "Providing Component Details and 
Implementation Requirements" on page 94.

For more information on other test types, see the HP Application Lifecycle 
Management User Guide.

Parameters Tab
The Parameters tab enables you to define:

➤ Input and output parameters at the flow level.

➤ Input parameters at the test level.

The following is an example of the Parameters tab at the test level.
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A green asterisk icon :

➤ Next to the Parameters tab name indicates that the selected test or flow 
has one or more parameters.

➤ Next to the Default Value tab name indicates that the selected parameter 
has a default value.

The following tabs are displayed: 

➤ The Description tab displays the description and comments for the 
parameter.

➤ The Default Value tab displays the default value for the input parameter. 
You can edit the default value here, but for advanced editing, see "The Set 
Values Page" on page 301. 

For general details, see Chapter 9, "Working with Parameters."

For task information, see "Defining Parameters and Setting Default Values" 
on page 273.
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Test Configurations Tab
The Test Configurations tab enables you to define and update test 
configurations. 

A test configuration is a set of definitions that describe a specific use-case of 
a test. For example, a test configuration can specify a subset of data or a run-
time environment that the test should use. Associating test configurations 
with requirements provide finer granularity for requirement coverage by 
enabling coverage by different use-cases of a test.

Note: You cannot define configurations for flows.
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The following tabs are displayed: 

➤ The Description tab displays the description and comments for the test 
configuration.

➤ The Data tab displays the data associated with this test configuration. For 
more information, see "How to Define Test Configurations to Run with 
Different Values" on page 354.

➤ The Attachments tab. For more information, see "Attachments Tab" on 
page 206. 

➤ The History tab. For more information, see "History Tab" on page 210. 

For task information on working with basic test configurations for manual 
tests in ALM, see the HP Application Lifecycle Management User Guide. 

For conceptual details on test configurations for business process tests, see 
"Working with Parameters—A Workflow" on page 271. 

For task details on working with configurations for business process tests, 
see "How to Define Test Configurations to Run with Different Values" on 
page 354.

Attachments Tab
The Attachments tab enables you to associate an attachment with a business 
process test or flow. An attachment can be a file, URL, snapshot, or system 
information, and is identified by its name, associated application icon, size, 
and latest modification date and time. The tab also contains a Description 
area that enables you to enter a description of the selected attachment.

A green asterisk icon  next to the Attachments tab name indicates that the 
selected test or flow has one or more attachments.

You can select an attachment to view its description in the Description area, 
or double-click an attachment to launch it in the appropriate application.

The Attachments tab for business process tests and flows has the same 
functionality as the Attachments tab for other test types. For more 
information on adding attachments, see the HP Application Lifecycle 
Management User Guide.
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Req Coverage Tab
The Req Coverage tab enables you to define requirement coverage by 
linking your business process tests and flows to requirements. Requirements 
specify the testing objectives in ALM by describing what must be tested in 
the application to assess its operation or usability. Testing requirements are 
created in the Requirements module of ALM. 

The tab provides a list of all the testing requirements defined in the 
Requirements module, and enables you to map the specific requirements to 
the currently selected business process test or flow. This enables you to 
methodically build your business process tests and flows according to 
preplanned requirements, and also to review the extent to which your tests 
and flows cover these testing requirements.

A green asterisk icon  next to the Req Coverage tab name indicates that 
the selected test or flow includes requirement coverage.

The Req Coverage tab for business process tests has the same functionality 
as the Req Coverage tab for other test types. For more information on 
linking requirements to a test, see the HP Application Lifecycle Management 
User Guide.

Linked Defects Tab
The Linked Defects tab enables you to add and link defects to your business 
process tests. 

A green asterisk icon  next to the Linked Defects tab name indicates that 
the selected test or flow has one or more defects.

The Linked Defects tab for business process tests has the same functionality 
as the Linked Defects tab for other test types. 

For details on linking defects to a test, see the HP Application Lifecycle 
Management User Guide.
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Dependencies Tab
The Dependencies tab displays the dependency relationships that exist 
between:

➤ The selected business component, and entities such as flows and tests.

➤ The selected flow, and entities such as tests.

A green asterisk icon  next to the Dependencies tab name indicates that 
the selected test or flow has one or more dependencies.

For details, see the HP Application Lifecycle Management User Guide.

Business Models Linkage Tab
The Business Models Linkage tab enables you to link requirements and tests 
to a model entity. For user interface details, see the HP Application Lifecycle 
Management User Guide.

A green asterisk icon  next to the Business Models Linkage tab name 
indicates that the selected test or flow is linked to one or more business 
models.

For user interface details, see the HP Application Lifecycle Management User 
Guide.
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Criteria Tab
The Criteria tab enables you to view the entities, such as flows and business 
components, that comprise a test. These entities are defined as criteria, and 
are used for the purposes of analyzing requirement coverage at a more 
granular level.

You cannot define criteria for flows. Flows can, however, be defined as 
criteria in business process tests.

In the Criteria tab, you can modify a criterion’s name and description.

A green asterisk icon  next to the Criteria tab name indicates that the 
selected business process test has one criterion or more.

For more information, see "Working with Criteria for Requirement 
Coverage" on page 241.
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History Tab
The History tab in the Test Plan module comprises the following sub-tabs.

➤ The Baselines tab (or, when versioning is enabled at the site, the Versions 
and Baselines tab) displays the baselines of the item selected in the Test 
Plan tree. For information on working with version control in ALM, see 
the HP Application Lifecycle Management User Guide.

➤ The Audit Log tab displays changes made to specified fields in a test or 
flow. 

For details, see the HP Application Lifecycle Management User Guide.

Test Plan Module Components and Flows Pane

When working in the Test Script tab from the Test Plan module, you can 
toggle the display of the Components pane and the Flows pane by clicking 
the Select Components button in the Script pane toolbar. 

This pane enables you to add:

➤ Business components to flows

➤ Business components and flows to business process tests

For task information on using the Components pane and the Flows pane, 
see "Adding Components and Flows to a Business Process Test" on page 216.

While adding the components and flows, you can also promote parameters 
to the next level. For task information on promoting parameters, see 
"Promoting Parameters and Viewing Their Status" on page 282.
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7
Managing Business Process Tests

This chapter describes how to create and manage business process tests in 
the Test Plan module of HP Application Lifecycle Management (ALM). The 
Test Plan module also enables you to convert existing manual tests to 
manual components.

This chapter includes:

➤ About Managing Business Process Tests on page 212

➤ Creating Business Process Tests on page 213

➤ Adding Components and Flows to a Business Process Test on page 216

➤ Managing Parameters at the Component, Flow, and Test Levels 
on page 218

➤ Defining Failure Conditions on page 221

➤ Grouping Components and Flows on page 222

➤ Requesting New Components for Business Process Tests or Flows 
on page 227

➤ Copying Business Process Tests and Flows on page 230

➤ Deleting Business Process Tests and Flows on page 232

➤ Mailing Business Process Tests or Flows on page 233

➤ Validating Business Process Tests and Flows on page 234

➤ Converting Manual Tests to Components on page 235

➤ Working with Criteria for Requirement Coverage on page 241

➤ Generating Documents for Business Process Tests and Flows on page 251
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About Managing Business Process Tests

You create and manage business process tests in the Test Plan module of 
ALM. 

You define the details and description of the test, and then build up the test 
structure using a sequence of business components and flows in a specific 
business process. For more information, see "Creating Business Process Tests" 
on page 213.

You can also define whether a business process test run continues or ends if 
a specific component in the test fails. For more information, see "Defining 
Failure Conditions" on page 221.

You can define parameters that allow business components and flows to 
pass variable values between each other and the business process test. For 
more information, see "Managing Parameters at the Component, Flow, and 
Test Levels" on page 218.

You can attach appropriate files, snapshots, and URLs to provide additional 
information about the business process test, and link the test to preplanned 
project requirements. 

If a business component that is necessary for a business process test has not 
yet been defined in the Business Components module, you can create a 
component request. You can use the requested component in the test you 
are building, and it also acts as a signal to add a new business component to 
the project. For more information, see "Requesting New Components for 
Business Process Tests or Flows" on page 227.
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ALM enables you to generate a document about your project and business 
process test, which includes detailed information about the project’s 
requirements, planning, test list, test set folders, and defect tracking data. 
For more information, see "Generating Documents for Business Process Tests 
and Flows" on page 251.

Note: Much of the functionality available when working with tests is also 
available when working with flows. For more information about flows, see 
Chapter 8, "Working with Flows."

Creating Business Process Tests

You create business process tests by providing the overall details of the test 
and building a sequence of business components and flows. You can also 
attach appropriate files and link the test to project requirements. 

Create the business process test in the Test Plan module. 

To create a business process test:

 1 Access the Test Plan module, as described in "About Getting Started with 
Business Process Testing in the Test Plan Module" on page 184.

Note: Each business process test must be created in a folder or subfolder 
in the Test Plan tree. Steps 2 to 4 below describe the creation of a folder to 
contain the test. If you do not need to create a new folder, select the 
existing folder in which you want to store the business process test and 
proceed to step 5.
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 2 In the Test Plan tree, select the Subject root folder, or another folder or 
subfolder, in which you want to create a new folder.

 3 Click the New Folder button in the toolbar above the tree. The New Test 
Folder dialog box opens.

 4 In the Test Folder Name box, enter a descriptive name for the folder and 
click OK.

Note: The names of business process test folders must not contain two 
consecutive semicolons (;;) or include any of the following characters: 
\ * ^ 

The new folder is displayed as a subfolder of the selected folder in the 
tree.
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 5 Select the folder in which you want to create the business process test and 
click the New Test button in the toolbar, or right-click the folder and 
select New Test. The New Test dialog box opens.

 6 In the Test Name box, enter a descriptive name for the business process 
test.

Note: Business process test names must not contain two consecutive 
semicolons (;;) or include any of the following characters: \ / : " ' ? ‘ < > | * 
% 

 7 From the Type list, select BUSINESS-PROCESS.

 8 Click OK. The new business process test is added to the selected folder in 
the Test Plan tree. 
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Adding Components and Flows to a Business Process Test

The first step in building a business process test is to select the business 
components and flows (or component requests) and add them to the test.

Note: If you require a component in your business process test that does not 
yet exist, you can create a new component request and include it in your 
test in the same way as a regular component. For more information, see 
"Requesting New Components for Business Process Tests or Flows" on 
page 227.

To select business components and flows:

 1 In the Test Plan Tree, select the relevant business process test. 

 2 Click the Test Script tab and ensure that the Components and Flows pane 
is displayed on the right. If it is not displayed, click the Select 
Components button in the Script pane toolbar. 
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The Components and Flows pane comprises a Components tab and a 
Flows tab.

 3 In the relevant tab, expand the folder that contains the business 
component or flow required for the business process test.

 4 To add the required component or flow to the Script pane, use one of the 
following options. For more information, see "Promoting Parameters and 
Viewing Their Status" on page 282.

➤ To add the component or flow while setting promotion options, click 
the Quick Add button in the toolbar and select Add while Setting 
Promote Options. If the component or flow has parameters defined, 
the Promote Parameters dialog box opens. This dialog box enables you 
to choose whether to promote component or flow parameters to the 
next level. Select the parameters you want to promote. For more 
information, see "Promoting Parameters and Viewing Their Status" on 
page 282.
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➤ To add the component or flow while automatically promoting all 
parameters (and without opening the Promote Parameters dialog box), 
click the Quick Add button in the toolbar and select Add And 
Automatically Promote All Parameters. The component or flow 
parameters are promoted to the next level.

➤ To add the component or flow without promoting all parameters (and 
without opening the Promote Parameters dialog box), click the Quick 
Add button in the toolbar and select Add Without Promoting 
Parameters. The component or flow parameters are not promoted to 
the next level. 

➤ To add the component or flow using the last-used method for 
parameter promotion, do one of the following: 

➤ Double-click the component or the flow.

➤ Drag the component or flow to the Script pane.

➤ Click the Quick Add button in the toolbar.

➤ Click the Quick Add button in the toolbar, and select the Quick Add 
menu option. 

 5 If necessary, click OK to close the Promote Parameters dialog box.

 6 To arrange the business components and flows into a logical testing order, 
select business components and flows in the Test Script pane and either 
use the arrow buttons in the toolbar, or use the Move up and Move down 
options in the right-click context menu. 

Managing Parameters at the Component, Flow, and Test 
Levels

You can configure how many times, and with which parameter values:

➤ A business component runs in a test.

➤ A flow runs in a test. 

➤ A test instance runs using certain configurations and iterations. 



Chapter 7 • Managing Business Process Tests

219

For more details on:

➤ Working with parameters: See Chapter 9, "Working with Parameters."

➤ Working with iterations: See Chapter 11, "Working with Iterations."

➤ Working with configurations: See Chapter 12, "Working with Test 
Configurations."

To view the parameters defined for a component, group, or flow in a 
business process test:

 1 In the Script pane of the Test Script tab, click the link in the I/O 
Parameters column for the corresponding component, group, or flow. 
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 2 The I/O Parameters dialog box opens. 

 3 Click OK. 

Note: This dialog box can also be used to link the values of output 
parameters to input parameters.
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Defining Failure Conditions

You can define whether a business process test run continues or ends if a 
specific business component in the test fails. 

To define the failure condition for a component:

 1 In the Script pane of the Test Script tab, click in the On Failure column for 
the business component. A down arrow is displayed.

 2 Click the down arrow and select one of the following from the list:

➤ Exit. The business process test run will end if the selected business 
component fails.

➤ Continue. The business process test will run the next business 
component if the selected component fails. By default, this failure 
condition is defined for each component when it is added to a test.
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Grouping Components and Flows

In some cases, it may be helpful to iterate several business components or 
flows together as a group.

This section contains the following topics: 

➤ "Creating Groups"

➤ "Modifying a Group"

➤ "Ungrouping a Group"

For conceptual details on group iterations, see "Group Iterations" on 
page 332.

For task details on iterating groups, see "How to Define Iterations to Run 
with Different Values" on page 334.

Creating Groups
You create groups of business components and/or flows in the Test Script tab 
of the Test Plan module. You can combine any number of components or 
flows in the business process test into a group, providing they comply with 
the following requirements:

➤ A component or flow can belong to one group only.

➤ Components or flows must be contiguous to be included in the same 
group.
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➤ Components or flows in the group with input parameters must have the 
same number of iterations. When grouping, if iteration ranges are set per 
component, ALM requests confirmation that the iteration range should 
be set to that of the first component’s iteration range. For example, if the 
first component in the group is set to run iterations 2 to 3, the entire 
group will be set to run iterations 2 to 3.

➤ For iterations of a group to be successful, the state of the application at 
the end of the last item in the group must match the state of the 
application before the first item in the group. For example, if the first 
component in the group assumes that the Login dialog box in an 
application is open, then at the point where the last component of the 
group ends, the Login dialog box but be in an open state before the next 
iteration begins. 

To create a group:

 1 Select the business process test or flow in which you want to create one or 
more groups and click the Test Script tab.

 2 In the Script pane, select one or more contiguous components or flows. 
The selected items are highlighted.

 3 Right-click, and select Grouping > Group. The group is created above the 
items.

The group is named, by default, Group followed by a unique number. You 
can rename the group by right-clicking its name and selecting Rename. 

All items to be included in the group must have the same number of 
iterations and the same iteration range, or a warning message is displayed.
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 4 Click the iterations link for the group to view and modify the iterations 
for each of the members in the Group Iterations dialog box. 

 5 Click OK to close the Iterations dialog box.

Groups in the Test Script tab are identified by a group node listed above its 
members. The group node contains the group icon and displays the number 
of iterations for the group. The group node can be expanded and collapsed 
to show or hide its members. 

➤ The number of iterations indicates the total number of value sets defined 
for the group. 

➤ The iteration range indicates the subset of iterations currently set for use 
when the test runs.

For task details on working with group iterations, see "How to Define 
Iterations to Run with Different Values."

For user interface details on working with the Group Iterations dialog box, 
see "Iterations Dialog Boxes and Tabs."
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Modifying a Group
You can add and remove members from component groups as required, 
change the order of groups in a business process test or flow, and change the 
order of members inside a group. In addition, you can add or delete 
iterations for all members in the group, and select a partial iteration range 
for all members in the group.

Note: Moving a group or a member within a group could cause a parameter 
reference conflict, for example, where a group is moved to a position 
preceding the component that provides an input component parameter 
needed by a parameter in the group.

If the resulting warning message is ignored, the conflicting link to the 
source parameter is deleted. The value for the source parameter will be 
empty. You can then either supply a value for the parameter or reinstate the 
link in the Group Iterations dialog box.

To modify a group:

The following table describes the procedures you can perform when working 
with groups:

To... Perform the following:

Add a business 
component or 
flow to a group

Drag the component or flow from the Component Tree 
pane to the relevant position within the group.

Select the component or flow. Drag the item up or down 
into the group, and drop it at the required location.

Remove a business 
component or 
flow from a group

Select the component or flow. Drag the item up or down 
out of the group, and drop it at the required location.

Move a group up 
or down in the 
test

Select the group node, and right-click, and select Move up 
or Move down.
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Ungrouping a Group
Components and flows can be ungrouped if required.

The following table describes several procedures you can perform to 
ungroup components and flows:

Add group 
iterations

Right-click the group and click Iterations to open the 
Group Iterations dialog box. Click the Add Iteration 
button  in the toolbar to add a new iteration for all 
the members in the group. Adding and configuring group 
iterations is similar to adding and configuring component 
iterations, as described in "Guidelines for Working with 
Iterations" on page 335. 

Delete group 
iterations

Right-click the group and click Iterations to open the 
Group Iterations dialog box. Select one or more iteration 
columns and click the Delete Iteration button in the 
toolbar.

Select a partial 
iteration range

Click the iterations link for the group to open the Group 
Iterations dialog box. Click the Select Iterations  
button in the toolbar. Selecting a partial iteration range 
for the members of a group is similar to selecting a partial 
iteration range for a single component, as described in 
"How to Select Iteration Ranges" on page 337.

To... Perform the following:

Remove a grouping Select the group node and click the Ungroup 
button  in the toolbar.

Completely remove a group, 
including the members in the 
group

Select the group node and click the Remove 
from Test button  in the toolbar.

To... Perform the following:



Chapter 7 • Managing Business Process Tests

227

Requesting New Components for Business Process Tests or 
Flows

If, while creating a business process test or flow in the Test Plan module, you 
realize that a necessary business component has not been defined, you can 
create and submit a component request. The component request is a signal 
to add the new component to the project.

You can view and edit component requests generated in the Test Plan 
module in the Component Tree pane on the right of the Test Script tab. You 
can view component requests in the Component Requests folder of the 
component tree in the Business Components module. 

After confirming that a requested component and its parameters are 
necessary for business process testing, you can drag the component request 
from the Component Requests folder to the appropriate folder in the 
component tree in the Business Components module.

For more information on adding component requests to the component 
tree, see "Handling Component Requests" on page 110.

This feature is especially useful when the roles of creating components in 
the Business Components module and building business process tests or 
flows in the Test Plan module are performed by different personnel.

Creating a Component Request
If a necessary business component has not been defined in the Business 
Components module, you can create and submit a component request from 
the Test Plan module.

To create a component request:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 In the Test Plan tree, select the business process test or flow for which you 
want to create a component request and click the Test Script tab.

 3 Click the New Component Request button in the Test Script tab toolbar.
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The Component Details dialog box opens. 

 4 In the Component name box, either enter a unique name for the request 
or accept the one supplied for you by ALM. 

 5 From the Assigned to list, select the subject matter expert to whom the 
request is assigned. 

 6 If required, click the Send E-mail button on the toolbar to send a 
notification of the new request. For more information, see the 
HP Application Lifecycle Management User Guide.

 7 If required, you can click the Snapshot sidebar entry to capture and attach 
an image associated with the component request. For task information on 
attaching an image, see "Attaching Images" on page 98.

 8 Define any other additional properties for the component request at this 
time, such as description details, and input or output component 
parameters for the component request.

 9 Enter the steps that should comprise the component. For information on 
how to enter steps, see "About Designing Manual Component Steps" on 
page 121.
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 10 Click OK. The new component request is displayed in the Test Script tab 
for the selected business process test or flow, and in the Component Tree 
pane under the Component Requests folder. 

The new request is automatically assigned the status of Not Implemented.

Note: The component request status changes from Not Implemented to 
Under Development when you move the request from the Component 
Requests folder into a component folder in the Business Components 
module.

For more information, see "Handling Component Requests" on page 110.

Modifying a Component Request
You can edit the properties of a component request, provided the request is 
still listed in the Component Requests folder in the component tree.

To edit a component request:

 1 Right-click the component request in the:

➤ Script pane of the Test Script tab in the Test Plan module

➤ Component tree in the Business Component module

 2 Select Details. The Component Details dialog box opens.

Note: If the component request has been moved to a component folder 
from the Component Requests folder in the Business Components 
module, or if the component request has been moved to the Obsolete 
folder, the properties in the Component Details dialog box are displayed 
in read-only format.

 3 Edit the properties in the tabs, as required, and click OK. 
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Deleting a Component Request
You can delete a component request in the Business Components module 
only. For more information, see "Deleting Component Requests" on 
page 113.

Copying Business Process Tests and Flows

You can duplicate an existing business process test or flow as the basis for a 
new test or flow in the current project, or in another project, and then 
position the new test or flow anywhere in the Test Plan tree of that project.

For the purposes of this discussion, references to business process tests also 
include flows.

Note: You can copy a business process test to another project on the same 
server or on another server.

When you copy a business process test within the current project, existing 
business components in the test are linked to the copied test, and the 
original components are not copied.

When you copy a business process test to another project, the test and its 
related business components are copied in the same component tree 
structure as in the source project (including any components in the 
Obsolete folder).

When components are copied to another project or server as a result of 
copying a business process test, all considerations for copying components 
apply, as described in "Copying Folders and Business Components" on 
page 102.
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To copy an existing business process test or flow:

 1 If copying to another project or server, open the source and target projects 
in separate browsers.

 2 In the Test Plan tree, right-click the business process test or flow that you 
want to copy and select Copy.

 3 Right-click the folder in which you want to paste the new business 
process test or flow (in the current project or in another project on the 
same server) and select Paste. The test or flow is copied to the new 
position in the Test Plan tree.

Note: If a copied business process test or flow has the same name as a test 
that already exists in the target folder, a duplicate name warning message 
is displayed. Click OK. The business process test or flow is copied to the 
new position in the Test Plan tree and a suffix, for example _Copy_1, is 
automatically added to the test or flow name to create a unique name 
within the folder.

 4 If you want to modify the name, select the test or flow in the tree and 
click again to activate the test label for editing. Alternatively, right-click 
the new test or flow and select Rename. Then enter a new name.

 5 If required, select the new business process test or flow in the tree and 
modify the settings in the tabs. For more information on business process 
test settings, see "Test Plan Module Tabs for Business Process Testing" on 
page 190.
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Deleting Business Process Tests and Flows

You can delete a business process test or flow, or a test folder, from the Test 
Plan tree.

➤ If you delete a business process test or flow, ALM permanently deletes the 
test or flow from the project. The test or flow is removed from all test sets 
and the run history is erased.

➤ If you delete a test folder, then by default ALM moves all the tests or flows 
in the folder to the Unattached folder in the tree.

Note: It is highly recommended that you do not run a business process test 
or flow from the Unattached folder. Move the test or flow to a valid folder in 
the Test Plan tree before running it.

To delete a business process test or flow:

 1 In the Test Plan tree, select the business process test or flow and click the 
Delete button in the tree toolbar, or right-click the test and select Delete. 
A warning message is displayed.

 2 Click Yes. The business process test or flow is permanently deleted.
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To delete a test folder:

 1 In the Test Plan Tree, select the test folder and click the Delete button in 
the tree toolbar, or right-click the folder and select Delete. The Confirm 
Delete Folder dialog box opens.

 2 Select:

➤ Delete folders only to move all the tests or flows in the folder to the 
Unattached folder.

➤ Delete folders and tests to permanently delete all the tests, flows, and 
subfolders in the folder.

 3 Click Yes. The folder or the folders, and the tests or flows, are deleted 
according to your selection.

Mailing Business Process Tests or Flows 

You can send an e-mail about one or more business process tests or flows to 
another user. For example, the email of a business process test could include 
a flow, the components that flow contains and their component steps, 
followed by a component and its component steps.

A link is included in the email message that enables the recipient to go 
directly to the entity in the Test Plan module.

For more information, see the HP Application Lifecycle Management User 
Guide.
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Validating Business Process Tests and Flows

You can check your business process tests and flows to locate any 
component errors that could halt the successful running of the test or flow. 

Validating a business process test or flow in the Test Plan module checks all 
instances of the test or flow within all test sets. 

To validate a business process test or flow:

 1 In the Test Plan tree, select the business process test or flow and click the 
Test Script tab.

 2 Click the Validate Test button in the toolbar.

Business Process Testing validates all instances of the business process test 
or flow and reports the results in the Test Validation Results dialog box, as 
shown in the example below. 

 3 If a validation error is reported, you can click the link in the Entity 
column to jump directly to the business component causing the error. 
Errors are indicated in the Description column. 

Note: In the case of an iteration range mismatch, the error is indicated in 
the second component. 
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Open the Component Iterations dialog box of the component that caused 
the error, and modify the component parameter or parameters as 
required. For more information on working with business component 
parameters, see Chapter 9, "Working with Parameters".

 4 Click OK to close the Test Validation Results dialog box.

 5 When you are finished, repeat the validation check. If the error has been 
resolved, a message is displayed indicating that the validation was 
successfully completed.

Converting Manual Tests to Components

In the Test Plan module, you can convert existing manual ALM tests (not 
business process tests) to manual components using the Select Destination 
Folder dialog box. 

To convert tests to components, in the Test Plan tree, select one or more 
manual tests or a test folder, and click the Convert To Component button. 
You can also right-click one or more manual tests or a test folder in the Test 
Plan tree, and select Convert To Component. 

The new components are created in a folder that you specify or create in the 
component tree in the Business Components module.

You can also recursively convert all the tests in a folder and all its subfolders 
simultaneously. In this case, the components are created in the same folder 
structure in the Business Components module as the original tests in the 
Test Plan module. If no manual tests exist in the selected source folder, an 
empty folder structure is created in the specified destination folder.

For more information, see:

➤ "The Select Destination Folder Dialog Box" on page 237

➤ "Considerations When Converting Manual Tests to Components" on 
page 240
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In the Business Components module, the Details tab of the converted 
component includes the following elements:

➤ Component name. The name you enter in the New Component Name 
box in the Destination Folder dialog box. (The default is the name of the 
test.) If a component with the same name already exists in the destination 
folder, a suffix, for example _Copy_1, is automatically added to the name 
to create a unique name within the folder.

➤ Assigned to. Remains empty.

➤ Automation engine. Displayed as MANUAL.

➤ Created by. The user who converted the test.

➤ Creation date. The date the test was converted.

➤ Status. Displayed as Under Development.

➤ Description. Copied from the Description tab of the test. The name of the 
source test and the test ID are also displayed.

➤ Comments. Copied from the Comments tab of the test.



Chapter 7 • Managing Business Process Tests

237

The Select Destination Folder Dialog Box 

Description Displays the component tree from the Business 
Components module, and enables you to select a 
destination folder for your converted components 
in the tree. 

To Access In the Test Plan tree, do one of the following: 

➤ Select one or more manual tests, or a test folder, 
and click the Convert To Component button.

➤ Right-click one or more manual tests, or a test 
folder, and select Convert To Component.

➤ Select one or more manual tests, or a test folder, 
and select the Tests > Convert To Component 
menu command.

Important Information ➤ Only manual tests in the selected folders are 
converted.

➤ The options available in the Select Destination 
Folder dialog box depend on whether you select 
a single test, multiple tests, or a folder in the Test 
Plan Tree. For more information, see "Select 
Destination Folder Dialog Box Options" on 
page 239.

See Also Conceptual overview: "Converting Manual Tests to 
Components" on page 235.

Additional related topics:

➤ "Select Destination Folder Dialog Box Options" 
on page 239.

➤ "Considerations When Converting Manual Tests 
to Components" on page 240.
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Below is an image of the Select Destination Folder dialog box: 

The example shown above opens when a folder is selected in the Test Plan 
tree. 

➤ When a single test is selected:

➤ The New Component Name box is displayed.

➤ The Include tests in subfolders check box is not displayed.

➤ When more than one test is selected:

➤ The New Component Name box is not displayed.

➤ The Include tests in subfolders check box is not displayed.
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Select Destination Folder Dialog Box Options 

Option Description

 Refresh Updates the data in the component tree.

 Find Enables you to search for a folder in the 
component tree. Full or partial folder names can be 
entered in the text box to the left of this button.

For information on Find and Replace functionality, 
see the HP Application Lifecycle Management User 
Guide.

 New Folder Enables you to create a new folder for your 
converted components below the selected 
destination folder in the component tree.

 Go to Entity by ID Enables you to highlight a folder in the tree by 
entering its folder ID number. 

Include tests in subfolders Enables you to recursively convert all the tests in 
the selected folder and all of its subfolders 
simultaneously. If the number of tests is large, this 
action may take some time.

Available: When a test folder is selected in the Test 
Plan Tree.

New Component Name Enables you to enter a new name for a converted 
component. The default is the name of the test. 
This field is mandatory.

Note: If a component with the same name already 
exists in the destination folder, a suffix is 
automatically added to the name to create a unique 
name within the folder (for example _Copy_1).

Available: When a single test is selected in the Test 
Plan Tree.
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Considerations When Converting Manual Tests to 
Components

Parameters

➤ Test parameter names may contain special characters that are not 
permitted in a component parameter name. Such characters are replaced 
with an underscore (_) when the test is converted.

➤ If a parameter name does not start with an English letter, the letter p is 
added as a prefix to the name when the test is converted.

➤ The parameter default value is copied from the test parameter.

➤ The parameter description is copied from the test parameter.

Component Steps

In the Component Steps tab of the new component:

➤ Step names and expected results are copied from the component steps in 
the test.

➤ Parameter names may be changed during the conversion process - see 
"Parameters", above. Parameter names in the step descriptions are 
changed accordingly.

➤ Certain test steps may call another test. If a component step is of type 
“call to”, it is copied as a regular step with the step name “Call”. The 
description is displayed as “Call <linked test name>”.

Other

Attachments, linked defects, and the test history are not copied over to the 
converted component.
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Working with Criteria for Requirement Coverage

In ALM, you can make sure that the tests in your test plan meet your 
original requirements by adding links between them. This is called 
requirement coverage.

In the Test Plan module, you create requirement coverage by selecting 
requirements to link to a test or a test configuration. Alternatively, in the 
Requirements module, you create test coverage by linking tests or test 
configurations to a requirement. 

With Business Process Testing, you can also link a requirement to criteria. 
When creating coverage between requirements and business process tests, 
instead of covering each requirement only at the level of a test and its 
configuration(s), you can define coverage by criteria, such as flows or 
business components. This enables you to determine if a test passed or failed 
on a more granular level. For example, a test can be considered passed even 
if just one of its business components passed, such as the most critical one. 
Less critical business components have no effect on the overall status of the 
test.

This section discusses:

➤ "About Calculating Coverage by Criteria" on page 241

➤ "How to Set Coverage by Criteria" on page 243

➤ "How to Modify the Criteria for Requirement Coverage" on page 247

➤ "How to Analyze Coverage by Criteria" on page 248 

About Calculating Coverage by Criteria
The logic used for calculating coverage by criteria is similar to the logic used 
for calculating coverage by tests and test configurations. For conceptual 
details on coverage analysis for tests and test configurations, see the 
HP Application Lifecycle Management User Guide. 
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Consider the following, however, when defining coverage for criteria:

➤ Coverage is calculated only for each instance of the selected criteria. 

For example, if a business process test contains three components, 
Component1, Component2, and Component3, and Component2 is the 
only criterion selected for coverage, each instance of Component1 and 
Component3 has no affect on coverage, regardless of whether the 
instances pass or fail. When all the instances of Component2 run, the 
requirement for the entire configuration is considered covered.

➤ Coverage for flows is calculated as follows: 

➤ Coverage for flows that are run from within a business process test is 
calculated for the flow in its entirety, and not according to the 
individual criteria within the flow.

➤ Coverage for flows that are run independently of a business process 
test is calculated according to the individual criteria within the flow. 

➤ When working with more than one configuration and multiple iterations, 
coverage for a criterion is calculated for each iteration of each 
configuration. If one of the criterion for an iteration of a configuration 
fails, the requirement coverage for the associated test fails.

For example, business process test OrderFlights has two business 
components, CheckFlights and ReserveFlights. Only ReserveFlights is set 
as a criterion for covering the test requirements, perhaps because it is 
assumed that if the user was able to reserve a flight, the user must have 
been able to check the flight. The test has two different configurations, 
Domestic and International, representing different types of flights. Each 
configuration iterates three times, testing the reservation of three 
domestic flights and three international flights. 
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Using this example, only the following component instances are 
examined when calculating coverage:

➤ Domestic configuration, Iteration 1, ReserveFlights

➤ Domestic configuration, Iteration 2, ReserveFlights

➤ Domestic configuration, Iteration 3, ReserveFlights

➤ International configuration, Iteration 1, ReserveFlights

➤ International configuration, Iteration 2, ReserveFlights

➤ International configuration, Iteration 3, ReserveFlights

If just one of these six component instances fails, the associated tests fails 
when requirement coverage is calculated. 

How to Set Coverage by Criteria
With Business Process Testing, you can create requirement coverage for 
flows and business components in addition to test configurations from the 
Test Plan module and the Requirements module. 

Note: When defining the criteria that ALM should use to calculate coverage 
for a test configuration, keep in mind that the same criteria are used for all 
configurations of the test. It is not possible to define different criteria for 
different configurations for the same test.

To set coverage by criteria from the Test Plan module: 

 1 In the ALM sidebar, under Tests, select Test Plan. 

 2 If the test plan tree is not displayed, select View > Test Plan Tree. 

 3 Select the business process test or flow for which you want to set criteria 
coverage in the test plan tree. 

 4 Click the Req Coverage tab. 

 5 If the requirement tree is not displayed in the pane on the right, click 
Select Req button on the toolbar. The requirement tree opens.



Chapter 7 • Managing Business Process Tests

244

 6 Select the requirement for which to add coverage in the requirement tree.

 7 Click Add To Coverage in the requirement tree toolbar (either with or 
without children). Either the Add Criterion Coverage or Add Advanced 
Coverage dialog box opens. 

For user interface details on the Add Criterion Coverage dialog box, see 
the HP Application Lifecycle Management User Guide.

 8 Select the criteria for which you want coverage and click OK. The selected 
criteria are added to the grid.

If you click OK without selecting criteria, the requirement is covered by 
the entire test.

Tip: To instruct ALM to hide the dialog box and add coverage only at the 
test level, without prompting you to select flow or business component 
criteria, select the Don’t show me this dialog again checkbox. You can 
reveal the dialog box by selecting View > Req Coverage > Show Advanced 
Coverage. 
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 9 To view the criteria you defined:

 a In the Test Plan tree, select the business process test. 

 b Click the Criteria tab. View the name, execution status, the name of 
the user who created the criteria, and the creation date. 

For user interface details on the Criteria tab, see the HP Application 
Lifecycle Management User Guide.

To set coverage by criteria from the Requirements module: 

 1 In the ALM sidebar, under Requirements, select Requirements. 

 2 If the requirement tree is not displayed, select View > Requirements 
Details. 

 3 Select the requirement for which you want to set criteria coverage in the 
requirement tree. 

 4 Click the Test Coverage tab. 

 5 If the test plan tree is not displayed in the pane on the right, click Select 
on the toolbar. The Test Plan tree opens.

 6 In the Test Plan tree, select the test or flow for which to add coverage.

➤ When adding coverage by a flow, the flow is added to the grid.

Note: ALM does not create criteria for a flow’s business components 
when selecting a flow from the test plan tree. To add business 
components as criteria, add coverage by selecting the corresponding 
business process test from the test plan tree.
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➤ When adding coverage by a business process test, the Add Criterion 
Coverage dialog box opens. 

This dialog box shows all criteria (flows, business components) that 
have not yet been added as criteria for coverage of this requirement. 
For user interface details on the Add Criterion Coverage dialog box, see 
the HP Application Lifecycle Management User Guide.

 7 In the Add Criterion Coverage dialog box, select the criteria for which you 
want coverage and click OK. The selected criteria are added to the grid.

If you click OK without selecting criteria, the coverage is set for the 
business process test as a whole and the test name (or, when working with 
test configurations, each test configuration name) is added to the grid.

Tip: To instruct ALM to hide the Add Criterion Coverage dialog box and 
add coverage only at the test level, without prompting you to select flow 
or business component criteria, select the Don’t show me this dialog 
again checkbox. You can reveal the Add Criterion Coverage dialog box by 
selecting View > Test Coverage > Show Add Criteria to Coverage. 
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How to Modify the Criteria for Requirement Coverage
After setting requirement coverage by criteria for business process test, you 
can modify the coverage by adding and removing criteria using the 
Criterion Settings tab.

Note: When defining the criteria that ALM should use to calculate coverage 
for a test configuration, keep in mind that the same criteria are used for all 
configurations of the test. It is not possible to define different criteria for 
different configurations for the same test.

To modify existing coverage by criteria: 

 1 In the ALM sidebar, under Tests, select Test Plan. 

 2 If the test plan tree is not displayed, select View > Test Plan Tree. 

 3 Select the business process test or flow for which you want to set criteria 
coverage in the test plan tree. 

 4 Click the Req Coverage tab. 

 5 Click the Criterion Settings tab near the bottom of the window.

 6 To remove a criterion, select the criterion in the grid and click the 
Remove Criteria button on the toolbar. 
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 7 To add a criterion, select the criterion in the grid and click the Add 
Criteria button on the toolbar. The Add Criterion Coverage dialog box 
opens. For user interface details on the Add Criterion Coverage dialog 
box, see the HP Application Lifecycle Management User Guide. 

 8 In the Add Criterion Coverage dialog box, select the criteria for which you 
want coverage and click OK. The selected criteria are added to the grid.

How to Analyze Coverage by Criteria
The main purpose for setting criteria for coverage is to be able to analyze 
requirement coverage on a detailed level, such as by business component 
and flow, and not only on a general level, such as by test.

The following methods enable you to analyze coverage by criteria:

➤ Using the Coverage Analysis View on page 249

➤ Checking Criterion Results on page 249

➤ Checking Criteria Status on page 250

➤ Creating Test Criteria Reports on page 250
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Using the Coverage Analysis View

The Coverage Analysis View enables you to examine the status of your 
requirements by displaying the breakdown of requirements according to test 
coverage and test configuration coverage. 

When working with Business Process Testing, this view also enables you to 
examine the status of requirements according to criteria coverage, such as 
by flows and business components.

To access the Coverage Analysis View:

 1 In the Requirements module, select Coverage Analysis from the View 
menu. 

 2 Click the Direct Cover Status link for a requirement in the grid. The 
Coverage Analysis dialog box opens. 

➤ Click Show Test Coverage to see the analysis as a pie chart.

➤ Click the pie chart to open the Test Coverage dialog box, from which 
you can see the coverage criteria in a grid.

For user interface details, see the HP Application Lifecycle Management User 
Guide and the HP Application Lifecycle Management User Guide. 

Checking Criterion Results

The Criterion Results tab displays the results of the last test criteria run for 
the selected business process test.

You can also modify the status of the last test criteria run. For example, if a 
criterion failed due to a temporary condition that should not impact the 
coverage of the requirement, you can override the misleading status by 
changing it to Passed.

Perform one of the following to access this tab.

➤ In the Test Lab module’s Test Sets tab, select a test set and then click the 
Execution Grid tab.

➤ In the Test Lab module’s Test Runs tab, select a run.

➤ In the Test Lab module’s Run Details dialog box sidebar, click Criterion 
Results.
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Checking Criteria Status

The Criteria Status dialog box displays the status of each criterion for the last 
test criteria run used for the coverage of the selected requirement.

To access the Criteria Status dialog box: 

 1 In the Requirements module, select the requirement whose coverage you 
are checking. Make sure that the requirement already is associated with 
criteria.

 2 Click the Test Coverage tab. 

 3 Click the Test Configuration Status tab near the bottom of the window. 

 4 In the Status column, click the hypertext link for the business process test 
whose criteria you want to check. The Criteria Status dialog box opens.

Tip: If there is no hypertext link to click, it means no components or 
flows have been added to the test, and therefore there are no criteria to 
check. Add components to the test in the Test Plan module and refresh 
the display in the Requirements module.

 5 View the status for each criterion’s last run. 

 6 Click OK. 

Creating Test Criteria Reports

You can create a template-based report for tests that includes test criteria 
coverage. 

For complete task details on creating template-based reports, see the 
HP Application Lifecycle Management User Guide.

To create a report that displays test criteria coverage:

 1 In the ALM sidebar, under Dashboard, select Analysis View. 

 2 In the relevant folder, click New Item and select New Project Report. The 
New Project Report dialog box opens. 
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 3 Enter a name for the report and click OK. 

 4 In the Configuration tab, right-click and select Add Report Section. 

 5 Select Tests in the Type field. 

 6 Enter a name for the report section in the Name field and click OK.

 7 In the tree, right-click the test node that you just created and select Add 
Report Section.

 8 Select Test Criteria in the Type field.

 9 Enter a name for the report section in the Name filed and click OK. 

 10 Specify other fields as necessary and click Generate. 

Generating Documents for Business Process Tests and Flows

The ALM Document Generator enables you to generate Microsoft Word 
documents containing comprehensive data about a selected business 
process test, flow, or test set. These documents include detailed information 
about a project’s requirements, planning, test list, test set folders, and defect 
tracking data.

For more information on generating documents for tests, see the 
HP Application Lifecycle Management User Guide.

Note: For more information on including component data in project 
documents, see "Generating Project Documents" on page 117.
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8
Working with Flows

This chapter describes how to create, build, and manage flows in the Test 
Plan module of HP Application Lifecycle Management (ALM). This chapter 
also describes how to add flows to business process tests. 

This chapter includes:

➤ About Working With Flows on page 254

➤ Creating Flows on page 256

➤ Developing Flows on page 257

➤ Understanding the Test Script Tab for Flows on page 258

➤ Building a Flow Structure on page 259

➤ Managing Flows on page 261
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About Working With Flows

A flow is a collection of business components in a sequence that can be used 
as a unit in multiple business process tests. This provides you with a 
building block you can use in multiple tests, but that has a single point of 
maintenance. When you modify a flow or any of its components, all 
business process tests containing that flow reflect that modification.

For an example of how flows can be used in more than one business process 
test, see "Flow Example" on page 254.

You work with flows in the Test Plan module. After you create a flow, you 
develop it by providing flow details, adding components, adding 
attachments, and creating associations between the flow and other ALM 
records, such as requirements and defects. These associations provide real-
time visibility into modifications for interrelated, application-quality 
elements.

Notes:

➤ Much of the functionality available in ALM when working with flows is 
the same as the functionality when working with business process tests. 
For more information, see Chapter 7, "Managing Business Process Tests."

➤ The permission settings for a user group for working with flows are the 
same as those for the user group for working with tests. For more 
information on configuring user group permission settings, see the 
HP Application Lifecycle Management Administrator Guide.

Flow Example

Suppose you are testing an application for a production and supply 
company. The company supplies goods it produces, as well as goods through 
third-party order processing. 

In third-party order processing, the company transfers the sales order to an 
external vendor. This vendor delivers the goods directly to the customer and 
invoices the branch company. The customer receives an invoice from the 
branch company’s sales office.
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To reflect these options, your application has two separate business 
processes, one for the Generating Orders business process, and one for 
Third-party Order processing. Both business processes begin with the Create 
Sales Order transaction. The Create Sales Order transaction contains all the 
steps necessary to begin sales processing.

The Generating Orders business process continues on to delivery and billing 
of the order, as well as producing a variety of other documents and reports. 
The Third-party Order business process continues on to creating a purchase 
order, posting a goods receipt, posting an invoice receipt, and invoicing the 
sales order.

To test these business processes, you would create a flow called Create Sales 
Order. This flow would contain the components that perform the 
operations necessary to complete the Create Sales Order transaction.

You would create one business process test for the Generating Orders 
business process and one for the Third-party Order business process. The 
Create Sales Order flow could be used in these two tests since both tests 
represent business processes that contain the same transaction. 

If, at any time in the future, the Create Sales Order transaction changes in 
your application, you would update the Create Sales Order flow. Both your 
business process tests would reflect the changes in your application.
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Creating Flows

You create flows within the Test Plan Tree in the Test Plan module. For 
information on working in the Test Plan module, see "About Getting Started 
with Business Process Testing in the Test Plan Module" on page 184.

To create a flow:

 1 In the ALM sidebar, under Testing, select Test Plan. 

 2 If the Test Plan Tree is not displayed, select View > Test Plan Tree.

 3 Select the folder in the Test Plan Tree in which you want to create the flow 
and click the New Test button. The New Test dialog box opens. 
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 4 From the Type list, select FLOW.

In a version-controlled project, you can choose whether to check the flow 
out immediately, and if so, you can add a comment to the check out.

 5 In the Test Name box, type a name for the flow.

 6 Add other details and attachments as necessary.

 7 Click OK. The flow is added to the selected folder in the Test Plan Tree.

Developing Flows

After you create a flow, you can use the following tabs to plan and design 
the flow:

➤ Details tab. Enables you to view and modify flow details. For more 
information, see "Details Tab" on page 191.

➤ Test Script tab. Enables you to build the structure of the flow by selecting 
one or more business components and adding them to the flow. For more 
information, see "Understanding the Test Script Tab for Flows" on 
page 258.

➤ Parameters tab. Enables you to define input and output parameters, and 
their values, at the flow level. This allows the flow to receive data from an 
external source and to pass data to components or flows. For general 
details, see Chapter 9, "Working with Parameters."

➤ Attachments tab. Enables you to associate the flow with a file, a URL, a 
screenshot, system information, or the contents of the clipboard. For 
more information on working with attachments, see the HP Application 
Lifecycle Management User Guide.

➤ Req Coverage tab. Enables you to associate the flow with requirements. 
You create requirements coverage for a flow in the same way as you would 
for a test. For more information, see the HP Application Lifecycle 
Management User Guide.
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➤ Linked Defects tab. Enables you to link the flow with existing defects, or 
to create a new defect and link it to the flow. For more information on 
defect linkage, see the HP Application Lifecycle Management User Guide.

➤ Dependencies tab. Enables you to view the dependency relationships that 
exist between entities such as components, tests, flows, test resources, and 
application areas. For more information on entity dependencies, see the 
HP Application Lifecycle Management User Guide.

➤ Business Models Linkage. Lists the business process model entities that 
are tested by the selected test or flow. For more details, see the 
HP Application Lifecycle Management User Guide.

➤ History tab. Enables you to view changes made to the item selected in the 
Test Plan tree, as well as its version history. For details, see the 
HP Application Lifecycle Management User Guide.

Understanding the Test Script Tab for Flows

Most of the functionality available in the Test Script tab for flows is the same 
as that available for business process tests. For more information on this 
functionality, see "Test Script Tab" on page 196.

When working with flows, the Test Script tab enables you to build the 
structure of a flow by:

➤ Adding one or more business components to the flow.

➤ Generating requests for additional business components that you require 
for your flow.

You can also use the tab to:

➤ Define flow parameters and their default values. 

➤ Add run conditions to the flow.

➤ Validate the flow. 

➤ Run the flow in Debug mode.

➤ View the snapshots attached to business components in the flow.

➤ View the manual steps of each business component in the flow.
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In addition to the standard functionality available for business process tests, 
the Test Script tab for flows includes the following toolbar buttons:

➤ Add Run Condition. Enables you to add run conditions to your flow. For 
more information, see "Adding Run Conditions" on page 371.

➤ Remove Run Condition. Enables you to remove an existing run condition 
from your flow. For more information, see "Managing Run Conditions" 
on page 374.

Building a Flow Structure

A flow consists of a sequence of one or more business components. You 
build the structure of a flow by selecting the business components from the 
Component Tree and adding them to the flow.

To build a flow:

 1 In the Test Plan Tree, select the flow to which you want to add 
components and click the Test Script tab. The Test Script tab displays the 
components currently in the flow.

 2 Click the Select Components button. The Component Tree opens in the 
right pane. 
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 3 In the Component Tree, expand the folder containing the business 
component that you want to add to the flow. 

Tips:

➤ You can search for a component by clicking the Find button in the 
search box located in the component tree pane toolbar. 

➤ In addition to adding existing components to your flow from the 
component tree, you can add component requests. A component 
request acts as a signal to add a new business component to the 
Business Components module. You add component requests to a flow 
as you would for a business process test. For more information on 
component requests, see "Handling Component Requests" on 
page 110.

 4 In the component tree, drag the component into the Test Script pane. 
Alternatively, select the component that you want to add to the flow and 
click the Quick Add button. You can also click the down arrow and choose 
whether to open the Promote Parameters dialog box. This dialog box 
enables you to choose whether to promote component or flow 
parameters to the next level. In the Promote Parameters dialog box, select 
the parameters you want to promote. For more information about 
promoting parameters, see "Promoting Parameters and Viewing Their 
Status" on page 282.

 5 Use the Move Component Up and Move Component Down buttons to 
arrange the components in the flow in the correct order. Alternatively, 
click the gray sidebar to the left of a component to highlight the 
component row and drag the component to the correct position.

 6 You can add flow parameters and run conditions to increase the flexibility 
of your flow. For information on flow parameters, see Chapter 9, 
"Working with Parameters." For information on run conditions, see 
Chapter 13, "Defining Run Conditions."
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Managing Flows

A business process test can comprise business components and/or flows, or a 
combination of business components and flows. 

You can cut, copy, paste, rename, delete, and validate flows. You perform 
these actions for flows in the same way as you would for business process 
tests. 

Note: In a version-controlled project, you can copy and paste any checked 
in flow, as well as any flow that is checked out by another user - the copied 
flow will contain the last checked-in data. However, you cannot copy and 
paste a flow that is currently checked out by you. You must check-in the 
flow before copying and pasting it.

You can send e-mail about a flow to another user. This enables you to 
inform other personnel about the status of new and existing flows, and the 
components they contain.

For more information on performing these actions, see Chapter 7, 
"Managing Business Process Tests."

For more information on adding flows, see "Adding Flows to Business 
Process Tests" on page 261.

Adding Flows to Business Process Tests
You add flows to business process tests in the same way as you add 
components, only instead of using the Components tab in the Components 
and Flows pane, you use the Flows tab. For more information on adding 
flows and business components to business process tests, see "Adding 
Components and Flows to a Business Process Test" on page 216.

After you add flows to a test, you can manage the flows and define flow 
iterations in the same way as you would for business components within a 
test. For more information on managing business components in a business 
process test and defining iterations, see Chapter 7, "Managing Business 
Process Tests."
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9
Working with Parameters

You can affect the behavior and results of a business process test by using 
parameters to define the values that components and flows receive and 
return. 

This chapter describes how to work with parameters in Business Process 
Testing at the component, flow, and test levels.

Product Feature Movie: To view a movie that demonstrates how to handle 
Business Process Testing parameters, select Help > Product Feature Movies in 
the ALM main window and click HP Business Process Testing – Parameters 
and Data Usage.

This chapter includes:

➤ Parameter Overview on page 264

➤ Parameter Promotion on page 269

➤ Working with Parameters—A Workflow on page 271

➤ Defining Parameters and Setting Default Values on page 273

➤ Promoting Parameters and Viewing Their Status on page 282

➤ Managing Parameters on page 284

➤ Dialog Boxes and Tabs for Defining Parameters on page 291



Chapter 9 • Working with Parameters

264

Parameter Overview

You can expand the scope of business process tests, flows, and components 
by defining the parameters that a component or flow can receive or return, 
and then replacing fixed values with these parameters. This process, known 
as parameterization, enables you to perform the same operations on the 
application you are testing with multiple sets of data.

Note: 

➤ You can also define input and output parameters for a business 
component in QuickTest. For more information, see the HP QuickTest 
Professional for Business Process Testing User Guide.

➤ Defining iterations enables you to automatically run business 
components, flows, and tests multiple times, each time using different 
input parameter values. For details, see Chapter 11, "Working with 
Iterations."

➤ You can run business process tests for different use-cases of the 
application you are testing. Each use-case of a test is represented by a test 
configuration. You can associate different sets of data for each test 
configuration and its iterations. For conceptual details, see "Test 
Configurations Overview" on page 350.

This section includes:

➤ "Parameter Categories"

➤ "Example: Linking Input and Output Component Parameters"

➤ "Example: Using Flow Parameters"
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Parameter Categories
Below is an explanation of the parameter categories for business process 
testing. 

Parameter 
Categories

Parameter and Description

Input / Output

Input and output 
parameters can be 
linked to make 
data available 
between 
components or 
flows within the 
same business 
process test.

For an example, 
see "Example: 
Linking Input 
and Output 
Component 
Parameters" on 
page 267.

Input parameters enable you to define data used by a 
component or flow that is provided from an external source. 
When creating components, tests, and flows, you define 
how the values are supplied for input parameters. 

An input parameter can receive:

➤ A predefined default value, if no other value is supplied by 
the test or flow.

➤ An output parameter value returned by a component or 
flow earlier in the flow or test.

➤ A parameter value that is supplied at the test or flow level, 
when the test or flow is run.

Output parameters allow data values retrieved from a 
component step or flow (the source) to be passed as input 
parameters to a subsequent component or flow (the target) 
in the test run.

Note: You cannot set a default value for an output 
parameter.
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Component, 
Flow, and Test

You can use 
parameters at the 
component level, 
the flow level, 
and at the test 
level. Parameters 
can be promoted 
from one level to 
the next.

For an example, 
see "Example: 
Parameter 
Promotion" on 
page 270.

Component parameters are parameters defined within a 
component. Component parameters can be input or output 
parameters. 

These parameters are available to:

➤ All subsequent steps in the same component.

➤ Subsequent components in a flow or a test, provided that:

➤ The component parameter is defined as an output 
parameter in the current test or flow, and as an input 
parameter in the subsequent component in the current 
test or flow. 

➤ The output parameter in the current test or flow is 
linked to the input parameter of the subsequent 
component in the current test or flow. 

Flow parameters are parameters defined within a flow. These 
parameters are available to all components in the flow. Like 
component parameters, flow parameters can be input or 
output parameters. For an example, see "Example: Using 
Flow Parameters" on page 268.

Test parameters are parameters defined within a business 
process test. These parameters are available to all 
components and flows in the test.

Local

Local parameter 
values are not 
available outside 
of the component 
in which they are 
defined.

Local parameter values are defined within a business 
component and can be accessed by that component only. It 
is intended for use in a single step or between component 
steps, for example, as an output parameter for one step and 
an input parameter for a later step. 

This type of parameter is generally used when working with 
automated QuickTest components in keyword view. For 
more information, see "Parameterizing in the Keyword View" 
on page 164.

Parameter 
Categories

Parameter and Description
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Example: Linking Input and Output Component 
Parameters
Suppose you create three components corresponding to different stages in 
processing a customer loan request:

➤ CreateLoan. Receives a loan request and generates a unique loan ID for 
the request.

➤ SearchLoan. Searches the existing loans to verify if the loan exists.

➤ ApproveLoan. Approves the loan request.

In this example, a business process test tests the entire loan processing 
workflow from receiving the request through approving the request. An 
output parameter called LoanID is created by the component CreateLoan. 
This output parameter stores the value of the loan ID generated when the 
loan is requested. You could then use this value as an input parameter for 
subsequent components or flows in the business process test, such as 
SearchLoan and ApproveLoan.
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Example: Using Flow Parameters
Continuing the "Example: Linking Input and Output Component 
Parameters" on page 267, the business process test contains the loan 
processing workflow, but should also contain components for logging in 
and out of the banking application. The login and logout processes are 
typically done once at the beginning of loan processing and once at the end 
of loan processing, respectfully. The loan processing workflow can occur 
many times within one session. The following diagram shows how adding a 
flow can group related business processes together for iteration purposes.
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Because three components (CreateLoan, VerifyLoan, and ApproveLoan) 
need access to the LoanID parameter value (and perhaps more components 
will need access as well), you may want to consider creating the LoanID 
parameter as a flow parameter from the beginning. Any component in the 
flow would then have access to the loan ID without needing to link input 
and output parameters.

The Login and Logout components do not need access to the loan ID. 

Tips for Working with Flow Parameters

➤ When designing business process tests using top-down design, you can 
create flow input parameters as needed. However, when implementing 
the design, input flow parameters must be assigned the value of a 
component input parameter in the flow. Otherwise, they have no 
relevance in the business process test. 

➤ When you promote a flow output parameter from a specific component 
output parameter, the flow output parameter is automatically named to 
match the component and flow parameter naming convention. If 
required, you can change the flow output parameter name to suit your 
needs. For more information, see "Parameter Promotion" below.

Parameter Promotion

Promoting parameters enables the components in other flows (and 
components and flows in other tests) to access a parameter value. 
Promotion widens the scope of a parameter so that more entities can use its 
value when a business process test runs. 

You can promote component parameters to the flow or test level at the same 
time as you add a component to a flow or test. Similarly, flow parameters 
can be promoted to the test level at the same time as you add a flow to a 
test. 

For task details, see "Promoting Parameters and Viewing Their Status" on 
page 282.
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For user interface details, see "The Promote Parameters Dialog Box" on 
page 310.

This section includes:

➤ "Example: Parameter Promotion"

Example: Parameter Promotion
Let’s take a closer look at the "Example: Using Flow Parameters" on page 268. 
The three components, CreateLoan, VerifyLoan, and ApproveLoan, process 
a customer loan request using a parameter called LoanID. The loan ID is 
stored as a flow parameter and is available to the three components in the 
flow.

However, the business process needs other flows in the business process test, 
such as CancelLoans, to access the loan ID as well. 
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For LoanID to be accessible to the other flows, promote the LoanID 
parameter to the flow level for each flow, and then promote the LoanID 
parameter to the test level. A new test level parameter called LoanID is 
created that is accessible to every component and flow in the business 
process test.

For task information, see "Promoting Parameters and Viewing Their Status" 
on page 282.

Working with Parameters—A Workflow

This workflow provides general information for how to work with 
parameters, iterations, and configurations in ALM.

 1 Design parameter usage

Consider the following before working with parameters: 

➤ Determine which parameters are dependant on other parameters so 
that you can link them. For conceptual details, see "Parameter Linkage 
Overview" on page 315. 

➤ After designing the various entities in your business process test, 
determine which parameters should be available at the component, 
flow, and test levels. For conceptual details, see "Parameter Promotion" 
on page 269. 

➤ Business process tests can be iterated for different use-case scenarios by 
setting up iterations and test configurations with different values. 
Design how many times each component, flow, and business process 
test configuration should run, and with what values. For conceptual 
details, see "Iterations Overview" on page 330 and "Test Configurations 
Overview" on page 350.

 2 Define parameters and set default values

Define input and output parameters, and their default values. For task 
details, see "Defining Parameters and Setting Default Values" on page 273. 

Link output and input parameters between components. For task details, 
see "How to Link Parameters" on page 321. 
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 3 Set parameter values for each iteration and test 
configuration during a run

Define how many times each business component or flow should be 
iterated when the business process test runs, define configurations (use-
cases) for testing the application iteratively according to different 
scenarios, and set values for parameters. 

➤ For task details on iterating components, see "How to Define Iterations 
to Run with Different Values" on page 334. 

➤ For task details on iterating business process test configurations, see 
"How to Define Test Configurations to Run with Different Values" on 
page 354. 

 4 Manage parameters

To manage parameters, you can: 

➤ Delete parameters that are no longer needed. For task details, see "How 
to Delete Parameters" on page 284. 

➤ Import and save parameters. For task details, see "How to Import and 
Save Parameter Values" on page 285. 



Chapter 9 • Working with Parameters

273

Defining Parameters and Setting Default Values

You define parameters using various methods. When defining input 
parameters, you can also set default values. 

Method Purpose / Use
Available 
from

See Also

Basic Lets you define 
parameters, their 
descriptions, and, for 
input parameters, 
default values. 

Business 
Component 
/ Test Plan 
modules > 
Parameters 
tabs

For user interface 
details, see "The New 
Parameter and 
Parameter Details 
Pages" on page 297.

For task details, see 
"How to Define 
Parameters from the 
Parameters Tab" on 
page 274.

Component 
Step 
Definition

Provides the ability to 
define parameters “on 
the fly” directly when 
defining component 
steps. 

Business 
Component 
module > 
Component 
Steps tab / 
dialog box

For task details, see 
"How to Define 
Component Parameters 
in Component Steps" 
on page 276.

Creation of 
Parameters 
while 
Setting 
Values to 
Other 
Parameters

Enables you to define 
flow and test parameters 
“on the fly” while 
setting values for 
component or flow 
parameters, such as 
when the value for a 
flow parameter should 
match the value of a 
new, “as-of-yet-
undefined,” test 
parameter. Useful for 
multiple iterations.

Test Plan 
module > 
Iterations 
dialog 
boxes

For user interface 
details, see "Iterations 
Dialog Boxes and Tabs" 
on page 340.

For task details, see 
"How to Define 
Parameters from the 
Iterations Dialog Boxes" 
on page 277.
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How to Define Parameters from the Parameters Tab 
You can define parameters in the Parameters tabs. This is the basic method 
for defining parameters. 

For user interface details, see "The New Parameter and Parameter Details 
Pages" on page 297.

Generation Allows you to generate 
input flow parameters 
from business 
component parameters. 
Useful for multiple 
iterations.

Test Plan 
module > 
Iterations 
dialog box > 
Create Test 
Parameters 
button

For user interface 
details, see "The Create 
Flow/Test Parameters 
Dialog Box" on 
page 346. 

For task details, see 
"How to Generate Flow 
and Test Parameters 
from the Iterations 
Dialog Boxes" on 
page 280.

Promotion Enables you to widen 
the scope of a parameter 
so that more entities can 
use its value when a 
business process test 
runs. For example, when 
a business component 
parameter is promoted 
to the flow level and 
then to the test level, a 
parameter with the 
same name is created for 
the flow and the test. All 
other entities, whose 
parameters have also 
been promoted, access 
the highest-level value 
for the parameter.

Test Plan 
module > 
Test Script 
tab

For user interface 
details, see "The 
Promote Parameters 
Dialog Box" on 
page 310. 

For task details, see 
"Promoting Parameters 
and Viewing Their 
Status" on page 282.

Method Purpose / Use
Available 
from

See Also
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To define parameters in the Parameters tab:

 1 Access the Parameters tab: 

➤ To define parameters for a business component: In the Business 
Components module, select the relevant business component in the 
component tree.

➤ To define parameters for a flow or a business process test: In the Test 
Plan module, select the relevant flow or business process test in the 
tree.

 2 Click the Parameters tab. For business components and flows, the Input 
Parameters and Output Parameters sub-tabs are displayed. 

 3 For business components and flows: Click Input Parameters or Output 
Parameters.

Note: Test parameters can only be input parameters. 

 4 Click New Parameter. The New Parameter dialog box opens for the 
corresponding entity (component, flow, or test), as indicated in the title 
bar. 

 5 Enter a descriptive name in the Name or Parameter Name box. 

 6 Click once in the Description tab at the bottom of the dialog box, and 
enter a description for the parameter. 

 7 For input parameters, specify a default value for the parameter in the 
Default Value tab, directly in the grid, or in the Set Value page (accessed 
by clicking the arrow in the relevant cell). For details on the Set Value 
page, see "The Set Values Page" on page 301.
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Tip: You can use the default value for providing a default value in case a 
value is not supplied for the run, or you can use the default value as an 
example for the type of value that can be provided (for example, a phone 
number example could be ###-###-####).

 8 Click OK. 

 9 In the Parameters tab, click the Refresh button on the toolbar. The new 
parameter is listed in the grid.

A line for the new parameter is added in the parameter list. 

How to Define Component Parameters in Component 
Steps 
ALM enables you to create input and output component parameters directly 
in the Component Steps tab as you insert them into your component steps. 

To define component parameters as you create component steps:

 1 In the Business Components module, select a business component and 
click the Component Steps tab. 

 2 Either create a new step or modify an existing step. 
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 3 In the grid, click either in the Description or Expected Result field at the 
position at which you want to add and define a component parameter.

 4 Enter a parameter name enclosed between three sets of angle brackets 
(<<<parameter>>>). (Parameters that you insert into your steps using the 
Select Parameter feature are automatically displayed between <<< >>> 
brackets.) 

 5 Click outside of the Description or Expected Result field.

 6 Click the Save button on the toolbar. 

 7 To see the newly-defined parameter, click the Input Parameters sub-tab 
from the Parameters tab and then click the Refresh button on the toolbar. 

How to Define Parameters from the Iterations Dialog 
Boxes
You can manually define:

➤ New flow and test parameters from the Component Iterations dialog box.

➤ New test parameters from the Flow Iterations dialog box.

Tip: This method for creating parameters is convenient when you need to 
set different parameter values for each iteration of the test or flow in which 
the component (or flow) exists. 



Chapter 9 • Working with Parameters

278

Using the Set Value page from the Iterations dialog box, or by typing a value 
directly in the relevant cell, you can assign values to parameters accordingly:

Tip: You can also define flow parameters from the Group Iterations dialog 
box. You define flow parameters from the Group Iterations dialog box as 
you would from the Component Iterations dialog box. 

This section describes how to set the value of a component parameter while 
creating a newly-defined flow parameter in the process. 

To define a new flow or test parameter to use as the value for a parameter:

 1 In the Test Plan module, select the relevant flow or test in the Test Plan 
tree, and click the Test Script tab. 

 2 In the Script pane of the Test Script tab, click in the Iterations column on 
the row of the entity (flow or component) whose value you want to set.

Parameter Value to Assign

Component parameter ➤ An existing flow parameter

➤ A newly-defined flow parameter

➤ An existing test parameter

➤ A newly-defined test parameter

➤ Any other value that you specify

Flow parameter ➤ An existing test parameter

➤ A newly-defined test parameter

➤ Any other value that you specify
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The Iterations dialog box opens. 

 3 Select Single Iteration View or Multiple Iterations View. When working in 
Single Iteration View, you can switch iterations either by selecting or 
clicking the arrows. 

 4 Click the down arrow next to the cell containing the parameter whose 
value you want to set. The Set Value page opens. 

Tip: You can also type a parameter value directly into the cell in the grid. 

 5 Use one of the following methods to create the parameter:

➤ Select Fixed Values and enter a descriptive name for the parameter 
between curly brackets { }. 

Ensure that you do specify the curly brackets { }, as they instruct ALM 
to treat what you type as a parameter and not as a fixed value.

➤ Select Test Parameters. A list of existing flow and test parameters is 
displayed. Either select an existing parameter or click New Parameter 
to create a new one using the New Test Parameter dialog box. For user 
interface details on using the New Test Parameter dialog box, see "The 
New Parameter and Parameter Details Pages" on page 297. 

Click OK. The New Parameter dialog box closes.
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 6 Click OK. The Iterations dialog box closes.

How to Generate Flow and Test Parameters from the 
Iterations Dialog Boxes
While defining iterations for business components or flows, you can 
generate test parameters to use as values for component or flow parameters.

While defining iterations for business components, you can also generate 
flow parameters to use as values for component parameters.

You can generate flow/test input parameters based on existing input 
parameters for a component or flow. When the component or flow runs, its 
parameters take the values assigned to the corresponding test or flow 
parameters.

There are several criteria you can define when generating flow/test input 
parameters. For example, you can:

➤ Specify whether to use the same or unique flow/test parameters for each 
iteration

➤ Configure the naming convention for your flow/test parameters

➤ Generate flow/test parameters for all component parameters

➤ Generate test parameters for all flows

➤ Specify the cells in the Component Iterations dialog box, Flow Iterations 
dialog box, or Group Iterations dialog box for which you want to generate 
flow/test parameters

To generate test parameters automatically from an Iterations dialog box:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 Click the Test Script tab.

 3 Select the business process test that contains the relevant business 
component or flow, or click the flow that contains the relevant business 
component.
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Note: The business component or flow must already have at least one 
parameter defined.

 4 Click the Iterations link for the component or flow whose input 
parameters you want to use as a basis for generating test input parameters. 

The Iterations dialog box opens. For user interface details on the 
Iterations dialog boxes, see "Iterations Dialog Boxes and Tabs" on 
page 340.

Tip: You can also generate flow/test parameters automatically from the 
Group Iterations dialog box, based on input parameters for components 
within component groups. You generate flow input parameters from the 
Group Iterations dialog box as you would from the Component Iterations 
dialog box. For more information, see "Grouping Components and Flows" 
on page 222.

 5 Click the Create Test Parameters button on the toolbar. The Create 
Flow/Test Parameters dialog box opens. Define the criteria for creating 
and naming test parameters. For more information, see "The Create 
Flow/Test Parameters Dialog Box" on page 346. 

 6 Click OK. The Create Flow/Test Parameters dialog box closes and flow 
input parameters are generated for the flow, based on the criteria you 
selected.

 7 Click OK to close the Iterations dialog box. 
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Promoting Parameters and Viewing Their Status

You can promote component parameters to the flow or test level at the same 
time as you add a component to a flow or test. Similarly, you can promote 
flow parameters to the test level at the same time as you add a flow to a test.

You can also view the status of promoted parameters.

This section includes the following topics: 

➤ "How to Create Parameters Using Promotion" on page 282

➤ "How to View the Promotion Status for Test and Flow Parameters" on 
page 284

How to Create Parameters Using Promotion
Parameter promotion enables you to create new parameters based on 
parameters defined on the component or flow level. The new parameters are 
then accessible to other components and flows in the test. 

As you promote parameters, new parameters with the same name are 
created at the higher level.

You promote parameters to the next level when adding components or 
flows to a test, or when adding components to a flow.

To create flow or the test level parameters by promotion:

 1 In the Test Plan module, select the flow or the test for which you want to 
promote components. 

 2 In the Test Script tab, click the Select Components button. The 
Components pane and/or the Flows pane opens. 

 3 In either the Components pane or the Flows pane, select the component 
or flow that contains the parameters you want to promote.

 4 Click the down arrow on the right side of the Quick Add button in the 
pane’s toolbar and select one of the following options for adding the 
component or flow. 
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➤ To add the component or flow while explicitly setting promotion 
options, such as specifying which individual parameters are to be 
created at the next level, select Add while Setting Promote Options. 

The Promote Parameters dialog box opens. This dialog box enables you 
to choose whether to promote component or flow parameters to the 
next level. Select the parameters you want to promote. For task details, 
see "Promoting Parameters and Viewing Their Status" on page 282. For 
user interface details, see "The Promote Parameters Dialog Box" on 
page 310.

➤ To add the component or flow while automatically promoting all 
parameters, select Add And Automatically Promote All Parameters. 

➤ To add the component or flow without promoting parameters, select 
Add Without Promoting Parameters. 

➤ To add the component or flow using the last-used method for 
parameter promotion, do one of the following: 

➤ Double-click the component or the flow.

➤ Drag the component or flow to the Script pane.

➤ Click the Quick Add button in the toolbar.

➤ Click the down arrow on the right side of the Quick Add button in 
the toolbar, and select Quick Add. 

Note: The Promote Parameters dialog box opens if the Add while 
Setting Promote Options menu option was the last menu option 
chosen when adding components or flows to the Script pane.

 5 If necessary, click OK to close the Promote Parameters dialog box.
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How to View the Promotion Status for Test and Flow 
Parameters
You can view a list of test and flow parameters, and how they were originally 
defined, using the Parameters Promotion Status dialog box.

To access the Parameters Promotion Status dialog box in the Test Plan 
module:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 In the Test Plan tree, select the relevant business process test or flow, and 
click the Test Script tab.

 3 In the Script pane toolbar, click Show Test Parameters Promotion Status. 
The Parameters Promotion Status dialog box opens. For user interface 
details, see "The Parameters Promotion Status Dialog Box" on page 312.

 4 Review the information and click OK to close the Flow or Test Parameters 
Promotion Status dialog box. 

Managing Parameters

This section provides instructions for managing parameters, and includes 
the following topics: 

➤ How to Delete Parameters on page 284

➤ How to Import and Save Parameter Values on page 285

How to Delete Parameters
You can delete input and output component parameters by selecting the 
parameter in the Input Parameters or Output Parameters sub-tabs and 
clicking the Delete button in the relevant toolbar. A warning message is 
displayed.

If the component had a Ready status before a component parameter was 
deleted, a popup dialog box enables you to choose whether to modify the 
component status to Maintenance.
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Note: If a business process contains the component parameter that you are 
deleting, the test may not run successfully. 

How to Import and Save Parameter Values
The task of defining lists of component or flow parameter values for 
iterations can be facilitated by importing the values from an external file. 
You can also save a set of defined parameter values as a file, for example, to 
use with other business components or flows.

Parameter values are imported and saved in .csv (comma separated value) 
files. This is a file format in which each line is a record, and each data value 
field in the record is separated by a comma. 

The format of a typical .csv file for a flight application is shown below:

➤ The first row is reserved as a title row. It can contain any text.

➤ The second row contains the column headers, including the name of the 
source business component.

➤ The subsequent rows contain the parameter values that are used in 
iterations of the business process test or flow.

You map the parameters to the column headers in the .csv file using the 
Map Import Data dialog box. The Map Import Data dialog box opens when 
you import parameter values from a file.

You can create a .csv file manually in a text editor, save a spreadsheet file as 
a .csv file from a program such as Microsoft Excel, or save a set of already 
defined parameters in a business process test or flow as a .csv file.

Column Headers

Parameter Values

Title
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Tip: Enter a few rows in the Component Iterations or Flow Iterations dialog 
box and use the Export option to create an initial .csv file in the proper 
format. Then edit and save the .csv file in a text editor or spreadsheet 
program to enter actual data.

Importing and saving parameter values is described in the following 
sections:

➤ "The Map Imported Data Dialog Box"

➤ "How to Import Parameter Values from a File"

➤ "How to Save Parameter Values to a File"

The Map Imported Data Dialog Box

The Map Imported Data dialog box enables you to associate, or map, each 
component or flow parameter to a column header of the imported .csv file.

The values in the column corresponding to the selected header become the 
iteration values used for that component or flow parameter.
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When the Map Imported Data dialog box opens, it automatically maps any 
column headers in the .csv file to the corresponding parameter if the 
column headers are identical. If no identical column header exists, the value 
<None> is displayed for that parameter.

For more information on how to import parameter values, see "How to 
Import Parameter Values from a File" on page 287.

How to Import Parameter Values from a File

You can import parameter values for component or flow iterations from a 
.csv file. When you import a file, all the records in the file become iterations 
in the business process test or flow. 

Note: The parameter values that you import from a .csv file are the values 
that were defined when the file was last saved before the import. The values 
in the .csv file do not change dynamically according to value changes that 
may be implemented in ALM. Conversely, the parameter values in ALM do 
not change dynamically when you make changes to the .csv file.

Before importing a .csv file, ensure that it is set up in the proper format, as 
described in "How to Import and Save Parameter Values" on page 285.

To import saved component or flow parameter values:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 In the Test Plan tree, select the business process test that contains the 
relevant business component and click the Test Script tab. Make sure the 
business component has at least one input parameter. 

 3 In the Test Script pane, right-click the business component or flow for 
which you want to import component parameter values, and select 
Iterations.
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The Component Iterations, or Flow Iterations, dialog box opens. 

Note: The title and text instructions in the dialog box differ according to 
whether the dialog box is opened for a component or a flow. 

 4 Click the Import button. The Open dialog box opens.
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 5 Specify or browse to the .csv file that contains the required data and click 
Open. The Map Import Data dialog box opens.

 6 Expand the components to locate the relevant parameters for mapping.

 7 If you need to select or modify a parameter’s mapping, click in the To 
Imported cell for the relevant parameter. A down arrow is displayed.

 8 Click the down arrow and select the mapping from the list.

 9 Repeat steps 7 and 8 for each mapping you need to set.

 10 Click OK. A confirmation message is displayed.

 11 Click Yes. The values from the .csv file are imported and displayed in the 
Iterations dialog box. 

Note: If the Component Iterations or Flow Iterations dialog box already 
has values defined for one or more iterations, these values are overwritten 
by the imported values. If the Component Iterations or Flow Iterations 
dialog box has more iterations currently defined than the number of 
records in the imported file, the surplus iterations in the dialog box will 
be removed.

 12 Click OK to close the Iterations dialog box. 
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How to Save Parameter Values to a File

You can save parameter values that you have defined for a business 
component or flow to a .csv file. 

You can then apply the same values to other component or flow iterations 
by importing the saved data. Saving parameters is also a useful way to create 
an initial .csv file that you can edit in a spreadsheet program, and then 
reimport to the component or flow. 

For more information on importing parameters, see "How to Import 
Parameter Values from a File" on page 287.

Note: The values that you save to a .csv file are fixed, and do not change 
dynamically when you make changes to parameter values in ALM. 
Conversely, the parameter values in ALM do not change dynamically when 
you make changes to the .csv file. It is important therefore, to check the 
parameter values in ALM before saving them to a .csv file to ensure that they 
contain up-to-date values.

To save component or flow parameter values:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 In the Test Plan tree, select the business process test that contains the 
relevant business component or flow, and click the Test Script tab.

 3 In the Script pane, right-click the business component or flow for which 
you want to save the component parameter values, and select Iterations.

The Component Iterations, or Flow Iterations, dialog box opens. 

Note: The title and text instructions in the dialog box differs according to 
whether the dialog box is opened for a component or a flow. 
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 4 Click the Export button. The Save CSV (Comma Delimited) File dialog 
box opens.

 5 Enter a descriptive name in the File Name box and click Save. The 
component or flow parameter values are saved in a .csv file. The .csv file is 
saved in a comma delimited table format, as shown in the example below.

Each column in the table represents the list of values for a single 
parameter. The first row of the table is a title row. The second row 
contains the parameter names (column headers). Each subsequent row in 
a column represents a value for the displayed parameter during a single 
iteration of the business process test or flow.

 6 Click OK to close the Iterations dialog box.

Dialog Boxes and Tabs for Defining Parameters

This section describes the following: 

➤ "The Parameters Page" on page 292

➤ "The New Parameter and Parameter Details Pages" on page 297

➤ "The Set Values Page" on page 301

➤ "The Promote Parameters Dialog Box" on page 310

➤ "The Parameters Promotion Status Dialog Box" on page 312
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The Parameters Page
This dialog box or tab enables you to view, select, and insert parameters for 
business components, flows, and business process tests. 

The Parameters tab for the Business Components module is shown below. 

To access Use one of the following:

➤ In the Business Components module’s component 
tree, select a component and click the Parameters tab.

➤ In the Business Components module’s component 
tree, select a component and click the Component 
Steps tab. Double-click a step and position the cursor 
in the Description or Expected Result field. Click the 
Insert Parameter button . The Parameters dialog 
box opens.

➤ In the Test Plan module’s component tree, select a 
business process test or a flow and click the 
Parameters tab.

➤ In the Test Plan module’s component tree, select a 
business process test or a flow and click the Test Script 
tab. Click the Parameters tab at the bottom of the 
window.
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Important 
information

➤ You can insert component parameters into your steps 
in the Component Steps tab in the Business 
Components module. After you select a parameter, the 
parameter is inserted at the cursor location in the 
component step, using the syntax <<<parameter 
name>>>. 

➤ Parameter values are stored, compared, and processed 
as characters strings (even if values are specified as 
numeric or date values). 

➤ When selecting the Parameters tab from the Test 
Script tab in the Test Plan module, the parameters can 
be viewed only. You cannot add, modify, or delete 
parameters in this tab.

➤ Notes for users of QuickTest:

Parameters for keyword-driven components can be 
viewed and modified in the Business Component 
Settings dialog box. In addition, you can insert Data 
Table parameters and output values to business 
components, but you can store the values only in the 
first row of the Data Table. Component iterations are 
defined for the business process test in ALM and are 
not affected by the Data Table. 

Relevant tasks "How to Define Parameters from the Parameters Tab" on 
page 274

See also "Parameter Overview" on page 264
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

New Parameter. Opens the New Component Parameter 
dialog box, enabling you to define a new component 
parameter. For more details, see "The New Parameter and 
Parameter Details Pages" on page 297.

Note: This option is not available when selecting the 
Parameters tab from the Test Script tab in the Test Plan 
module. 

Delete. Deletes the currently selected parameter. If you 
delete a parameter that is included in a design step, the 
parameter in the design step is replaced by regular text, 
using the syntax: <parameter name>.

Note: This option is not available:

➤ When selecting the Parameters tab from the Test 
Script tab in the Test Plan module.

➤ From the Parameters dialog box.

Refresh. Refreshes the component parameters so that 
they display the most up-to-date information.

Note: This option is not available:

➤ When selecting the Parameters tab from the Test 
Script tab in the Test Plan module.

➤ From the Parameters dialog box.

Set Filter. Enables you to filter and sort the component 
parameters in the grid. Any currently applied filters or 
sorting orders are displayed below the toolbar. For details, 
see the HP Application Lifecycle Management User Guide. 

Note: This option is not available when selecting the 
Parameters tab from the Test Script tab in the Test Plan 
module.
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Select Columns. Opens the Select Columns dialog box, 
enabling you to determine which fields are displayed and 
their order. For more details, see the HP Application 
Lifecycle Management User Guide. 

Note: This option is not available when selecting the 
Parameters tab from the Test Script tab in the Test Plan 
module.

Parameter Details. Opens the Component Parameter 
Details dialog box, displaying the details of the selected 
parameter. For more details, see "The New Parameter and 
Parameter Details Pages" on page 297.

Map Parameters. For use with configurations that access 
dynamic data. Enables you to specify sets of parameter 
values from an external Microsoft Excel file by mapping 
the parameter names in the Excel file to the parameter 
names in ALM. For task details, see "How to Map and 
Filter Data Resource Parameter Values" on page 365

Available from: Parameters tab from Test Plan module. 
This field is not available when selecting the Parameters 
tab from the Test Script tab in the Test Plan module.

Resource Preview. For use with configurations that access 
dynamic data. Enables you to preview the resource 
specified in Data Resource in the Resource Preview dialog 
box. 

Available from: Parameters tab from Test Plan module. 
This field is not available when selecting the Parameters 
tab from the Test Script tab in the Test Plan module.

Go To Resource. For use with configurations that access 
dynamic data. Opens the resource in the Test Resources 
module. 

Available from: Parameters tab from Test Plan module. 
This field is not available when selecting the Parameters 
tab from the Test Script tab in the Test Plan module.

UI Elements (A-Z) Description
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<grid filters> Displays a grid filter box under each column name, 
enabling you to define a filter condition for a column. 

Type directly into the box, or click the box to display the 
browse button, which opens the Select Filter Condition 
dialog box. For details, see the HP Application Lifecycle 
Management User Guide.

Data Resource Specifies the name of an external Microsoft Excel file that 
contains sets of parameter values for each configuration 
of the test. Used only for configurations defined to access 
dynamic data. For task information, see "How to Define 
Configurations that Access Dynamic Data" on page 359.

Available from: Parameters tab from Test Plan module. 
This field is not available when selecting the Parameters 
tab from the Test Script tab in the Test Plan module.

Default Value The default value of the input parameter. This value is 
used when the component runs if no other value is 
supplied by the business process test or flow.

Available from: Input Parameters sub-tabs for business 
components and business process tests (not flows)

Description Provides a description of the component parameter’s 
purpose, or other descriptive text.

Filter Describes the filters currently applied to the list of 
parameters. Located directly above the grid filter boxes.

Input Parameters Sub-tab listing all defined input parameters. 

Available from: Parameters tabs

UI Elements (A-Z) Description
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The New Parameter and Parameter Details Pages
The New Parameter dialog box or tab enables you to create:

➤ Input and output component parameters

➤ Input and output flow parameters

➤ Input test parameters

The Parameter Details dialog box enables you to view the details for 
parameters. 

Name A descriptive name for the parameter.

➤ Parameter names must begin with a letter and cannot 
include spaces or any of the following characters: 
! @ # $ % ^ & * ( ) + = \ { } | ; ' : " , . / < > ? ~ ` [ ] – ~
Any invalid character is automatically replaced by an 
underscore (_).

➤ Parameter names must be unique within a 
component, flow, or test.

➤ The parameter name must begin with a letter. If the 
first character of the component name is not a letter, a 
prefix, such as comp_, is added.

Output Parameters Sub-tab listing all defined output parameters. 

Available from: Parameters tabs

Used When checked, this user interface element means the 
component parameter is included in a step.

Available from: Parameters tab for business components

UI Elements (A-Z) Description
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Below is an example of the New Test Parameter dialog box for flow 
parameters. 

Below is an example of the Parameter details dialog box for component 
parameters. 
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ To define a new parameter, click the New Parameter 
button  from a Parameters tab.

➤ To view the details of a parameter, double-click the 
parameter from a Parameters tab or dialog box.

Important 
information

➤ Parameter values are stored, compared, and processed 
as characters strings (even if values are specified as 
numeric or date values). 

➤ Notes for users of QuickTest:

Parameters for keyword-driven components can be 
viewed and modified in the Business Component 
Settings dialog box. In addition, you can insert Data 
Table parameters and output values to business 
components, but you can store the values only in the 
first row of the Data Table. Component iterations are 
defined for the business process test in ALM and are 
not affected by the Data Table. 

Relevant tasks "How to Define Parameters from the Parameters Tab" on 
page 274

See also "Parameter Overview" on page 264

UI Elements (A-Z) Description

First Entity. Jumps to the first component in the business 
components module.

Available from: Parameter Details tabs/dialog boxes

Previous Entity. Jumps to the previous component in the 
business components module.

Available from: Parameter Details tabs/dialog boxes

Next Entity. Jumps to the next component in the 
business components module.

Available from: Parameter Details tabs/dialog boxes
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Last Entity. Jumps to the last component in the business 
components module.

Available from: Parameter Details tabs/dialog boxes

Delete. Deletes the currently selected parameter. If you 
delete a parameter that is included in a design step, the 
parameter in the design step is replaced by regular text, 
using the syntax: <parameter name>.

Available from: New Parameter dialog box

Spell Checking. Checks the spelling of the selected word 
or all the words in the parameter.

Thesaurus. Displays a synonym, antonym, or related 
word for the selected word.

Spelling Options. Configures the way ALM checks 
spelling.

Default Value tab The default value of the input parameter. This value is 
used when the component runs if no other value is 
supplied by the business process test or flow. The default 
value can be entered in the grid directly, in the Set Value 
page, or in the tab at the bottom of the window.

For details on specifying default values for parameters, 
see "The Set Values Page" on page 301. 

Default values are saved and compared as strings, but can 
be specified according to different value types. 

Available from: Input Parameters sub-tabs

Description tab A description of the component parameter’s purpose, or 
other descriptive text. The description can be entered 
either in the grid or in the tab at the bottom of the 
window.

Details tab Enables you to modify details for the parameter.

UI Elements (A-Z) Description
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The Set Values Page
This page enables you to set default and actual values for parameters at the 
component, flow, and test levels. This page appears in different formats (as a 
pane or a dialog box) with different options depending on the context in 
which it was opened. 

Set Values Pane for Fixed Date Values

The following shows a Set Values pane for setting a default parameter value 
with the Set Date button selected. 

Name A descriptive name for the parameter.

➤ Parameter names must begin with a letter and cannot 
include spaces or any of the following characters: 
! @ # $ % ^ & * ( ) + = \ { } | ; ' : " , . / < > ? ~ ` [ ] – ~
Any invalid character is automatically replaced by an 
underscore (_).

➤ Parameter names must be unique within a 
component, flow, or test.

➤ The parameter name must begin with a letter. If the 
first character of the component name is not a letter, a 
prefix, such as comp_, is added.

Order The position of the parameter in the set of parameters. 

Available for: Test and flow parameters 

UI Elements (A-Z) Description
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Set Values Pane for Fixed Dynamic Date Values

The following shows a Set Values pane for setting a default parameter value 
with the Set Dynamic Date button selected. 

Set Values Pane for Fixed Values for Iterations

The following shows a Set Values dialog box for setting an actual parameter 
value for an iteration. This dialog box is accessible from the grid of the 
Component Iterations dialog box or the Flow Iterations dialog box. This 
shows how the dialog box appears when the Fixed Value button is selected. 
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Set Values Pane for Assigning a Test Parameter Value to 
Another Parameter

The following shows a Set Values dialog box for setting an actual parameter 
value for an iteration. This dialog box is accessible from the grid of the 
Component Iterations dialog box or the Flow Iterations dialog box. This 
shows how the dialog box appears when the Test Parameters button is 
selected. 

 

Description Enables you to do one of the following: 

➤ Enter a fixed, encrypted, date, or dynamic date value. 

➤ Use the value of a flow or test parameter as the value for a 
component parameter.

➤ Use the value of a test parameter as the value for a flow 
parameter.
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To Access Click the field or cell for the parameter’s value or default 
value in one of the following dialog boxes or tabs. Then, if 
one exists, click the drop-down button on the right side of 
the cell or field.

➤ Parameters tab (in the Business Components and Test Plan 
modules)

➤ Parameters dialog box (when inserting a parameter into a 
component step)

➤ New Component Parameter dialog box

➤ New Test Parameter dialog box (for flows and tests)

➤ Component and Flow Iterations dialog boxes

➤ Test Iterations tab in the Execution Settings sidebar entry 
of the Test Instance Details dialog box

➤ Data sub-tab for static configurations in the Test 
Configurations tab for a test in the Test Plan module

Important 
Information

➤ The structure and fields of the page change depending on:

➤ The location from which you opened the page

➤ The values you select for fields in this page

➤ All parameter values are internally stored as strings, 
regardless of how the parameter values are specified. For 
example, you can set a value as a date, using a calendar. 
But when the value is stored and compared to other 
values, it is compared as a string.

➤ String. One or more characters. When you enter a 
parameter value as a string, numeric, or boolean value, 
the value is treated in the same way as any other 
character. For example, “1” and “1.0” are treated as 
different strings. 

➤ Encrypted. An encoded string. The characters you enter 
are encrypted and displayed as asterisks.

➤ Date. Date values, which can be specified as fixed dates 
or dynamic dates (dates relative to another date, such as 
the current date).

➤ Values can also be entered by typing a string value directly 
in the relevant cell in the grid.

Relevant Tasks "Defining Parameters and Setting Default Values" on page 273



Chapter 9 • Working with Parameters

305

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

 

See Also ➤ "Setting Dynamic Dates" on page 307

➤ "Considerations for Setting Dynamic Dates" on page 308

➤ "Manually Setting Values for Dynamic Date Parameter 
Values" on page 309

UI Elements (A-Z) Description

<calendar area> Enables you to select a specific date in the calendar. 

➤ Click the right or left arrow to scroll through the 
calendar. 

➤ Click a date to select it. 

➤ Select Encrypted to encrypt the date—optional. 

➤ Click Cancel to close the calendar without selecting a 
date. 

You can also enter date values manually in <text area>.

Available when: Set Date is selected, and if it appears, 
Fixed Value is selected. 

<dynamic date area> Enables you to provide a time relative to the current 
date (such as Today, WeekAgo). For task details, see 
"Setting Dynamic Dates" on page 307.

Available when: Set Dynamic Date is selected, and if it 
appears, Fixed Value is selected.

<promotion 
information>

Enables you to see promotion information for the 
selected parameter. 

Available from: The Component and Flow Iterations 
dialog boxes (Test Plan module) and the Test Iterations 
tab (Test Lab module) when Test Parameters is selected. 

<text area> Displays the current value for the parameter, and 
enables you to enter and modify the value.
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Encrypted checkbox Encrypts the fixed value (including dates).

Specify the fixed value and then check Encrypted. 

Once a value is encrypted, it can only be modified in 
the Set Value page, and not directly in the grid.

You can modify an encrypted value. It remains 
encrypted.

Available when: Entering fixed values, and if it appears, 
Fixed Value is selected.

Fixed Value radio 
button

Displays areas, fields, and buttons that enable you to 
enter a fixed value for the parameter. 

Note: The value can be XML code, but use an external 
tool to validate the XML.

Available from: Flow and Component Iteration dialog 
boxes (Test Plan module) and the Test Iterations tab 
(Test Lab module).

Set Date button Displays <calendar area>, enabling you to select a fixed 
date value using a calendar. 

UI Elements (A-Z) Description
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Setting Dynamic Dates

A dynamic date is a date relative to the current date (today, yesterday, a year 
from today). You can add or subtract an offset time period to the relative 
date that you specify (such as 3 months before one year ago).

For example, to specify a date 10 days before the current date, the dynamic 
date could be: WeekAgo - 3 days

To set a dynamic date: 

 1 Select a relative date from the first list box (for example, Tomorrow or 
MonthAgo).

 2 Select + or - from the next list.

 3 Enter the number in the edit box by which you want to adjust the relative 
date.

Set Dynamic Date 
button

Displays <dynamic date area>, enabling you to select a 
date that is relative to a fixed date. 

Test Parameters radio 
button

Displays the Parameters dialog box, which enables you 
to select (or create) a flow or test parameter whose value 
should be used as the value for the selected parameter. 
You can set the value of a component parameter to the 
value of a flow or test parameter. Similarly, you can set 
the value of a flow parameter to the value of a test 
parameter. 

For user interface details, see "The Parameters Page" on 
page 292.

The name of the parameter is entered as a value in the 
grid, surrounded by curly brackets { } . The curly 
brackets instruct ALM to treat the parameter as a 
parameter, and not as a fixed value.

Available from: Flow and Component Iteration dialog 
boxes (Test Plan module) and the Test Iterations tab 
(Test Lab module), when a component or a flow is 
included in a test.

UI Elements (A-Z) Description
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 4 Select a time period from the list that you want to use to adjust the 
relative date.

 5 Click Cancel to close without selecting a date. 

Considerations for Setting Dynamic Dates

Consider the following points when setting dynamic dates: 

➤ You can also enter relative date values manually in <text area> or other 
relevant value cells or fields. For details, see "Manually Setting Values for 
Dynamic Date Parameter Values" on page 309.

➤ When you run a test or flow either automatically or manually, dynamic 
dates are converted to the actual dates they represent.

➤ When a test or flow run ends, the parameters displayed in Last Run Result 
show the date used in the run and not the dynamic date value.

➤ When creating a run condition on a parameter that contains a dynamic 
date value, define the run condition as a static date (for example, 
12/10/2011), which is compared to the actual date used in the run. 

➤ The dates use the date on the server (not the client).

➤ For the maximum values that can be added or subtracted to time periods, 
see "Considerations" under "Manually Setting Values for Dynamic Date 
Parameter Values" on page 309.
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Manually Setting Values for Dynamic Date Parameter Values

You can also set dynamic date values by manually typing the values directly 
in the relevant field or cell, without selecting field values in the Set Value 
page’s <dynamic date area>. Dynamic date parameters must be enclosed by 
square brackets [ ]. You can provide a relative date as the dynamic date value 
of the date parameter, or you can adjust the date string by an offset value. 

The following are the valid relative dates you can enter manually:

[Today], [Yesterday], [Tomorrow], [WeekAgo], [WeekFromToday], 
[MonthAgo], [MonthFromToday], [YearAgo], [YearFromToday].

The following values can be entered manually to customize a date string by 
adding or subtracting a time period to or from it:

Considerations

➤ Date strings are not case-sensitive. For example, both [WeekAgo] and 
[Weekago] are valid values. 

➤Time periods used to modify date strings are not case-sensitive. For 
example, both [YearFromToday + 5 Months] and [YearFromToday + 5 
months] are valid.

➤Spaces are not required in dynamic date values. For example, both 
[MonthFromToday + 3 w] and [MonthFromToday+3w] are valid.

Value Represents Usage

Day/Days/D Time period in 
days

[Tomorrow + 1 day], [Today + 3 days], 
[Yesterday - 5 d]

Week/Weeks/W Time period in 
weeks

[Tomorrow - 1 week], [Today + 2 weeks], 
[MonthFromToday + 3 w]

Month/Months/M Time period in 
months

[YearAgo - 1 month], [YearFromToday + 
5 months], [Today + 3 m]

Year/Years/Y Time period in 
years

[Today - 1 year], [Tomorrow + 2 years], 
[WeekFromToday + 2 y]
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➤The following maximum values apply to the time periods used to modify 
date strings:

For example, [today + 5000 years] is valid. [today + 5001 years] is not 
valid.

The Promote Parameters Dialog Box
This dialog box enables you to promote parameters to the next level. 

The contents of the dialog box differs for components and flows.

 

Time Period Maximum Value

Years 5000

Months 60,000

Weeks 240,000

Days 1,680,000
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User interface elements are described below:

 

To Access In the Test Plan module, display the Components 
and/or Flows panes to the right of the Test Script tab 
by clicking the Select Components button. Then, 
select a component or flow that contains parameters 
in the tree and click the right arrow next to the Quick 
Add button in the toolbar. Select Add while 
Setting Promote Options.

Important Information ➤ The content and text of the Promote Parameters 
dialog box depends on whether you are adding 
components to a flow or test, or flows to a test. 

➤ Clicking Cancel or pressing the ESC key closes the 
dialog box but still adds the component or flow, 
without promoting any parameters.

See Also "Parameter Overview" on page 264

UI Elements (A-Z) Description

<New indicator column> If the parameter is first being created as it is being 
promoted, New is displayed in this column.

<Promote All checkbox> Promotes all parameters when you add the 
component to a test or flow, or the flow to a test. 
The check boxes for the individual parameters 
below this checkbox are disabled.

<Promote checkboxes> Enables you to select the parameters that are 
promoted when you add the component to a test 
or flow, or the flow to a test.

Cancel Closes the dialog box but still adds the component 
or flow, without promoting any parameters. 

Component Parameter 
Name 

Displays the parameters of the component or flow.

Parameter Source Displays the source for the parameter (that is, in 
which component or flow the parameter was 
originally defined). 
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The Parameters Promotion Status Dialog Box
The Parameters Promotion Status dialog box displays flow and test 
parameters and how they were defined or promoted. 

➤ Test Parameters Promotion Status dialog box: Lists the business 
component and flow parameters available in the business process test. 

➤ Flow Parameters Promotion Status dialog box: Lists the business 
component parameters available in the flow.

The information provided in these dialog boxes include:

➤ Component input parameters, flow input parameters, and flow output 
parameters that have been promoted to the flow or test level.

➤ Flow and test parameters defined manually in the Test Plan module, with 
an indication that these parameters were not promoted. 

➤ The names of components and flows from which flow and test 
parameters were promoted.

Below is an example of the Flow Parameters Promotion Status dialog box for 
output parameters. 

Parameter Type Displays the type of parameter, Input or Output. 

Test/Flow Parameter Name Displays the names assigned to the promoted 
parameters in the current business process test or 
flow.

UI Elements (A-Z) Description
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Below is an example of the Test Parameters Promotion Status dialog box. 

Description Enables you to:

➤ View parameters available from the business process test or 
flow. 

➤ View how the parameters became available to the business 
process test or flow. 

To Access In the Test Plan module, select a business process test or flow. 
Click Show Test Parameters Promotion Status  in the Test 
Script toolbar. 

Important 
Information

The title bar, structure and fields of the dialog box change 
depending on the object that was selected in the Test Plan 
Module: flow or business process test.

Relevant Tasks "How to View the Promotion Status for Test and Flow 
Parameters" on page 284

See Also "How to Create Parameters Using Promotion" on page 282
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User interface elements are described below:

UI Elements (A-Z) Description

Component Name Name of the component from which the output 
parameter was promoted. 

If the flow parameter was created manually (that is, not 
promoted from a business component), this value 
appears as N/A (not applicable). 

Available from: The Output Parameters tab of the Flow 
Parameters Promotion Status dialog box

Component Output 
Parameter Name

The name of the corresponding output parameter as 
defined in the business component.

If the flow parameter was created manually (that is, not 
promoted from a business component), this value 
appears as N/A (not applicable). 

Available from: The Output Parameters tab of the Flow 
Parameters Promotion Status dialog box

Input Parameters Displays the input parameters defined for either the flow 
or the business process test. 

Output Parameters Displays the output parameters defined for the flow. 

Available from: The Flow Parameters Promotion Status 
dialog box

Test / Flow 
Parameter Name

Name of the parameter defined for the business process 
test or flow. 

Used By Components Name of the component or flow from which the input 
parameter was promoted. 

If the parameter was created manually (that is, not 
promoted), this value appears as N/A (not applicable). 

Available from: The Input Parameters tab of the Flow 
Parameters Promotion Status dialog box, and the Test 
Parameters Promotion Status dialog box.
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10
Linking Parameters

You can make data available between business components and flows by 
linking output parameters to input parameters. 

This chapter describes how to link parameters.

Product Feature Movie: To view a movie that demonstrates how to handle 
Business Process Testing parameters, select Help > Product Feature Movies in 
the ALM main window and click HP Business Process Testing – Parameters 
and Data Usage.

This chapter includes:

➤ Parameter Linkage Overview on page 315

➤ How to Link Parameters on page 321

➤ Dialog Boxes for Linking Parameters on page 324

Parameter Linkage Overview

Parameter linkage enables you to make data available between business 
components and flows. 

To link parameters, you pass the values of output parameters to input 
parameters of subsequent business components and flows in a test. The 
process of setting the value of an input parameter to the value of an output 
parameter is called linking output and input parameters. 
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For example, the CreateLoan business component has an output parameter 
that contains a generated loan ID. A subsequent business component, 
SearchLoan, can verify the loan if it has access to CreateLoan’s loan ID 
value. This access is provided by linking the CreateLoan’s output parameter 
to SearchLoan’s input parameter. 

The component or flow in which the output parameter is defined is the 
source. The component or flow that links to that output parameter is the 
target. In the example above, CreateLoan is the source component and 
SearchLoan is the target component.

For task details, see "How to Link Parameters" on page 321.

This overview includes the following topics: 

➤ "Linkage and Iterations" on page 316

➤ "Example: Basic Linkage" on page 319

➤ "Example: Linkage with Iterations" on page 320

Linkage and Iterations
You can configure a component or flow to run a certain number of times 
during a single run, using different data values for the component’s or flow’s 
parameters. Each time the component or flow runs is called an iteration. For 
details on iterations, see Chapter 11, "Working with Iterations."

Iterations of a source can result in multiple parameter output values. In 
these cases, the value provided by each iteration is passed as input to the 
corresponding iteration of the target. 

Linking can occur successfully only when ALM can determine the target 
iteration for each source iteration. One of the following conditions must 
exist:

➤ Condition 1. The source has one iteration and the target has one or more 
iterations (a “1–to–n” relationship).

➤ Condition 2. The source and the target have the same number of 
iterations (an “n–to–n” relationship). 
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Note: When a source or target is a member of a group, the number of 
iterations is that of the group.

If the component iterations are not represented by a “1–to–n” or “n–to–n” 
relationship, a warning message is displayed.

The following topics are discussed in this section: 

➤ "Condition 1: Example" on page 317

➤ "Condition 2: Example" on page 318

➤ "Partial Iteration Ranges" on page 318

➤ "Considerations" on page 318

Condition 1: Example

The source component has one iteration and the target component has one 
or more iterations (a “1–to–n” relationship). 

In this case, the same output value of the source component is used in each 
iteration of the target component.
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Condition 2: Example

The source component and the target component have the same number of 
iterations (an “n–to–n” relationship). 

In this case, the different output values of each of the source component’s 
iterations are used in the respective iterations of the target component.

Partial Iteration Ranges

The number of iterations in the relationship between the components can 
be the number of actual iterations in each component or group, or the 
number of iterations selected in a partial range.

In the example of Condition 2 above therefore, the three output iteration 
values of C1 could also have been used as input values in the three iteration 
runs of C2 (iterations 3, 4 and 5), if that range was selected in C2. For more 
information on partial iteration ranges, see "How to Select Iteration Ranges" 
on page 337.

Considerations

Take the following into account when working with parameter linkage and 
iterations:

➤ When you use the output of a previous component as the value for an 
input component parameter, the option applies to all component 
iterations for that input parameter. 
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➤ When iterations of a source component in a business process test result in 
multiple parameter output values, the value that is provided by a given 
iteration run is passed as input to the corresponding iteration of the target 
component.

➤ Moving a business component, group, or flow can cause a parameter 
reference conflict, for example, where a target component is moved to a 
position preceding the source component. If the resulting warning 
message is ignored, the conflicting link to the source parameter is deleted. 
This causes the iteration to fail, and the link must be reinstated in the 
target Iterations dialog box if necessary.

➤ In cases where there is an incompatible number of iterations between 
input and output component parameters, the parameter name in the 
column header is displayed in red text in the Iterations dialog box. 

➤ Iteration errors cause a business process test or flow that contains the 
relevant components to fail. These errors are indicated in the Test Script 
tab in the Test Plan module, and reported when a flow or test is validated. 
For more information, see "Validating Business Process Tests and Flows" 
on page 234.

Example: Basic Linkage
Three components exist corresponding to different stages in processing a 
customer loan:

➤ CreateLoan. Receives a loan request and generates a unique loan ID 
number for the loan.

➤ SearchLoan. Searches existing loan requests by ID number to verify the 
loan.

➤ ApproveLoan. Approves the loan once verified.

To define a business process test that tests the entire loan request workflow 
from receiving the request to approving it, define an output parameter for 
the component CreateLoan called LoanID, which stores the value of the loan 
ID number generated when the loan is created. You can then use this value 
as an input parameter for subsequent components or flows in the business 
process test, such as SearchLoan and ApproveLoan.
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Example: Linkage with Iterations
In the example below, the source component CreateLoan has an “n–to–n” 
(“3 to 3”) relationship with the target component SearchLoan. For each 
iteration of component input parameter LoanID in SearchLoan, there is a 
corresponding iteration of component output parameter LoanID from 
CreateLoan. 
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Conversely, the source component Login has a “1–to–n” (“1–to–3”) 
relationship with the target component ApproveLoan. Each iteration of 
component input parameter LoanOfficer in the ApproveLoan component 
uses the same component output parameter (Username) from the Login 
component. 

How to Link Parameters

This section describes how to link output and input parameters. 

For conceptual details, see "Parameter Linkage Overview."

For user interface details, see "Dialog Boxes for Linking Parameters."

To link output parameters to input parameters:

 1 Design linkage.

➤ Determine which parameters are generated by the application being 
tested. Create output parameters for these parameters either at the 
component level or the flow level. 

➤ Determine which input parameters are dependant on other parameters 
in other business components or flows. You will link these input 
parameters to their corresponding output parameters.
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 2 From the Test Plan module, select the relevant business process test or 
flow. 

 3 Click the Test Script tab. 

Note the I/O Parameters column. This column displays the total number 
of input and output parameters defined for each component or flow. For 
example, the SearchLoan component has three input parameters. The 
total (3 in) is a link.
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 4 Click the link in the I/O Parameters column for a component or flow 
whose input parameter you want to link to an output parameter (that is, 
the link of the target). The I/O Parameters dialog box opens. 

In the lower pane of this dialog box, you can see which input parameters 
are already linked to the output parameters. In the example above, none 
of the parameters is linked.

 5 For each component or flow input parameter to link:

 a Select the checkbox in the Link I/O column. The Select Output 
Parameter dialog box opens. 

The Select Output Parameter dialog box lists output parameters from 
each source business component or flow in the business process test 
prior to the current target component or flow.

 b Select the output parameter to link to the input parameter and click 
OK. 
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Note: If the number of iterations for the output parameter and the 
input parameter do not match, the parameter name is displayed in red.

The number of iterations are considered a match if either the number 
of output parameter iterations is equal to the number of input 
parameter iterations, or if the output parameter iterations is equal to 
one (regardless of the number of input parameter iterations). 

 6 Click OK to close the I/O Parameters dialog box. 

Dialog Boxes for Linking Parameters

The section describes: 

➤ "The I/O Parameter Dialog Box" on page 325

➤ "The Select Output Parameter Dialog Box" on page 326
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The I/O Parameter Dialog Box
The I/O Parameter dialog box enables you to link target input parameters to 
source output parameters.

The title of the dialog box differs according to the entity for which you 
opened the dialog box (component or flow). 

How to access From the Iterations dialog box for a component or a flow, 
click the link in the I/O Parameters column.

Relevant tasks "How to Link Parameters" on page 321

See also "Parameter Linkage Overview" on page 315
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User interface elements are described below:

The Select Output Parameter Dialog Box 
This dialog box enables you to select the source output parameter to link to 
a target input parameter.

UI Elements (A-Z) Description

Description Description of the parameter.

Input Parameters Target input parameters defined for the component or 
flow.

Link I/O checkbox Checkboxes for linking the target input parameters to 
source output parameters.

Linked To Target input parameters linked to the source output 
parameter.

Name Name of the parameter.

Output Parameters Source output parameters defined for the component or 
flow.

How to access From the I/O Parameters dialog box, click a checkbox in 
the Link I/O column.

Important 
information

➤ Click the row for the output parameter you want to 
select, and then click OK. 

➤ Output parameters from components or flows prior to 
the current component or flow in the test hierarchy 
are displayed.

Relevant tasks "How to Link Parameters" on page 321

See also "Parameter Linkage Overview" on page 315
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User interface elements are described below:

UI Elements (A-Z) Description

Component Name Name of the component or flow in which this source 
output parameter is defined. 

Description Description of the parameter.

Name Name of the parameter.
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11
Working with Iterations

You can affect the behavior and results of a business process test by using 
iterations. You can configure a component, group, or flow to run a specified 
number of iterations during a single run, using different values for the 
parameters. 

This chapter describes how to work with iterations in Business Process 
Testing at the component, group, and flow levels.

Product Feature Movie: To view a movie that demonstrates how to handle 
Business Process Testing parameters, select Help > Product Feature Movies in 
the ALM main window and click HP Business Process Testing – Parameters 
and Data Usage.

This chapter includes:

➤ Iterations Overview on page 330

➤ Group Iterations on page 332

➤ How to Define Iterations to Run with Different Values on page 334

➤ How to Select Iteration Ranges on page 337

➤ Dialog Boxes and Tabs for Working with Iterations on page 340



Chapter 11 • Working with Iterations

330

Iterations Overview

Defining iterations enables you to run business components, groups, flows, 
and tests multiple times, each time using different parameter values. For 
example: 

➤ Searching for different loans in a test for a banking application by 
supplying different loan IDs

➤ Approving loans with different interest rates

When you run your business component, flow, or test, one iteration is run 
for each value. For example, a test or flow with ten sets of data runs ten 
times, and a component with six sets of component parameter values runs 
six times before proceeding to the next component in the run.

When iterating a component, group, or flow, you determine how, and how 
many times, it should run. For task details on defining iterations for 
components, groups, and flows, see "How to Define Iterations to Run with 
Different Values" on page 334.

When iterating a test, you define how many times each test instance should 
run using its configurations. For task details on defining iterations for tests 
and test configurations, see "How to Define Test Configurations to Run with 
Different Values" on page 354.

Note: You can run business process tests for different use-cases of the 
application you are testing. Each use-case of a test is represented by a test 
configuration. You can associate different sets of data for each test 
configuration and its iterations. For conceptual details, see "Test 
Configurations Overview" on page 350.
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Example
Consider the following business process test for a banking application 
comprising three business components: Login, CreateLoan, and Logout:

As illustrated above: 

➤ The entire business process test is iterated three times.

➤ Different values for the test parameters BankURL, Username, and 
Password can be used for each test iteration.

➤ Within each of the three test iterations, the CreateLoan component is 
iterated twice. This means that the CreateLoan component iterates a total 
of six times.

➤ Different values for the CustomerName, CustomerPhone, 
CustomerAddress, and the Amount input parameters are used for each 
iteration of the CreateLoan component. Six different input parameters 
can be supplied in total.

➤ The CreateLoan component provides an output value for the LoanID 
parameter for each iteration (six output values provided in total).
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Group Iterations

In some cases, it may be helpful to iterate several business components 
together as a group in certain business process tests or flows.

Consider a business process test that contains four business components; 
C1, C2, C3, and C4. The test requires that the components be iterated as 
follows:

➤ Component C1 - Two iterations

➤ Component C2 - Three iterations

➤ Component C3 - Three iterations

➤ Component C4 - One iteration

Without grouping, the business process test would run each business 
component in sequence, C1 and its iterations, then C2 and its iterations, 
then C3 and its iterations, and then C4.

This is illustrated as follows: 
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Instead of running all the iterations of component C2 followed by all the 
iterations of component C3, you could group these two components 
together, enabling the business process test to run:

➤ The first iteration of C1, then the second iteration of C1, followed by

➤ the first iteration of C2, then the first iteration of C3, followed by

➤ the second iteration of C2, then the second iteration of C3, followed by

➤ the third iteration of C2, and then the third iteration of C3 followed by

➤ C4.

This is illustrated as follows:
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Component groups in the Test Script tab are identified by a group node 
listed above its member components. The group node contains the group 
icon and displays the number of iterations for the group. The group node 
can be expanded and collapsed to show or hide its member components. 

➤ The number of iterations indicates the total number of value sets defined 
for the group. 

➤ The iteration range indicates the subset of iterations currently set for use 
when the test runs.

How to Define Iterations to Run with Different Values

You can instruct a component, business process test, or flow to run multiple 
times, and use different values each time by defining iterations.

This section includes the following topics:

➤ Guidelines for Working with Iterations on page 335

➤ How to Define Iterations to Run with Different Values on page 335 

For information on defining iterations and values for test configurations, see 
"How to Define Test Configurations to Run with Different Values" on 
page 354.
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Guidelines for Working with Iterations
Take the following guidelines into account to successfully work with 
iterations: 

➤ Matching an application’s post-condition with the next iteration’s pre-
condition. For a business component to run iterations successfully, it is 
essential that the post-condition (the state of the application after the last 
step in the component runs) matches the pre-condition (the state of the 
application before the first step in the component runs). 

➤ Linking output parameters to input parameters. Iterations in a business 
process test or flow can result in multiple output parameter values. In 
these cases, each iteration passes its output value as input to the 
corresponding target component or flow. This is called parameter linkage. 
For conceptual details, see "Parameter Linkage Overview."

How to Define Iterations to Run with Different Values
You use the Iterations dialog boxes to set the parameter values that a 
component, group, or flow will use for each iteration. For user interface 
details, see "Iterations Dialog Boxes and Tabs" on page 340.

To set input parameter values for iterations:

 1 In the Test Plan module, select the relevant business process test or flow 
in the Test Plan tree, and click the Test Script tab. 

 2 In the Script pane of the Test Script tab, right-click the component, group, 
or flow for which you want to set values and select Iterations. 
(Alternatively, you can click the Iterations link of the component, group, 
or flow.)
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The Iterations dialog box for the component, group, or flow opens. 

Note: You can also set the values of input flow parameters for iterations 
from the Test Lab module. 

➤ Click Test Lab in the sidebar.

➤ Select the test set containing the flow in the test set tree.

➤ Click the Execution Grid tab.

➤ Click the link in the Iterations column for the flow.

By default, the Iterations column is not displayed in the Execution Grid 
tab. Add it using the Select Columns dialog box, if required. For 
information on how to add or arrange columns in ALM, see the 
HP Application Lifecycle Management User Guide.

 3 If you want the component, group, or flow to run only once, skip to 
step 4.
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If you want the component, group, or flow to run more than one 
iteration, click the Add Iteration button for each iteration you want to 
add. You can add a new iteration with blank values, a new iteration with 
default values, or a copy of the selected iteration. An additional column 
or row is added for each iteration.

 4 Set the value of each input parameter for each iteration. For user interface 
details, see "The Set Values Page" on page 301. 

 5 If you want the group, component, or flow to run for a specific range of 
iterations, click the Select Iterations button and select the relevant 
iterations in the Select Iterations dialog box. For more information on 
specifying which component iterations to run, see "How to Select 
Iteration Ranges" on page 337.

 6 Click OK to close the Iterations dialog box.

Note: If a component, group, or flow has input parameters that reference 
the output parameters of a different business component or flow, differences 
between the number of iterations can result in an error. The parameter name 
in the Iterations dialog box is displayed in red, indicating an iteration range 
mismatch.

How to Select Iteration Ranges

You can specify a single iteration or a range of iterations to run in a business 
process test or flow. This enables you to run and check one or more specific 
iterations without having to run all the defined iterations. In addition, you 
could use the same business process test or flow definition for different 
scenarios. Different combinations of iterations can be run for different test 
runs.
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Iteration ranges for components, flows, and test configurations that use 
static data are specified using the Select Iterations dialog box.

.

Iteration ranges for test configurations that use dynamic data are specified 
using the Data Resource Settings dialog box.

.

For information on working with test configurations, see Chapter 12, 
"Working with Test Configurations."

The following tasks are described in this section: 

➤ "To access the Select Iterations dialog box:" on page 339

➤ "To select an iteration range using the Select Iterations dialog box:" on 
page 339

➤ "To select an iteration range using the Data Resource Settings dialog box:" 
on page 339
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To access the Select Iterations dialog box:

Perform one of the following:

➤ For business components and flows: In any Iterations dialog box toolbar, 
click the Select Iterations button. The Select Iterations dialog box opens.

➤ For business process tests that use configurations that access static data:

 a In the Test Plan module, select the business process test. 

 b Click the Parameters tab.

 c Click the Data tab near the bottom of the window. 

 d In the Data tab toolbar, click the Select Iterations button. The Select 
Iterations dialog box opens.

To select an iteration range using the Select Iterations dialog box:

 1 In the Select Iterations dialog box, select the second radio button. The 
from and to spin boxes are enabled.

 2 Specify or select the start and end of the iteration range to run in the 
business process test or flow.

Tip: To run one specific iteration only, enter or select the same iteration 
number in both the from and to spin boxes.

 3 Click OK. The iterations that are not selected for inclusion in the run are 
disabled. When the component or flow runs, only the defined iterations 
run.

To select an iteration range using the Data Resource Settings dialog box:

 1 In the Test Plan module, select the business process test. 

 2 Click the Parameters tab.

 3 Click the Data tab near the bottom of the window. 
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 4 Click the Data Resource Settings button. The Data Resource Settings 
dialog box opens.

 5 Specify the rows from the data resource file that should be processed 
when the test is run. Iterations are created only for the selected rows.

➤ To process all rows that meet the specified filter condition, if one 
exists, in the data resource file, select All Rows.

➤ To indicate a subset of rows, select Rows and enter the row numbers, 
separated by commas. A range of rows can be specified with a hyphen 
(for example, 3-5 means that rows 3, 4, and 5 will be processed). 

 6 Click OK. 

Dialog Boxes and Tabs for Working with Iterations

This section describes the following topics: 

➤ "Iterations Dialog Boxes and Tabs" on page 340

➤ "The Create Flow/Test Parameters Dialog Box" on page 346

Iterations Dialog Boxes and Tabs
The following Iterations dialog boxes and tabs enable you to configure the 
input parameter values that a business component, group, test, or flow uses 
for each iteration during a test run.

➤ Component Iterations dialog box

➤ Group Iterations dialog box

➤ Flow Iterations dialog box

➤ Test Iterations tab

The title of the dialog box shown above differs according to the entity for 
which you opened the dialog box.
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Below is an example of an Iterations dialog box for a component: 

Below is an example of the Test Iterations tab for a business process test:
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How to access ➤ Component Iterations dialog box: From the Test Plan 
module, select any test or flow to which the business 
component has been added. In the Test Script tab, 
select the component and click the corresponding 
Iterations hypertext link in the Iterations column. 

➤ Group Iterations dialog box: From the Test Plan 
module, select the business process test or flow in 
which the group has been defined. In the Test Script 
tab, select the group and click the corresponding 
Iterations hypertext link in the Iterations column. 

➤ Flow Iterations dialog box: From the Test Plan module, 
select any test to which the flow has been added. In 
the Test Script tab, select the flow and click the 
corresponding Iterations hypertext link in the 
Iterations column. 

➤ Test Iterations tab: From the Test Lab module, select 
the test set that contains the test. In the Execution 
Grid tab, right-click the test instance and select Test 
Instance Details. On the sidebar, click Execution 
Settings and select the Test Iterations tab. 

Important 
information

➤ Test iterations can also be viewed in the Data tab near 
the bottom of the window after clicking the Test 
Configurations tab in the Test Plan module. For task 
details, see "How to Define Test Configurations to Run 
with Different Values" on page 354.

➤ The Add Iteration, Delete Iteration, and Select 
Iterations buttons in the Component Iteration or Flow 
Iteration dialog box are disabled if the business 
component is a member of a component group. These 
are common operations for all group members and 
can be accessed by clicking the group node to open 
the Group Iterations dialog box. For more 
information, see "Grouping Components and Flows" 
on page 222.

Relevant tasks ➤ "How to Define Iterations to Run with Different 
Values" on page 335

➤ "How to Define Test Configurations to Run with 
Different Values" on page 354
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

See also ➤ "Iterations Overview" on page 330

➤ "Group Iterations" on page 332

UI Elements (A-Z) Description

Multiple Iterations View / Single Iteration View. Enables 
you to toggle between:

➤ A view that shows all iterations in one dialog box

➤ A view that shows only one iteration at a time in the 
dialog box.

Not available from: Test Iterations tab

Previous / Next Iteration. Displays the next or previous 
iteration in the dialog box.

Not available from: Test Iterations tab

Iteration. Displays the iteration currently in focus in the 
dialog box, and enables you to select a different iteration 
on which to focus.

Not available from: Test Iterations tab

Add Iteration. Adds an iteration for the entity 
(component, group, test, or flow). 

When adding iterations in the Iteration dialog boxes, the 
following options are available:

➤ Add New Iteration. Adds a new iteration without 
setting parameter values.

➤ Copy Iteration. Adds a new iteration by copying the 
values of a selected iteration’s parameters.

➤ Create Iteration with Default Values. Adds a new 
iteration and sets the parameter values to the default 
values.

Note: This button is disabled when the component or 
flow for which you are adding an iteration is in a group.
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Remove/Delete Iteration. Deletes the selected iteration 
for the entity (component, group, test, or flow). 

For more information on adding and deleting 
component iterations, see "Guidelines for Working with 
Iterations" on page 335.

Note: This button is disabled when the component or 
flow for which you are deleting an iteration is in a group.

Select Iterations. Opens the Select Iterations dialog box, 
which enables you to select which of the defined 
iterations you want to run during the test run. You can 
specify one, all, or a range of iterations. For task details, 
see "How to Select Iteration Ranges" on page 337.

Note: This button is disabled when the component or 
flow for which you are selecting iterations is in a group.

Find. Enables you to find a parameter value, a parameter, 
or a component. For information on Find and Replace 
functionality, see the HP Application Lifecycle Management 
User Guide.

Not available from: Test Iterations tab

Import/Export. Enables you to import component 
parameter values for iterations from a .csv (comma 
separated value) file, and to save component parameter 
values to a .csv file. For more information on importing 
and exporting parameter values, see "How to Import and 
Save Parameter Values" on page 285.

<parameter 
columns>

Displays the names for each parameter in the displayed 
iteration. 

Available from: Single Iterations view and the Test 
Iterations tab

<value columns> Displays the value for each parameter in the displayed 
iteration. 

Available from: Single Iterations view and the Test 
Iterations tab

UI Elements (A-Z) Description
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<values> The value of the input parameter when the instance runs. 
The value can be entered in the grid directly or in the Set 
Value page (accessed by clicking the arrow in the relevant 
cell).

For task details on specifying default values for 
parameters, see "The Set Values Page" on page 301. 

If no value is specified, the default value for that 
parameter is used. If no default value is specified, no 
value is displayed and the entity may not run correctly.

Values are saved and compared as strings, but can be 
specified according to different value types. 

Test or flow parameters (parameters whose values are to 
be taken from the business process test or flow), are 
shown in curly brackets { }. This instructs ALM to treat 
the parameter as a parameter and not as a fixed value. 

Create Flow/Test 
Parameters

Opens the Create Flow/Test Parameters dialog box, which 
enables you to generate flow or test parameters from 
business component input parameters or flow input 
parameters. 

For user interface details, see "The Create Flow/Test 
Parameters Dialog Box" on page 346. 

For task details, see "How to Generate Flow and Test 
Parameters from the Iterations Dialog Boxes" on 
page 280.

Description area The description for the parameter and its original source 
entity (business component, test, or flow). 

Parameter descriptions are initially entered in the 
module in which they were created (the Business 
Components module or the Test Plan module), or in 
QuickTest for automated components.

UI Elements (A-Z) Description
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The Create Flow/Test Parameters Dialog Box
The Create Flow/Test Parameters dialog box defines the way generated flow 
or test parameters are created and named.

For task details, see "How to Generate Flow and Test Parameters from the 
Iterations Dialog Boxes" on page 280.

Iteration # 
columns/rows

Displays the current values for each parameter in each 
iteration. 

Available from: Multiple Iterations view and the Test 
Iterations tab

Parameter column Names of the parameters, grouped by entity (business 
component, group, test, or flow). 

Available from: Iterations dialog boxes

UI Elements (A-Z) Description
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User interface elements are described below:

Option Description

Flow/Test Parameters 
Creation Criteria

➤ Use the same flow/test parameter for each 
iteration. Clears the flow or test parameter 
values between iterations so that the same 
parameter names are used for every iteration, 
but the values are not passed from one 
iteration to the next.

➤ Use a different flow/test parameter for each 
iteration. Automatically creates a new flow or 
test parameter for each iteration. The 
parameter values are saved with each iteration 
run.

Parameter Name Include component name before flow/test 
parameter name. If checked, adds the 
component or flow name as a prefix preceding 
the generated flow/test parameter name.

Example Provides an example of the generated parameter 
name based on the selected criteria.

Create flow/test parameters 
for

➤ Empty cells only. Creates flow/test parameters 
only for cells that do not contain any value 
(default).

➤ Empty cells and cells with default values. 
Creates flow/test parameters for all cells that 
either do not contain a value or contain the 
default value defined in the component or 
flow parameter.

➤ All cells. Creates flow/test parameters for all 
cells in the Component Iterations, Group 
Iterations, or Flow Iterations dialog boxes.
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12
Working with Test Configurations

You can run business process tests for different use-cases of the application 
you are testing. A test configuration is a set of definitions that describe a 
specific use-case of a test. You can associate different sets of data for each test 
configuration.

This chapter describes how to work with test configurations in Business 
Process Testing.

This chapter includes:

➤ Test Configurations Overview on page 350

➤ How to Define Test Configurations to Run with Different Values 
on page 354

➤ How to Generate a Configuration from a Modified Instance on page 367
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Test Configurations Overview

You can run business process tests for different use-cases of the application 
you are testing. Each use-case of a test is represented by a test configuration. 
You can associate different sets of data for each test configuration and its 
iterations. 

Working with test configurations enables you to run the same test under 
different scenarios. For example, you may want to check the same test in a 
Windows environment and again in a UNIX environment. In this case, you 
can define one business process test with two test configurations. The 
parameters values for the Windows configuration would contain Windows-
specific values (for example, backslashes in a path name) while the UNIX 
configuration would contain UNIX-specific values (for example, forward 
slashes in a path name). 

When using test configurations with business process tests, you can run a 
test many times in succession with different values specified in a Microsoft 
Excel file. 

A test configuration can be associated with multiple iterations, based on the 
number of sets of data supplied for that test configuration. 

When creating a business process test, by default, a test configuration is 
created by ALM. This test configuration is created with the same name as 
the test. This test configuration can be renamed.

This section contains the following topics:

➤ Test Configurations Associated with Static Data

➤ Test Configurations Associated with Dynamic Data

➤ Configuration Example with Iterations
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Test Configurations Associated with Static Data
The basic ALM test configuration accesses static data. Static data are sets of 
values that are provided for each iteration’s parameters directly from within 
ALM. For task details on creating configurations for ALM manual tests, see 
the HP Application Lifecycle Management User Guide. 

When creating test configurations for manual and automated business 
process tests, you also create a set of static data for each use-case. However, 
for each test configuration, you can also add iterations and define different 
parameter values for each iteration. For task details on creating test 
configurations that access static data for business process tests, see "How to 
Define Configurations that Access Static Data" on page 357.

Test Configurations Associated with Dynamic Data
Business process test configurations can access dynamic data. Dynamic data 
are sets of values that are provided for each iteration’s parameters from 
outside of ALM, in an external data table uploaded in the Test Resources 
module. The external data table is a Microsoft Excel file. 

When the business process test instance runs using a configuration that 
accesses dynamic data, the test instance fetches the parameter values for 
each iteration of the configuration from the list of parameter values in the 
Microsoft Excel file. 

You can supply ALM with dynamic data resources: 

➤ At the test level. You can supply a Microsoft Excel file that contains all 
parameter values for each iteration of the configuration is specified at the 
test level. The Microsoft Excel file is uploaded as a data table in the Test 
Resources module, and associated with the business process test 
configuration in the Parameters tab of the Test Plan module. For task 
details, see "How to Define Configurations that Access Dynamic Data" on 
page 359. 
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➤ At the configuration level (overriding any test-level data resources). You 
can supply an alternate Microsoft Excel file, overriding the test-level data 
resources file that is associated with the business process test as a whole. 
The Microsoft Excel file is uploaded as a data table in the Test Resources 
module, and associated with a specific configuration of the business 
process test in the Test Configurations tab of the Test Plan module. For 
task details, see "How to Define Configurations that Access Alternate 
Dynamic Data" on page 363. 

Note: Configurations that access dynamic data are not available for use with 
ALM manual test configurations. 

Configuration Example with Iterations
Consider the following business process test and its three configurations for 
a banking application comprising three business components: Login, 
ApproveLoan, and Logout: 
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➤ The entire business process test tests the following aspects of the 
application: 

➤ Access rights are correct, based on the identity of the user. 

➤ Load is handled well, such as when a bank manager approves many 
loans using an external list of data created in Microsoft Excel.

➤ A bank manager can approve urgent, high priority loans, based on a 
different external list created in Microsoft Excel. This external list is to 
be further narrowed down to include only those loans that have 
manager authorization.

➤ To test access rights, a configuration named UserAccessData accesses 
static data, which provides different values for the test parameters 
Username and Password for three test iterations: One iteration provides 
the login information for an average loan processor, another for a bank 
manager, and the third for a system administrator for the application. 
Each of these users has different permissions and access to the 
application. The parameter values are specified within ALM.

➤ A configuration named LoanData accesses dynamic data for one hundred 
different values for the LoanID input parameters used by the 
ApproveLoan component. These values are provided in a Microsoft Excel 
test resource of the data table type. A test iteration is run for each value in 
the Microsoft Excel file, so the test instance that uses this configuration 
runs one hundred times. 

Note: Configurations can supply data values for test iterations, but not for 
component iterations. 

➤ To test urgent loans, a configuration-level data resource can be defined to 
override the test-level data resource for the business process test. This data 
resource, UrgentLoanData, only contains high priority loans that are to 
be approved. One test iteration is run for each value that matches the 
filter criteria in the alternative configuration-level Microsoft Excel file (in 
this case, urgent loans that have been authorized for approval). 
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How to Define Test Configurations to Run with Different 
Values

You can run business process tests according to different use-cases, for 
example, with a different set of data for each iteration. Each use-case is 
called a test configuration. 

Before running a test within a test set, you can specify the values for any test 
parameters defined for the test. If you do not specify values, and valid 
default values have not been specified, the test run may fail.

This section provides instructions for defining configurations for business 
process tests that access both static and dynamic data:

➤ "How to Modify Test Configurations" on page 354

➤ "How to Define Configurations that Access Static Data" on page 357

➤ "How to Define Configurations that Access Dynamic Data" on page 359

➤ "How to Define Configurations that Access Alternate Dynamic Data" on 
page 363

➤ "How to Map and Filter Data Resource Parameter Values" on page 365

How to Modify Test Configurations
When a test parameter is created, ALM creates a configuration for the test 
that accesses static data. You can modify the configuration to suit your 
needs.

To update test configurations:

 1 In the Test Plan module, select the business process test for which you 
want to modify a test configuration that accesses static data. 

 2 In the Parameters tab, create test-level parameters that represent the 
values for the first iteration of the configuration. For task details on 
creating test-level parameters, see "How to Generate Flow and Test 
Parameters from the Iterations Dialog Boxes" on page 280.
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 3 In the Test Configurations tab, a configuration is listed in the 
configuration grid with the same name as the test. You can rename the 
configuration by double-clicking the configuration name and typing in a 
new name.

 4 Click the Description tab near the bottom of the window to enter a 
description for the configuration.
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 5 Click the Data tab near the bottom of the window. 

 6 Select Static to view the details of the static data for this test 
configuration. One iteration exists for this test and the default values for 
each test parameter for this iteration are displayed. 

 a To change the values of a parameter, click in its cell. Type a value 
directly in the grid, or click the down arrow to open the Set Value 
page. For task details on setting values, see "The Set Values Page" on 
page 301.

 b To add iterations, click the Add Iteration button and update each 
iteration’s parameter values. You can also delete iterations.

 c To select the iteration ranges (either partial or all) to run in a business 
process test or flow, click the Select Iterations button.

Alternatively, click Dynamic to change the test configuration so that it 
access an external Microsoft Excel data resource file. For task details, see 
"How to Define Configurations that Access Dynamic Data" on page 359 
and "How to Define Configurations that Access Alternate Dynamic Data" 
on page 363.

 7 Run the test to confirm the test runs according to the expected 
configurations, iterations, and parameter values.
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How to Define Configurations that Access Static Data
Defining static data enables you to specify sets of parameter values for the 
test directly from within ALM. 

You can create configurations that access static data from the Test Plan 
module, and modify them from the Test Plan and Test Lab modules. 

To create a configuration from the Test Plan module:

 1 In the Test Plan module, select the business process test for which you 
want to define a test configuration that accesses static data. 

 2 Create test-level parameters. For task details on creating test-level 
parameters, see "How to Generate Flow and Test Parameters from the 
Iterations Dialog Boxes" on page 280.

 3 In the Test Configurations tab, a test configuration is listed in the 
configuration grid with the same name as the test. 

 4 Click the New Configuration button in the toolbar. The New Test 
Configuration dialog box opens. 
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 5 Enter the name and other details for the configuration, and click OK. The 
New Test Configuration dialog box closes.

 6 In the Test Plan module, click the Data tab near the bottom of the Test 
Configurations tab. 

 7 Select Static to view the details of the static data for this test 
configuration. One iteration exists for this test and the default values for 
each test parameter for this iteration are displayed. 

 8 To change the values of a parameter, click in its cell. Type a value directly 
in the grid, or click the down arrow to open the Set Value page. For task 
details on setting values, see "The Set Values Page" on page 301.

 9 To add iterations, click the Add Iteration button, and update each 
iteration’s parameter values. You can also delete iterations and select a 
range of iterations that the test should run. For task details on selecting an 
iteration range, see "How to Select Iteration Ranges" on page 337.

 10 Run the test to confirm the test runs according to the expected 
configurations, iterations, and parameter values.

To modify an existing configuration from the Test Lab module:

 1 Create test-level parameters. For task details on creating test-level 
parameters, see "How to Generate Flow and Test Parameters from the 
Iterations Dialog Boxes" on page 280.

 2 In the Test Lab module, select the test set that contains the business 
process test for which you want to define a configuration that accesses 
static data. 
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 3 Click the Execution Grid tab.

 4 Right-click the test instance and select Test Instance Details. The Test 
Instance Details dialog box opens. 

 5 Select the Execution Settings sidebar entry. 

 6 Click the Test Iterations tab.

 7 Add and delete iterations, defining values for each test parameter in each 
iteration. You can also: 

➤ Select a range of iterations that the test should run. For task details, see 
"How to Select Iteration Ranges" on page 337.

➤ Import and export data for each test parameter. For task details, see 
"How to Import and Save Parameter Values" on page 285.

 8 Click OK to close the Test Instance Details dialog box. 

How to Define Configurations that Access Dynamic Data
Defining dynamic data enables you to specify sets of parameter values for 
the test from an external Microsoft Excel file.

The same Microsoft Excel file can be used as a data resource for different 
tests.

Note: To work with dynamic data, make sure that the QuickTest Professional 
Add-in for Business Process Testing Add-in is installed on the client 
computer. The QuickTest Professional Add-in for Business Process Testing is 
installed from the HP Application Lifecycle Management Add-ins page.
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To define a configuration that accesses dynamic data:

 1 In Microsoft Excel, create a spreadsheet that contains the values for each 
test parameter.

 a Select the Sheet1 tab. 

Note: Do not define data in the other sheets. ALM ignores data entered 
in the other sheets.

 b Specify parameter names in the each cell of the first row. The 
parameter names do not have to match the parameter names defined 
in the test.

 c Specify values for each parameter under the parameter names, each on 
a different row. Each row represents an iteration.

 d Save the file. 

 2 In ALM, create a test resource and upload the Microsoft Excel file to it. For 
task details on creating test resources and test resource folders, see the 
HP Application Lifecycle Management User Guide.

 a Select the Test Resources module.

 b Either create or select a test resource folder. 

 c Click the New Resource button to create a new test resource. The New 
Resource dialog box opens. 

 d Enter Data Table as the resource type and click OK. 

 e Click the Resource Viewer tab. 

 f Click the Upload File button.

 g Navigate and select the Microsoft Excel file you created and click 
Open. 

 h Click OK when prompted that the upload completed successfully. The 
Resource Viewer lists the default Microsoft Excel sheets. The data is 
now available in ALM.
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You can double-click Sheet1 to view the data you created in the 
Resource Viewer tab.

Note: The data in the Microsoft Excel file starts with row number 2. It 
is assumed that the first row in the Microsoft Excel file contains the 
names for the data columns, which are mapped to parameter names in 
ALM.

 3 In ALM, associate the test resource with the business process test.

 a In the Test Plan module, select the business process test for which you 
are defining this test configuration.

 b Click the Parameters tab. 

 c Click the down arrow next to the Data Resource field in the toolbar.

 d Navigate to, and select, the data resource and click OK. The Microsoft 
Excel file is now the default external data file for the test. 

 4 In ALM, map the test parameter names to the resource parameter names 
in the Microsoft Excel data resource.

 a In the Parameters tab for the test, click the Map Parameters button in 
the toolbar. The Map Parameters dialog box opens, listing each test 
parameter. 
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 b For each test parameter, click in the cell for its corresponding resource 
parameter name. Type in the corresponding resource parameter name 
for each test parameter, and click OK. 

Tip: The mapping of resource parameter names to test parameter names 
facilitates reuse of the same resource file by different tests. 

 5 Create the test configuration.

 a Click the New Configuration button in the toolbar. The New Test 
Configuration dialog box opens. 

 b Enter the name and other details for the configuration, and click OK. 
The New Test Configuration dialog box closes.

 c Click the Data tab near the bottom of the Test Configurations tab. 
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 d Select Dynamic. This instructs ALM to use the Microsoft Excel test 
resource file defined for the test in the Parameters tab. 

 6 To filter the data so that the test runs only on a subset of the parameter 
values, either by row or by value, click Data Resource Settings. The Data 
Resource Settings dialog box opens. For task details, see "How to Map and 
Filter Data Resource Parameter Values" on page 365.

 7 Run the test to confirm the test runs according to the expected 
configurations, iterations, and parameter values.

How to Define Configurations that Access Alternate 
Dynamic Data
You can create configurations that process alternate dynamic data resource 
files instead of the dynamic data resource file associated with the business 
process test. 

The same file can be used as a data resource for different tests.

To override the test-level data resource with an alternate, configuration-
level data resource:

 1 In the Test Plan module, select the business process test for which you are 
defining this configuration.

 2 Click the Test Configurations tab. 

 3 Click the Data tab near the bottom of the window. 
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 4 Select Dynamic. This instructs ALM to use the Microsoft Excel test 
resource file defined for the test in the Parameters tab. We will override 
this data resource in step 5.

 5 Select Override test data resource. The Data Resource field is enabled.

 6 Navigate to, and select, the alternate data resource. Click OK. 

 7 Click Data Resource Settings to map the test parameter names to the 
resource parameter names in the Data Resource Settings dialog box. 
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 8 For each parameter listed in the Test Parameter Name column, click the 
cell in the Resource Parameter Name column and type the name of the 
corresponding resource parameter from the Microsoft Excel file. 

 9 To filter the data so the test runs only on a subset of the parameter values, 
either enter a filter condition or row numbers in the Data Resource 
Settings dialog box. For task details, see "How to Map and Filter Data 
Resource Parameter Values" on page 365.

 10 Click OK in the Data Resource Settings dialog box. 

 11 Run the test to confirm the test runs according to the expected 
configurations, iterations, and parameter values.

How to Map and Filter Data Resource Parameter Values
When working with configurations that access dynamic data, you can run a 
test on a subset of the parameter values in the data resource. This is done by 
instructing ALM to filter out certain parameter values in the Data Resource 
Settings dialog box.

Note: This dialog box is also used to map test parameter names to alternate 
data resource parameter names when overriding the default data resource 
associated with the automated business process test. For each parameter 
listed in the Test Parameter Name column, click the cell in the Resource 
Parameter Name column and type the name of the corresponding resource 
parameter from the Microsoft Excel file.
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You can filter the parameter values by specifying filter conditions and 
specific rows. Only values that match both the filter condition and the 
specified rows are processed.

To filter the data:

 1 To access the Data Resource Settings dialog box:

 a From the Test Plan module’s Test Configurations tab, select the 
dynamic configuration whose data you want to filter. 

 b Click the Data tab near the bottom of the window. 

 c Click Data Resource Settings. The Data Resource Settings dialog box 
opens. 

 2 For each parameter by which you want to filter, click its cell in the Filter 
Condition column and specify a filter according to the following 
guidelines: 

➤ Only strings can be specified. 

➤ Do not specify quotation marks or operators. 

➤ Only one value can be specified.
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 3 Specify the rows from the data resource file that should be processed 
when the test is run:

➤ To process all rows that meet the specified filter condition, if one 
exists, in the data resource file, select All Rows.

➤ To indicate a subset of rows, select Rows and enter the row numbers, 
separated by commas. A range of rows can be specified with a hyphen 
(for example, 3-5 means rows 3, 4, and 5 will be processed). 

 4 Click OK. 

How to Generate a Configuration from a Modified Instance

In Business Process Testing, you can generate a new test configuration from 
an existing static test configuration instance whose configuration properties 
have been modified to no longer match its original static configuration.

For user interface details, see the HP Application Lifecycle Management User 
Guide.

To generate a new configuration:

 1 From the Test Lab module’s Test Sets tab, right-click the static test 
configuration instance that was modified in the Execution Grid tab. 
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Note: If a test instance has not been modified, Configuration Based 
appears in the Iterations column for that instance. 

 2 Click Generate Test Configuration. 

Note: The Generate Test Configuration option is disabled if: 

➤ The test set is pinned to a baseline. You cannot generate test 
configurations for pinned test sets.

➤ Version Control: If the test is checked out by another user, wait until 
the test is checked in before generating the test configuration.

The Generate Test Configuration dialog box opens. 

 3 Enter a name for the new test configuration and click OK. 

The test instance name in the Execution Grid is renamed to reflect the 
name of the new configuration with which this instance is now 
associated. 

In the Test Plan module, a new static test configuration is added for the 
corresponding text in the Test Configurations tab. 
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13
Defining Run Conditions

This chapter describes how to define and work with run conditions for your 
flows.

This chapter includes:

➤ About Defining Run Conditions on page 369

➤ Adding Run Conditions on page 371

➤ Managing Run Conditions on page 374

➤ Running Tests with Run Conditions on page 375

About Defining Run Conditions

You can use run conditions to insert condition statements into your flows. A 
run condition checks the current value of a component parameter before 
running the component in a flow. Based on the parameter value and the run 
condition definition, HP Application Lifecycle Management (ALM) then 
determines whether to run the component, skip to the next component, or 
end the component run and set the component status to fail.

When you run business process tests containing flows with run conditions, 
the test run results display the results of run conditions in the test, and lists 
the components that did not run because a run condition was not met.

The following topics are discussed in this section: 

➤ "Guidelines for Working with Run Conditions" on page 370

➤ "Run Condition Example" on page 370
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Guidelines for Working with Run Conditions

➤ You can define only one run condition per business component.

➤ To set run conditions for a component, the component must reference at 
least one flow parameter, input component parameter, or output 
component parameter.

➤ Parameters with encrypted values cannot be chosen from the list when 
defining run conditions. We recommend that you do not use parameters 
whose default values are encrypted when defining run conditions. 

➤ In some cases, it may be preferable to define different flows, rather than 
using a large number of run conditions within a particular flow. 

➤ If you set run conditions, and later add or remove a component or change 
the component order within a flow, the parameters may no longer be 
relevant and the run condition may not work. For example, if Component 
B uses an output parameter value from Component A, and you change the 
order of the components so that Component B precedes Component A, 
then Component B cannot receive the output parameter value from 
Component A and the run fails. 

Run Condition Example
Suppose you create a test called Standard Sales Order, which contains all the 
transactions necessary to complete the Standard Sales Order business 
process. The first transaction in this business process is Create Standard 
Order. The Create Standard Order transaction contains all the steps 
necessary to begin sales processing.

You would create a flow called Create Standard Order. This flow would 
contain the collection of components that perform the operations necessary 
to complete the Create Standard Order transaction. 

In the Create Standard Order transaction, depending on the material being 
ordered, some screens may or may not open. 

For example, when ordering item number 10, with material number p-101, 
the Standard Order: Availability Control screen is displayed. When ordering 
item number 10 with material number p-103, this extra screen is not 
displayed. 
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You can include the Create Standard Order flow in your Standard Sales 
Order test and test when either material number p-101 or p-103 is entered.

In the component that enters the material number, you promote the 
parameter containing the item number and the material number, to a test 
parameter. When running the test, you can then assign that parameter a 
value of either p-101 or p-103. 

You then create a run condition for the Standard Order: Availability Control 
component. The run condition checks the status of the parameter. If the 
value in the material number cell of the table parameter is p-101, the flow 
runs the component for the Standard Order: Availability Control screen. 
Otherwise, it skips to the next component and continues.

Adding Run Conditions

When you add a run condition to a flow, the condition is displayed in the 
Run Condition column of the Script pane in the Test Script tab. 

For some additional considerations when working with run conditions, see 
"Guidelines for Working with Run Conditions" on page 370.

To add a run condition:

 1 In the Test Script tab for a flow, select the component for which you want 
to add the run condition and click the Add/Edit Run Condition button.

The Run Condition dialog box opens.

 2 Specify the criteria for the component to run. For more information, see 
"The Run Condition Dialog Box" on page 372.

 3 Click OK. The Run Condition dialog box closes and the run condition is 
added to the flow.
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The Run Condition Dialog Box
The Run Condition dialog box defines which attributes must match for the 
component to run. 

The Run Conditions dialog box contains the following sections. Unlabeled 
elements are listed between angle brackets < >.

Section Description

Run If A drop-down list of parameter types defined in that 
component. The following types are available:

➤ Input Parameter. Available only if one or more 
input parameters are defined for this component.

➤ Output Parameter. Available only if one or more 
output parameters are defined for one or more of 
the previous components in the flow.

➤ Flow Parameter. Available only if one or more flow 
input parameters are defined. 

<parameter name> A drop-down list of available parameter names.

Encrypted parameters are not listed.
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Is A drop-down list of conditions that need to be met 
for the component to run. The following conditions 
are available:

➤ equal to

➤ not equal to

➤ less than (not available for table parameters)

➤ less than or equal (not available for table 
parameters)

➤ greater than (not available for table parameters)

➤ greater than or equal (not available for table 
parameters)

<value> An edit box in which you enter the valid value for 
the condition. 

Else Specifies what to do if the condition is not met. The 
following options are available:

➤ skip to next component and continue. If the 
condition is not met, the component for which 
the run condition is set does not run, and the test 
run continues with the next component in the 
flow.

➤ End component run and fail. If the condition is 
not met, the component for which the run 
condition is set does not run, but instead sets the 
status of the component run as Failed. The flow 
either continues to the next component or ends, 
depending on the failure condition set for the 
component. For more information on defining 
failure conditions for components, see "Defining 
Failure Conditions" on page 221.

Summary A text description of the run condition you have 
defined for the component.

Section Description
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Prior to a component run, the condition and value are checked. If the 
condition and value are met, the component run continues. If the condition 
and value are not met, then the component does not run, and the run 
session proceeds according to your selection in the Else box.

Tip: Your selection in the Else box applies only if the run condition is not 
met. To specify whether to continue or end the entire run if a component 
run fails, set the failure condition for the component. You do this in the Test 
Script tab of the Test Plan module. For more information, see "Defining 
Failure Conditions" on page 221.

Managing Run Conditions

After you create a run condition, you can modify its settings. You can also 
remove a run condition from a flow.

To modify a run condition:

 1 In the Test Script tab for a flow, right-click the component and select Add/
Edit Run Condition. Alternatively, click the relevant link in the Run 
Condition column. The Run Condition dialog box opens.

 2 In the Run Condition dialog box, modify the attributes and alternative 
behavior as needed. For more information on the available options, see 
"The Run Condition Dialog Box" on page 372.

 3 Click OK. The run condition is modified. 

To remove a run condition:

 1 In the Script pane of the Test Script tab select the component and click 
the Delete Run Condition button.

 2 Click Yes in the confirmation box. The run condition is removed from the 
flow. 
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To troubleshoot run conditions:

If the run condition is not valid, the run condition link is displayed in red. 
This can happen, for example, if a reference parameter was deleted, a 
parameter value was encrypted, and so on.

Delete the run condition and define a new one.

Running Tests with Run Conditions

You run a business process test containing flows with run conditions as you 
would a regular business process test. For more information on running 
business process tests, see Chapter 14, "Running Business Process Tests and 
Flows."

As with regular business process tests, you can view test results in the Last 
Run Report tab in the Test Lab module.

➤ If you select skip to next component and continue for a run condition, 
and the run condition you specify is not met, the test results list the run 
status for the component with the run condition as Ignored. The 
component is not displayed in the run results.

➤ If you select end component run and fail for a run condition, and the run 
condition you specify is not met, the test results list the run status for the 
component with the run condition as Failed.

If a run condition is not met, the test results also provide details about the 
condition that was not met to help you understand why the component run 
failed or did not run.
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14
Running Business Process Tests and Flows

This chapter describes how to run business process tests and flows in 
HP Application Lifecycle Management (ALM) and how to view the results.

This chapter includes:

➤ About Running Business Process Tests and Flows on page 377

➤ Running a Business Process Test or Flow Manually on page 380

➤ Understanding the Manual Runner Window on page 388

➤ Understanding the Manual Runner Dialog Box on page 391

➤ Debugging Tests in the Test Plan Module on page 400

➤ Running Automated Business Process Tests or Flows on page 406

➤ Viewing Run Results of Business Process Tests or Flows on page 410

About Running Business Process Tests and Flows

Business process tests and flows can contain manual and automated 
components. You run business process tests and flows, and view run results 
in the Test Plan module and Test Lab module of ALM.

The following topics are discussed in this section: 

➤ "About Running Tests Manually" on page 378

➤ "About Running Tests Automatically" on page 378

➤ "About Viewing Run Results" on page 379

➤ "Working with Other Testing Products" on page 379
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About Running Tests Manually
When working with tests that contain one or more manual components, 
use the Manual Runner or HP Sprinter.

For information, see "Running a Business Process Test or Flow Manually" on 
page 380.

About Running Tests Automatically
When working with automated tests, you can first check whether the 
individual automated business components run together successfully in the 
test by debugging it in the Test Plan module. Debugging enables you to 
check, for example, whether the component and flow order in the test is 
logical, or that components start where previous components in the test 
end. For information, see "Debugging Tests in the Test Plan Module" on 
page 400.

When a debug run is complete, the Test Plan module displays a summarized 
report that shows which of the business components passed or failed the 
test. These results are provided for debugging purposes only and are not 
stored in ALM.

After a test has been debugged and is ready for testing new builds of an 
application, you use the Test Lab module. Tests can be run individually, or 
they can be run as part of a test set containing multiple tests of all types. For 
more information, see "Running Automated Business Process Tests or Flows" 
on page 406.

Automated components can be used in the same test. When you run the 
test, the testing tool opens each component in the test. For more 
information, see "Working with Other Testing Products" on page 379.

Note: You can continue using the Manual Runner to run your business 
process test or flow manually even after automation. However, if even one 
of the components in a business process test is manual, you cannot run the 
test automatically. 
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About Viewing Run Results
When a test run is complete, the Test Lab module displays a detailed report 
that shows the pass or fail results of checkpoints and other tested points in 
the business components included in the test.

In addition, you can view a comprehensive report that displays many details 
about each of the steps performed during the test.

Working with Other Testing Products
Before you run an automated test containing keyword-driven components 
on a host computer, you must ensure that the relevant testing tool on the 
host allows ALM to run tests.

QuickTest Professional

To enable ALM access to a specific QuickTest Professional client, open 
QuickTest on the host computer, select Tools > Options, click the Run node, 
and ensure that Allow other HP products to run tests and components is 
selected in the Run pane.

To run a QuickTest component from ALM, you must have the necessary 
ALM permissions. For more information, see the HP Application Lifecycle 
Management Administrator Guide.

Note: When you run a QuickTest business process test from ALM, the test 
run may be influenced by QuickTest Remote Agent settings on the 
QuickTest computer. For more information on the QuickTest Remote Agent, 
see the HP QuickTest Professional User Guide.
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Running a Business Process Test or Flow Manually 

If you are working with one or more manual components in your business 
process test or flow, you can use:

➤ The HP Sprinter tool for enhanced functionality, including: the ability to 
create and annotate screen captures, automatically enter data into fields 
in your application, and automatically include the list of your steps or 
user actions in any defect you submit.

To run tests using Sprinter, In the Test Lab module, click the Run button 
in the Execution Grid tab toolbar and select Run... (Sprinter).

For more information, refer to the HP Sprinter User Guide, available from 
the HP Application Lifecycle Management Adds-ins Page.

➤ The Manual Runner in the Test Lab module to run the test or flow 
manually. A manual run can include a combination of manual, keyword-
driven components. You can also use the Manual Runner, for example, if 
you want to run an automated test manually, or when the automation of 
components has not yet been completed. This section describes how to 
work with this Manual Runner.

Note: You can use both the Manual Runner and HP Sprinter to run 
automated components manually.

Working with the Manual Runner for business process tests or flows is 
described in the following sections:

➤ "Understanding Manual Runs" on page 381

➤ "Running a Test or Flow Manually" on page 381

➤ "Understanding Run Statuses" on page 387
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Note: The Manual Runner for business process tests and flows has additional 
features that the Manual Runner used for ALM manual tests does not have. 
For information on running ALM manual tests, see the HP Application 
Lifecycle Management User Guide.

Understanding Manual Runs
ALM enables you to run both manual and automated tests and flows 
manually, allowing you to follow the test steps and perform operations on 
the application you are testing. You use data from the Component Steps tab 
(manual steps from manual components, or step documentation from 
keyword-driven components).

Using the Manual Runner, you mark each step as passed or failed, 
depending on whether the actual application results match the expected 
results. You can also mark an entire component as passed or failed.

Note: Component steps created in versions prior to Quality Center version 
9.0 are not displayed in the Manual Runner.

Running a Test or Flow Manually
When you run a business process test or flow manually, you follow the test 
steps and perform operations on the application you are testing. You can 
run a test or flow as many times as you want and register the results. Results 
are stored separately for each run. 
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To run a business process test or flow manually:

 1 In the Test Lab module, select the relevant test set in the test set tree. The 
tests that comprise the test set are displayed in the Execution Grid tab.

 2 To iterate any test in the test set, select the test and right-click. Select Test 
Instance Details from the context menu. The Test Instance Details dialog 
box opens. If you do not want to iterate any test in the test set, proceed to 
step 7.

 3 In the Test Instance Details dialog box, click Execution Settings. 

 4 In the Test Iterations tab, configure the number of iterations required for 
the selected test, and then define the values for each parameter in each 
iteration. These parameter values are displayed for any components that 
reference them during the manual running of the test. 

Parameter values can either be defined:

➤ Manually, in the Test Iterations tab in the Test Lab module.

➤ For each test configuration in the Test Configurations tab in the Test 
Plan module. 

For details on how to set values, see "How to Define Iterations to Run with 
Different Values" on page 334.

 5 Repeat steps 2 through 4 for each test in the test set that you want to 
iterate.
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 6 Click OK to close the Test Instance Details dialog box. 

 7 Click the Run button in the Execution Grid tab toolbar and select Run 
Manually. The Manual Runner window opens.

Note: For more information on this window, see "Understanding the 
Manual Runner Window" on page 388.

 8 Click the Begin Run button to start the run. 
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The Manual Runner dialog box opens.

Tip: You can keep the Manual Runner dialog box visible while you work 
with an application by clicking the Keep on Top button. Click the button 
again if you do not want to keep the Manual Runner dialog box visible 
while you work. For more information on this dialog box, see 
"Understanding the Manual Runner Dialog Box" on page 391.

 9 If required, expand the first component in the test to view its steps. Select 
the first step in the component to see a detailed description of the step, its 
parameters and values, and its expected result. For more information, see 
"Understanding the Manual Runner Dialog Box" on page 391.
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 10 Open the application you are testing and perform the first step. If the 
selected step requires input parameters, use the values displayed in the 
Value cells under the Type: Input section in the Parameters pane. For 
more information, see "Working with the Parameters Pane" on page 395.

 11 Indicate the result of the step:

➤ If the actual result is the same as the expected result when you perform 
the step, click the Pass Selected toolbar button, or select Passed from 
the list in the Status column. A green check mark is added to the step 
and the step status changes to Passed. 

To pass the current step and all its sub-steps at once, click the Pass 
Selected arrow  and select Pass (Including Sub-Steps).

➤ If the actual result is different from the expected result when you 
perform the step, type the actual result in the Actual box. Click the Fail 
Selected toolbar button, or select Failed from the list in the Status 
column. A red X is added to the step and the step status changes to 
Failed. 

To fail the current step and all its sub-steps at once, click the Fail 
Selected arrow  and select Fail (Including Sub-Steps). For example, if 
a dialog box does not open as expected during the test, you can 
perform none of the subsequent steps that are performed on that 
dialog box. In this case, select the specific component iteration node, 
click the Fail Selected arrow , and select Fail (Including Sub-Steps).

➤ If you are unable to complete the step, type the reason in the Actual 
box and select Not Completed from the list in the Status column.

Note: For a description of how test, component, and step statuses 
interact, see "Understanding Run Statuses" on page 387.
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 12 If the step description indicates that you must manually return a value to 
an output parameter, enter the resulting value in the Value cell of the 
parameter Type: Output list. (Output values are populated automatically 
during automated runs, but not during manual runs.) This value may be 
used as the input value of one or more subsequent steps or components 
in the test, but you can possibly change the value during the component 
run.

 13 If you detect an application flaw while running the test, click the Add 
Defect toolbar button. The Add Defect dialog box opens, enabling you to 
add the defect. ALM automatically creates an association between the run 
and the new defect. For more information on adding defects, see the 
HP Application Lifecycle Management User Guide.

 14 If you want to attach an image or other file with more information about 
what happened when you performed the step, click the Attach to Step 
toolbar button. The Attachments dialog box opens, enabling you to add 
attachments. An icon to the left of the step indicates an attachment. Click 
the toolbar button to view any attachments. To add attachments to the 
entire run, click Attach to Step and select Attach to Run. For more 
information on adding attachments, see the HP Application Lifecycle 
Management User Guide.

 15 Repeat steps 9 to 14 for each step in the component.
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 16 Click the End Run button when you complete the run.

 17 Click the Last Run Report tab at the bottom of the Execution Grid tab and 
review the results of your test. For more information, see "Viewing Test 
Results in the Test Lab Module" on page 411.

Understanding Run Statuses
In certain instances, the test, component, and step statuses in the Status 
column of the Manual Runner dialog box change automatically, according 
to the status of their respective parent and child nodes in the test hierarchy. 

In general, if a run item fails, all of that item’s parent items fail. Similarly, if 
all the items of a particular type pass, their immediate parent also passes.

For example:

➤ If one or more steps receive a Failed or Not Completed status, all of its 
parent nodes (component iteration, component, flow, and test) also 
receive a Failed or Not Completed status.

➤ If all the steps pass in a component iteration, then their immediate parent 
(the component iteration) receives a Passed status.
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➤ If all the iterations for a component receive a Passed status, the 
component receives a Passed status.

➤ If all the components within a test receive a Passed status, the test 
receives a Passed status.

Understanding the Manual Runner Window

The Manual Runner window enables you to view and edit run and test 
details. It also lets you begin a new manual run, which opens the Manual 
Runner dialog box.

The name of the test you are running and the test set are shown in the title 
bar of the Manual Runner. 
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Toolbar

The Manual Runner window contains the following toolbar buttons:

Begin Run. Opens the Manual Runner dialog box.

End Run. Ends the current run.

Cancel Run. Cancels the current run. 

Attach to Run. Enables you to add attachments to the test run, such as a file, 
URL, snapshot of your application, an image from the Clipboard, or system 
information. For more information on how to add attachments, see the 
HP Application Lifecycle Management User Guide.

Add Defect. Enables you to add a defect in the Defects module regarding 
this run. ALM automatically creates an association between the run and the 
new defect. For more information on how to add defects, see the 
HP Application Lifecycle Management User Guide.

Help. Opens the Online Help for the Manual Runner window.

For more information, see:

➤ "Working with the Run Details Pane" on page 389

➤ "Working with the Test Details Pane" on page 390

Tip: You can navigate the Manual Runner, and perform many commands, 
using shortcut keys. For a list of shortcut keys, see "Manual Runner 
Shortcuts for Business Process Testing" on page 417.

Working with the Run Details Pane
The Run Details pane enables you to edit the following run information:

➤ Run Name. The name of the run.

➤ Tester. The user name of the person who initiated the run.
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You can view the following run information:

➤ Status. The run status of the test, for example, Failed, or Not Complete.

➤ Exec Date. The date that the run was initiated.

➤ Exec Time. The time that the run was initiated.

You can also click the Operating System Info link in the Run Details pane to 
display or edit details about the operating system, operating system service 
pack and operating system build. 

For more information on operating system information, see the 
HP Application Lifecycle Management User Guide.

Working with the Test Details Pane
The Test Details pane provides the description of the test or flow defined in 
the Test Plan module.
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You can click the More link in the Test Details pane to open the Test 
Properties dialog box and display test details and attachments. 

➤ The Details tab displays a description of the test and contains the same 
information as the Details tab in the Test Plan module. See "Details Tab" 
on page 191.

➤ The Attachments tab displays the attachments that are added to the test 
and contains the same information as the Attachments tab in the Test 
Plan module. See the HP Application Lifecycle Management User Guide.

Understanding the Manual Runner Dialog Box

The Manual Runner dialog box enables you to manually progress through 
each step of your business process test or flow and indicate a Pass, Fail, or 
Not Completed result for each step.

The Manual Runner dialog box displays the run status, parameters, 
description, and actual result of each step.
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Tip: The various panes can be hidden or displayed. If a required pane is not 
visible, click Show  to the right of the pane name. Click Hide  to hide 
the pane.

The name of the test you are running and the test set are shown in the title 
bar of the Manual Runner dialog box. 

Toolbar

The Manual Runner dialog box contains the following toolbar buttons:

Previous Step. Jumps to the previous step.

Next Step. Jumps to the next step.

Pass Selected. Enables you to indicate that the actual result of the selected 
step, (test, or component iteration) is the same as the expected result. A 
green check mark is added to the step and the step status changes to Passed. 
(To pass the current step and all its sub-steps at once, click the Pass Selected 
arrow  and select Pass All.) 
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Fail Selected. Enables you to indicate that the actual result of the selected 
step or steps is different from the expected result, and to enter the actual 
result in the Actual box. A red X is added to the step and the step status 
changes to Failed. (To fail the current step and all its sub-steps at once, click 
the Fail Selected arrow  and select Fail All.)

Return to previously clicked link. Enables you to jump back to the step 
containing the input parameter link you clicked previously.

Attach to Step. Enables you to add attachments to the step. To add 
attachments to the entire run, click the arrow and select Attach to Run. For 
more information on how to add attachments, see the HP Application 
Lifecycle Management User Guide.

Add Defect. Enables you to add a defect for the step in the Defects module. 
For more information on how to add defects, see the HP Application Lifecycle 
Management User Guide.

Keep On Top/Not On Top. Enables you to keep/not keep the Manual Runner 
dialog box visible while you work with the application you are testing.

End Run. Ends the current run.

Help. Opens the Online Help for the Manual Runner dialog box.

For more information, see:

➤ "Working with the Run Progress Pane" on page 393

➤ "Working with the Details Pane" on page 394

➤ "Working with the Parameters Pane" on page 395

➤ "Understanding the Run Progress Pane Hierarchy" on page 397

Working with the Run Progress Pane
The Run Progress pane in the Manual Runner dialog box displays a 
hierarchical tree of each test or flow iteration, business component, and 
component iteration contained in the business process test or flow. 
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Select a tree item to display its description, parameters and values, and 
expected result in the other panes. You can expand or collapse the nodes in 
the tree to display or hide the contents. 

For more information on the tree hierarchy in the Run Progress pane, see 
"Understanding the Run Progress Pane Hierarchy" on page 397.

You can select the Status cell of each run item in the tree to modify its 
current status in the test, for example, Passed or Not Completed. For more 
information on statuses, see "Understanding Run Statuses" on page 387.

The number of run items modified during the current manual run, and the 
total number of run items in the test, is shown next to the Run Progress 
pane title.

Working with the Details Pane
The Description box in the Details pane of the Manual Runner dialog box 
provides the textual description of the selected test, flow, component, or 
step. This is the text originally entered in the Business Components or Test 
Plan modules. 

In the Expected box, you can view the expected result of running the 
selected component. This is the text originally entered in the Component 
Steps tab of the component in the Business Components module. 

Input and output parameters within the text in the Description and 
Expected boxes are indicated by sets of angle brackets:

➤ Input parameters. Input parameters are enclosed in one set of angle 
brackets. If a value has been assigned to the parameter, the value is 
enclosed in the angle brackets, for example, <mercury>, for the 
AgentName parameter. If no value has been assigned to the parameter, an 
empty set of angle brackets is shown, for example, <>. 

➤ Output parameters. Output parameter names are enclosed in three sets of 
angle brackets, for example, <<<Order_Number>>>. 

In the Actual box you can enter the actual result of running the step during 
the test or flow.
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Working with the Parameters Pane
The Parameters pane in the Manual Runner dialog box displays the input 
parameter values for you to use when manually running the component 
selected in the run tree. The Parameters pane also enables you to enter 
values output by the application that you can use later in the test or flow 
run.

Input Parameter Values

You can view the input parameter values defined for the component 
selected in the tree in the Value cells of the Type: Input section. These input 
parameter values are provided by:

➤ Parameters. You can define parameters for use during a run for each 
iteration using the Test Iterations tab in the Test Instance Details dialog 
box before running the test. 

Alternatively, you can set up values for each test configuration. For more 
information, see "How to Define Iterations to Run with Different Values" 
on page 334.

Parameter names are shown as links in the Source cells in the Type: Input 
section. You can click the link to jump to the component or iteration that 
provides the parameter value. You can click the Return to previously 
clicked link button to jump back to the step containing the link.

➤ Output parameters. You can enter a value provided by a step in the 
application you are testing in the Value cell of the parameter Type: 
Output list. You can then use this value as an input value in a subsequent 
step.

Input parameters derived from the output parameter of a previous step 
are shown as links in the Source cells in the Type: Input section. 

The name of the link indicates the name of the source component and 
the name of the relevant output parameter, for example, [Component1] 
Order_Number.

To retrieve the output parameter value, you can click the link to jump to 
the step that provides the value.

You can click the Return to previously clicked link button to jump back to 
the step containing the link.
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➤ Default values. Default values can be defined for input parameters in the 
component Parameters tab in the Business Components module. Default 
values are used if no other value is provided from a parameter or output 
parameter during the test. For more information, see "Defining 
Parameters and Setting Default Values" on page 273.

Input parameter values that are defined as the default values in the 
Parameters tab of the component in the Business Components module do 
not have any associated link.

Output Parameter Values 

Output parameters allow you to retrieve values from a step in one business 
component (the source component) and insert them as input parameters in 
a subsequent component (the target component) in the business process test 
or flow. 

Note: The output parameter must already have been created in the 
component Parameters tab in the Business Components module. In 
addition, the output parameter must have been linked to the input 
parameter in the Component Iterations dialog box. For more information, 
see "Defining Parameters and Setting Default Values" on page 273.

You manually type in the relevant value provided by the application you are 
testing in the Value cell of the parameter Type: Output list when you run the 
step. A link to the source component is displayed when the target 
component is run. You can click the link to retrieve the required value. This 
value may be used as the input value of one or more subsequent steps or 
components in the test.
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Understanding the Run Progress Pane Hierarchy
The Run Progress pane displays a tree hierarchy of all the components and 
steps in your business process test or flow in the order that the steps should 
be performed on the application. Component groups, and iterations of 
groups and components, are also displayed in the tree in the defined order. 
This enables you to manually perform each of the individual component 
steps in the correct testing sequence. 

For example, consider a business process test named Reservation_Test, that 
contains four business components; Component1 (C1), Component2 (C2), 
Component3 (C3), and Component4 (C4). The test requires that 
components C2 and C3 be grouped and that the components and group are 
then run and iterated as follows:

➤ the first iteration of C1, then the second iteration of C1, followed by

➤ the first iteration of the group comprising C2 and C3, followed by

➤ the second iteration of the group, followed by

➤ the third iteration of the group, followed by the component C4.
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This is illustrated as follows:

In addition, the entire test is iterated twice.
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The test is displayed in the Manual Runner as follows:

Note: For clarity, the components in the tree have not been expanded to 
display their individual steps.
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Debugging Tests in the Test Plan Module

You can debug a business process test or flow comprised of one or more 
automated business components by running the components in Debug 
mode in the Test Plan module. Debugging is usually performed after the 
automation engineer has ensured that the individual components can run 
successfully in QuickTest Professional or other testing tools, and all the 
components have a Ready status. 

Tip: You can also access QuickTest to run and debug individual business 
components. 

For more information on running and debugging components in QuickTest, 
see the HP QuickTest Professional for Business Process Testing User Guide. 

Debugging ensures that the test runs properly, and locates any possible 
errors that may have occurred during the building of the test. For example, 
you can check the logical order of business components in the test, the 
pre-conditions and post-conditions required by each component, and the 
suitability of component parameter values, especially where output values 
are used as input values in other components. 
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You use the Run or Debug Test dialog box to choose whether to run each of 
the business components in the test in Debug mode or in Normal mode.

➤ When you run an automated component in Debug mode, the component 
opens and immediately pauses, enabling you (or an automation engineer) 
to use the debug tools available in QuickTest to debug the component. 
When one component ends, the next one immediately opens.

➤ When you run in Normal mode, the testing tool runs all the steps in the 
component consecutively, and then opens the next component. You 
cannot access debug options while a component runs in Normal mode.

Note: When you run a business process test or flow in Debug mode in the 
Test Plan module, no results or other test data is saved to the ALM database.

Working with the Run or Debug Test Dialog Box
When you choose to run a business process test or flow from the Test Plan 
module, the Run or Debug Test dialog box opens. 
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The dialog box displays the business components that make up the selected 
business process test or flow, and enables you to choose whether to run each 
component in the test in Debug mode or in Normal mode.

➤ Debug mode adds a breakpoint that causes the test to pause before 
running the first step in the specified business component. The position 
of the breakpoint in the test is indicated by a red spot icon in the left 
margin of the Keyword View or Expert View in QuickTest. This enables 
you to use all the debug options of QuickTest to check the performance of 
one or more specific steps in the component. You can then continue the 
run. 

For more information on QuickTest debugging options, see the 
HP QuickTest Professional for Business Process Testing User Guide.

➤ Normal mode runs the selected business component from start to finish 
without pausing.

Clicking the relevant cell in the Run Mode column enables you to select the 
required run mode from a list. You can also click the appropriate button to 
set all the components to Debug mode or to Normal mode simultaneously.

When you initiate a test to debug a business component or a complete test, 
ALM opens QuickTest directly from the Test Plan module. The requested test 
is then run on your local computer, and the results are exported back to 
ALM for your viewing.

Note: Tests can contain both automated and manual components. Initiating 
a test to debug a manual component or test containing one or more manual 
components will display a warning message. To run tests that contain 
manual components, use the Manual Runner. For information on the 
Manual Runner, see "Running a Business Process Test or Flow Manually" on 
page 380.
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To run a test or flow using Debug mode:

 1 In the ALM sidebar, click Test Plan to open the Test Plan module.

 2 Select the relevant test in the Test Plan tree, and click the Test Script tab. 

 3 Ensure that all the necessary applications for the test are set up to meet 
the pre-conditions required by the first business component. For 
example, close unnecessary instances of applications, or open the 
application at the required window.

 4 Ensure that default values are set for the parameters, as described in 
Chapter 9, "Working with Parameters."

 5 In the Script pane of the Test Script tab, click the Run or Debug Test 
button in the toolbar.

The Run or Debug Test dialog box opens, which lists all the business 
components that make up the selected test.

 6 For each component, click in the Run Mode column and select Debug or 
Normal from the list. 

Tip: Click the Debug button to set all the components to run in Debug 
mode or click the Normal button to set all the components to run in 
Normal mode.
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 7 Click OK to close the Run or Debug Test dialog box. QuickTest opens on 
your computer and runs the first business component in the test. 

Note: You should close all browsers before running a test on a Web 
browser. QuickTest must load the Web Add-in (as defined in the 
application area in QuickTest) before a step in the test opens the browser.

If the test contains QuickTest components, the test should include a 
QuickTest component at the beginning of the test before the browser 
opens.

From your task bar, you can toggle between the Test Plan module, 
QuickTest, and the application you are testing.

➤ With the first keyword-driven or scripted component in the test, ALM 
opens QuickTest and loads the add-ins from the application area that 
is associated with that component. It assumes that these are the 
required add-ins for all the components in the test. 

➤ In the Test Plan module, the status of the test and the name of the 
component currently being run are shown below the toolbar in the 
Test Script tab, for example, Running(OrderStart). You can click the Stop 
Run button to stop the run at any time.

➤ In QuickTest, the status of the test being run, for example Running, or 
Ready, is shown in the status bar at the bottom of the window.

➤ In QuickTest, all the debugging functions from the Debug menu, for 
example, Step Over or Step Into, are enabled for use. For more 
information on applicable debug options, see the HP QuickTest 
Professional for Business Process Testing User Guide.

 8 If you selected a business component to run in Debug mode, the test 
pauses after opening the component in QuickTest. Use the QuickTest 
debug options to control the continuation of the run through the 
displayed component. When you are ready to proceed with the run, 
continue the run in QuickTest. 
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When one component finishes running, it closes and the next 
component in the test opens in QuickTest.

When the debug run is complete, ALM imports the results from QuickTest 
and displays summary information in the Debug Run Information dialog 
box in the Test Plan module. 

This report details the results of the debug run for each business 
component in the test and includes all relevant QuickTest messages.

 9 Click Close to complete the run.
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Running Automated Business Process Tests or Flows

When a business process test or flow has been debugged and parameters 
have been configured, you can run the test or flow, or a test set containing 
several tests and flows, from the Test Lab module. 

To run a business process test or flow in the Test Lab module:

 1 In the Test Lab module, select the relevant test set in the test set tree. The 
tests and flows in the test set are displayed in the Execution Grid tab.

 2 Perform one of the following:

➤ Select the specific test in the Execution Grid tab and click the Run 
button in the tab toolbar. 

Or

➤ Click the Run Test Set button in the Execution Grid tab toolbar.
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Note: Clicking the Run button enables you to run a test manually using 
either the standard manual runner or HP Sprinter. For more information 
on using the standard manual runner, see "Running a Business Process 
Test or Flow Manually" on page 380. 

The Automatic Runner dialog box opens. 

The Automatic Runner dialog box lists the specific tests selected in the 
Execution Grid, or all the tests in the test set if you clicked the Run Test 
Set button.
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 3 Select the Run All Tests Locally check box if you want to run the selected 
flow, test, or test set using QuickTest on your local computer. If you want 
to run the test or test set on a host computer, select the cell in the Run on 
Host column, click the browse button, and select a host from the list.

Notes:

If you select Run All Tests Locally, you must have QuickTest Professional 
version 10.00 or above installed on your computer. 

If you select a remote host, make sure that the HP ALM Client 
Registration Add-in is installed on the remote host before running the 
flow, test, or test set.

For information on choosing a different host computer, see the 
HP Application Lifecycle Management User Guide.

 4 Select the Enable Log check box to enable QuickTest to record an 
execution log of the run. For more information on the execution log, see 
"Viewing the Execution Log" on page 413.

 5 Select a test in the list and click the Run button to run the selected test, or 
click the Run All button to run all the tests in the test set. The testing tool 
required for each component, such as QuickTest, opens and runs the 
applicable business components in the test or test set. From your task bar, 
you can toggle between the Test Lab module, QuickTest, and the 
application you are testing.

➤ The status of the test run, for example, Connecting, or Running, is 
shown in the Status column of the Automatic Runner dialog box. You 
can click the Stop button in the toolbar to stop the run at any time. 
You can click the Stop All button in the toolbar to stop all the 
currently running tests.

➤ The status of the run is shown in the status bar at the bottom of the 
QuickTest window.

After the test or test set run ends, the overall result of the run is shown in 
the Status column of the Automatic Runner dialog box.
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 6 Close the Automatic Runner dialog box to return to the Test Lab window.

Tip: You can view an execution log of the test or test set run. For more 
information, see "Viewing the Execution Log" on page 413.

Note: For improved performance when running tests or flows that 
contain only QuickTest automated components, ALM creates and runs a 
BPT wrapper test in QuickTest. The BPT wrapper test is recreated each 
time the test or flow runs. By default, the wrapper test is not saved with 
the run.

For auditing purposes, you can instruct ALM to save the BPT wrapper test 
as an attachment to the test or flow run. In Site Administration, add the 
BPT_WRAPPER_TEST_AUDIT parameter to the list of parameters and set 
the value to Y. For more information on setting parameters, see the 
HP Application Lifecycle Management Administrator Guide.

To view the contents of a BPT wrapper test, from the Test Lab module’s 
Test Runs tab, double-click the attachment icon next to the business 
process test or flow run in the grid. 
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Viewing Run Results of Business Process Tests or Flows

After you run a business process test or flow from the Test Lab module, you 
can view the results in various formats:

➤ For automated and manual tests, you can view the summarized results of 
the run in the Last Run Report tab. This pane lists each step of all the 
business components in the test, and, where applicable, the summarized 
results of main events reported by QuickTest. For more information, see 
"Viewing Test Results in the Test Lab Module" on page 411.

➤ For automated tests, you can view a complete QuickTest report. The 
hierarchical report contains details on all the steps for all the different 
iterations and business components within the automated test run. For 
more information, see "Viewing Reports for Automated Business Process 
Tests" on page 412.

➤ For automated and manual tests, you can view an execution log of the 
tests run. From this log you can view summarized or detailed results of 
any test or test set run. For more information, see "Viewing the Execution 
Log" on page 413.

Note: Results are stored in ALM only when the business component runs 
from the Test Lab module as part of a test. They are not stored in ALM when 
you run the test in Debug mode from the Test Plan module, or when 
running components directly from QuickTest.
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Viewing Test Results in the Test Lab Module
You can view the results of the latest automated or manual test run in the 
Test Lab module in the Last Run Report tab at the bottom of the Execution 
Grid. 

The pane displays a hierarchical tree of each business component contained 
in the test, the test run date and time, and the overall result obtained when 
the component or step ran, such as Passed, or Failed. If one or more steps 
within a component receive a Failed result, the component itself displays a 
Failed status.

Note: The results of automated steps run in previous versions of ALM are 
not displayed in the Last Run Report tab.

To view the results of the last test run:

 1 Ensure that the Last Run Report tab is displayed at the bottom of the 
Execution Grid tab.

If the Last Run Report tab is not visible, click the Show button at the 
bottom-right of the Execution Grid tab. After clicking this button, it 
changes to a Hide button that you can later use to hide the pane. 

Expand and collapse the tree entities in the Name column as necessary to 
see more or less details. 

 2 Select steps in the pane to view a description of the events in the test or 
the reason for a failed event.
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Viewing Reports for Automated Business Process Tests
If you have QuickTest Professional or the QuickTest Professional Add-in for 
ALM installed on your computer, you can view a full report of an automated 
business process test run in the Test Lab module.

To view a report of an automated business process test:

 1 After you run a business process test from the Test Lab module, open the 
Last Run Report tab at the bottom of the Execution Grid tab, as described 
in "Viewing Test Results in the Test Lab Module" on page 411.

 2 Click the link to the report about each iteration in the Status column of 
the pane. The Run Results Viewer opens. 
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The Run Results Viewer displays a graphical representation of the result of 
each step or event in the selected iteration of the test.

By selecting a node in the tree, you can view the details of how the step or 
node performed in the test. 

For more information on viewing and analyzing the results of tests in the 
Run Results Viewer, see the HP QuickTest Professional for Business Process 
Testing User Guide.

Viewing the Execution Log
The Execution Log provides a log of the automated test or tests run in a test 
set. The log includes the date and time that each test ran, the host on which 
it ran, and summary results of the selected test.

Note: The Execution Log is created only if the Enable Log check box is 
selected in the Automatic Runner dialog box before the test or test set runs. 
For more information, see "Debugging Tests in the Test Plan Module" on 
page 400.

To view the Execution Log:

 1 After the test or test set run is completed, the results of the run are shown 
in the Status column of the Automatic Runner dialog box.
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 2 Double-click a test name in the Automatic Runner dialog box, or select a 
test and select View Execution Log from the Run menu.

The Execution Log window opens and displays the results of the test or 
test set run.

 3 If required, you can filter the list to display fewer entries by:

➤ Selecting the specific test you want to view from the Test list, and 
clicking the Refresh button.

➤ Selecting your local computer or the specific host on which the test 
was run from the Host list, and clicking the Refresh button.

 4 In the list of test runs for the selected test set, select the test whose results 
you want to view. The results of the run are displayed in the box at the 
bottom of the log window.
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A
Business Process Testing Keyboard 
Shortcuts

You can navigate HP Business Process Testing, and perform many Business 
Process Testing commands, using shortcut keys.

This chapter includes:

➤ General Keyboard Shortcuts on page 415

➤ Business Component Module Shortcuts on page 415

➤ Test Plan Module Shortcuts for Business Process Testing on page 417

➤ Manual Runner Shortcuts for Business Process Testing on page 417

General Keyboard Shortcuts 

You can navigate ALM, and perform common commands, by pressing the 
shortcut keys described in the HP Application Lifecycle Management User 
Guide.

Business Component Module Shortcuts

You can perform the following commands in the Business Components 
module by pressing the corresponding shortcut keys:

Shortcut Key Function

CTRL+ALT+N Creates a new component folder. 

CTRL+N Creates a new component. 
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DELETE Deletes an entity (component, component step).

F5 Refreshes.

ALT+G Opens the Go To Component dialog box.

CTRL+U Copies a URL.

ALT+S Snapshot tab: Creates a snapshot.

ALT+L Snapshot tab: Loads a snapshot from file.

ALT+D Snapshot tab: Deletes a snapshot. 

Alt+N Manual Steps tab: Adds a new step. 

Parameters tab: Adds a new parameter.

CTRL+C Manual Steps tab: Copies steps.

CTRL+V Manual Steps tab: Pastes steps.

CTRL+P Manual Steps tab: Inserts a parameter.

CTRL+DELETE Parameters tab: Deletes a parameter.

CTRL+F Manual Steps tab: Finds a test.

CTRL+F11 When positioned in the Output cell from the Keyword 
View of the Component Steps tab: Opens the Output 
Options dialog box. 

When positioned in the Value cell from the Keyword 
View of the Component Steps tab: Opens the Value 
Configuration Options dialog box. 

Shortcut Key Function
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Test Plan Module Shortcuts for Business Process Testing

You can perform the following commands in the Test Plan module for 
business process tests and flows by pressing the corresponding shortcut 
keys:

Manual Runner Shortcuts for Business Process Testing

You can perform the following commands in the Manual Runner for 
business process tests and flows by pressing the corresponding shortcut 
keys:

Shortcut Key Function

CTRL+S Test Script tab: Opens the Select Component pane.

CTRL+R Test Script tab: Creates a new component request. 

DELETE Test Script tab: Removes the selected item (component, 
flow business process test, group).

F5 Refreshes.

F8 Validates the test. 

Shortcut Key Function

CTRL+R Begins run. 

CTRL+Q Ends run. 

CTRL+K Cancels run. 

CTRL+U Attaches to run. 

CTRL+B Adds a defect. 

CTRL+UP ARROW Goes to previous step. 

CTRL+DOWN ARROW Goes to next step. 

CTRL+P Passes selected steps.

CTRL+ALT+A Passes (including sub-steps).



Appendix A • Business Process Testing Keyboard Shortcuts

418

CTRL+F Fails selected steps. 

CTRL+G Fails (including sub-steps).

ALT+LEFT ARROW Returns to previously clicked link. 

ALT+S Attaches to step.

F12 Toggles the Always on Top option.

Shortcut Key Function
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B
Business Process Testing Glossary

This glossary describes terminology specific to Business Process Testing.

See also: The glossary in the HP Application Lifecycle Management User Guide.

Application Area. Application areas contain all of the settings and resources 
required to create the content of keyword-driven business components for a 
particular application or part of an application. These include 
representations of the objects from your application contained in the shared 
object repository, and user-defined operations, contained in function 
libraries.

Automation Engineer. An expert in an automated testing product, such as 
QuickTest Professional.
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Business Component (or Component). An easily-maintained, reusable unit 
comprising one or more steps that perform a specific task. You can use 
business components in multiple tests and flows. A business component can 
be defined as a manual or automated component. Business components 
may require input values from an external source or from other 
components, and they can return output values to other components.

Business Process Test. A scenario comprising a sequence of business 
components or flows, designed to test a specific business process of an 
application.

Business Process Test Parameters. Variable values that a business process test 
or flow can receive and then pass to business components or flows for use as 
input values.

Dynamic data for configurations. Values for a test configuration specified in 
an external Microsoft Excel file, which is then uploaded as a test resource 
and mapped to a test configuration in ALM.

input component parameters. Variable values that a business component 
can receive and use as the values for specific, parameterized steps in the 
component.

output component parameters. Values that a business component can 
return. These values can be viewed in the business process test results and 
can also be used as input for a component or flow that is used later in the 
test.

Component Request. A request for the creation of a new business 
component, when no existing component answers the needs of a business 
process test or flow. Component requests are initiated in the Test Plan 
module and can be viewed in the Component Requests folder in the 
Business Components module.

Flow. A reusable collection of business components in a fixed sequence that 
performs a specific task. You can use flows in multiple business process tests. 
Flows may require input values from an external source or from other 
components or flows, and they can return output values to other 
components or flows.
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Flow input parameters. Variable values that enable you to define data used 
by a flow that is provided to the flow from an external source. 

Flow output parameters. Values that enable you to define data that is 
retrieved and stored by a flow and can be used in subsequent components in 
a flow.

Group. A combination of contiguous components that you can iterate 
together in a business process test or flow.

Implementation requirements. Details and information, written by the 
subject matter expert that creates a business component, describing a 
general overview of the business component’s purpose or goals, and the 
condition of the application before and after a component is run (the 
pre-conditions and post-conditions).

Iterations. The number of times that an individual business component, 
group of components, or flow, runs within a single test run, or the number 
of times that an entire business process test runs within a test set.

Pre-Condition and Post-Condition. The state of the application before the 
first step in a business component, and the state of the application after the 
last step in a business component. For example, the pre-condition for a 
component may state that all applications should be closed, or a specific 
application should be open to a specific screen or with a specific dialog box 
displayed. A post-condition may state that an application should be open to 
a particular screen, or be closed. 

If you want the business component to allow iterations, the post-conditions 
should specify that the application’s end state must match its state at the 
beginning of the component. The pre-conditions and post-conditions 
provide a guide when implementing the steps for the business component.

Roles. The various types of users who are involved in Business Process 
Testing.

Run condition. A conditional statement you can insert into a flow to check 
the current value of a given parameter before running a component in a 
flow. The run condition determines whether to run the component, skip the 
component run, or skip and set the component status to fail.
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Static data for configurations. Values for a test configuration specified from 
within ALM.

Status (Component). A status value that indicates whether a business 
component is fully implemented, debugged, and ready to be run in a 
business process test or flow. The component with the most severe status 
determines the status of the entire test or flow. The status can be modified 
by the subject matter expert in ALM and the automation engineer in 
QuickTest.

Status (Business Process Test, or Flow). A status value that is automatically 
generated based on the status values of all the business components in the 
business process test or flow.

Steps. Individual operations in a component. These can be manual steps or 
detailed automated testing steps and are designed and implemented in a 
business component to test the workings of a specific task in an application.

Subject Matter Expert. The subject matter expert who uses ALM to create 
business components, flows, and business process tests.
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